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Chapter 1. Unica Collaborate

Unica Collaborate provides marketing organizations with the ability to distribute the

execution of centrally managed marketing campaigns throughout the enterprise.

It allows centralized marketers to maintain control over corporate standards and business
rules, while it allows remote users to tailor or provide input to the campaign for greater local

customization and relevance, ultimately increasing response rates and revenue.

Collaborate supports campaign customization by remote users; however, the remote users

can change only those parameters that are specified by the campaign designer.

For example, a retail company might want to centrally control certain selection criteria,
but allow individual store owners to control selections that are related to their stores or

locations.

Collaborate use cases

Collaborate enables organizations to accomplish their goals by supporting multiple

collaborate use cases.

Specifically, Collaborate enables you to:

« Centralize marketing efforts while it ensures that corporate business rules, logic,
and best practices are enforced, allowing execution and controlled customization
throughout the organization.

« Promote field compliance by having corporate marketers centralize campaign design
with corporate business rules (such as opt-outs) and customer preferences.

« More efficiently design, conduct, manage, and measure both global and localized
cross-channel marketing initiatives.

« Increase the number of users who are able to contribute to and run campaigns,
providing more flexibility within an organization and enabling measurement and

management of marketing efforts.
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« Provide "self-serve" customer interaction management within an enterprise, for
less technical-oriented marketers and individuals closest to the customer, without
compromising corporate rules, goals, or objectives.

« Manage customer interactions in real-time through email and the web.

« Allow marketing decision-making and campaign management to be handled by field
marketers, while corporate marketers manage corporate marketing communication and

policies.

Corporate marketers

Corporate marketers develop templates for reusable campaign logic and lists of customer
contacts.

Corporate marketers manage corporate campaigns and oversee marketing activities of field
marketers. They also specialize in designing and generating campaigns from which the field
marketer can choose.

Primary corporate marketer tasks

In Collaborate, corporate marketers perform the following tasks:

+ Design campaign flowcharts.

* Create corporate campaigns.

« Manage campaign workflow.

» Create reports that are used to assess campaign success.

« Design templates for Corporate Campaigns, On-demand Campaigns, and Lists, for use
by field marketers and other corporate marketers.

Corporate marketer tasks in Campaign

Corporate marketers also frequently use Campaign, through which they design and
build flowcharts that are associated with Lists, On-demand Campaigns, and Corporate

Campaigns.
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Corporate marketer roles

Corporate marketers must be assigned the Corporate Marketer role in the Global security

policy, or its equivalent, to perform their tasks.

To work in Campaign, corporate marketers must be assigned the following roles:

« Global Policy Execute
« Global Policy Design
- Global Partition Design or Execute

Field marketers

Field marketers create and run local or regional marketing activities for a territory or line of

products.

Field marketers work directly with customers, understand their needs, and can make good
decisions on how best to reach their customers with on-demand or corporate marketing

campaigns.

Field marketers may be line-of-business users, partners, branch office managers, retail store
managers, or members of local sales forces. Field marketers create on-demand (local)

campaigns that they can run at any time to target a local customer base.

Field marketers tasks

In Collaborate, field marketers work with:

e Lists

Field marketers typically create Lists in Collaborate and define criteria to select
contacts for the Lists. These Lists can then be used by one or more On-demand
Campaigns as needed.

» On-demand Campaigns

Field marketers can create and run On-demand Campaigns to target their set of

customers.
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 Corporate Campaigns

Field marketers subscribe to the Corporate Campaigns they want to participate in.
For those Corporate Campaigns, field marketers review and choose which of their

customers are targeted by the Corporate Campaign.

Field marketer roles

Field marketers must be assigned the Field Marketer role in the Global security policy, or its

equivalent, to perform their tasks.

Logging in to HCL Unica

This procedure assumes that you know the website address (or URL) to your server and
you have an assigned user name and password. If you need help, contact your HCL Unica

administrator.

1. Open a supported browser and enter the URL to the HCL Unica server.
The prompts that display vary based on the security settings that are defined for your

installation.
2. If prompted, accept the digital security certificate.

3. On the login page, enter your user name and password, then click Sign In.

If you are prompted to accept the digital security certificate, click Yes to accept the

certificate.

The dashboard or the default start page displays. The options that are available to you

depend on the permissions that are assigned to you by your HCL Unica administrator.

[5) Note: For a list of supported browsers, see the Recommended Software Environments

and Minimum System Requirements guide.
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Collaborate documentation and help

Collaborate provides documentation and help for users, administrators, and developers.
The following table describes the various tasks of Collaborate. The Documentation column
contains names of documents where you can find more information about the tasks.

Table 1. Get up and running

This two-columned table describes the Collaborate installation or upgrade tasks in one

column, and the corresponding documents in the second column.

Task Documentation

Find out about new features, known issues, and Collaborate Release Notes

limitations

Learn about the structure of the Collaborate Collaborate System Tables and Data
system tables Dictionary

Install or upgrade Collaborate One of the following guides:

« Collaborate Installation Guide

« Collaborate Upgrade Guide

Implement the IBM® Cognos® reports provided Cognos Reports Installation and

by Unica Collaborate Configuration Guide
Implement Unica Insights reports provided by Unica Insights Installation and
Unica Collaborate Configuration Guide

The following tables describe administrative tasks in Collaborate. The Documentation
column contains names of documents where you can find more information about the

tasks.

Table 2. Configure and use Collaborate
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This two-columned table describes the Collaborate administrative and user tasks in one

column and the corresponding documents in the second column.

Task Documentation
« Set up and configure the system for users Unica Collaborate Administrator's
« Adjust security settings Guide

« Map tables, define offer templates and
custom attributes

* Run utilities and perform maintenance

« Create and deploy marketing campaigns Unica Collaborate Corporate

« Analyze campaign results Marketer's Guide

Unica Collaborate Field Marketer's
Guide

Use REST APIs Unica Collaborate REST APIs

The following tables contain information about online help and obtaining PDFs for
Collaborate. The Instructions column describes how to open online help and access
documentation for Collaborate.

Table 3. Getting help

This two-columned table contains information about how to start online help and access

PDF documentation for the Collaborate. Second column contains instructions for the

tasks.
Task Instructions
Open 1. Choose Help > Help for this page to open a context-sensitive help topic.

online help | 2. Click the Show navigation icon in the help window to display the full help.

You must have web access to view context-sensitive online help. Contact
HCL Support for more information about accessing and installing Unica

Knowledge Center locally for offline documentation.
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Task Instructions
Obtain Use either of the following methods:
PDFs

 Choose Help > Product documentation to access Collaborate PDFs.
« Choose Help > All HCL Unica suite documentation to access all available
documentation.

Unica To access the Unica Knowledge Center, choose Help > Support for this
Knowledge | product.
Center




Chapter 2. Customize Collaborate

You can customize the Collaborate interface to meet your needs. Customization settings

are available in Collaborate when you click Settings or Settings > Collaborate Settings.

The following table describes what you can customize.

Table 4. Options for customizing Collaborate

Option

Description

Set current page

as Home

Set the current page to display automatically as soon as you log in to

Collaborate.

Basic Settings

Set the security policy to apply to new items by default.

Timezone

Choose your local timezone.

Projects Options

Define the project list and view to show by default for projects.

Tasks Options

Define the task list and view to show by default for tasks.

Collaborate Set a default report to display when you go to the Analytics >
Analytics Collaborate Analytics page, and set the Analytics home page as your
Options login page.

Instances Customize your default view of Lists, On-demand Campaigns, and
Options Corporate Campaigns.

Calendar/ Select options to customize how you view the calendar and task
Timeline milestones.

Settings

You (or another user with the appropriate permission) can set up dashboards to show the

information that you view most often. Each dashboard can include one or more "portlets”

that present:

* List management.

« Subscription management.
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« Campaign management

« Calendar

Setting your basic settings

Use the basic settings option to choose the security policy that is used by default when you

create items.

To set the security policy, complete the following steps.

1. Select Settings > Collaborate Settings.

The Administrative Settings page opens.

2. Click Basic Settings.

The Basic Settings page opens.

3. In the Default Security Policy field, select the security policy to use by default when you

create items in Collaborate.

You can leave Global selected, which is the default, to use the global security policy
that is defined by your administrator. Otherwise, you can select a security policy that
your administrator instructed you to select. As a best practice, do not change the
security policy without the guidance of your administrator. For more information about
security policies, contact your administrator or see the Collaborate Administrator's
Guide.

4. Click Save Changes to save your changes.

Setting your instance options

You can use instance options to customize your default views of Lists, On-demand

Campaigns, and Corporate Campaigns.
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For example, you might want to specify that the On-demand Campaigns list that opens by

default shows only On-demand Campaigns set to run in the current week.

1. Select Settings > Collaborate settings.

The Administrative Settings page opens.

2. Click Instances Options.
The Instances Options page opens.

3. In each of the List, On-demand Campaign, and Corporate Campaign sections, select the

default view.

4. Click Save Changes to save your changes.

When you open the Lists, On-demand Campaigns, or Corporate Campaigns page, your

default list is shown.

Setting your start page

The start page is the page that displays when you log in to HCL Unica. The default start

page is the default dashboard, but you can easily specify a different start page.

If you do not want a dashboard page to display when you first log in to HCL Unica, you can

select a page from one of the installed Unica products as your start page.

To set a page you are viewing as your start page, select Settings > Set current page as
home. Pages available for selection as a start page are determined by each HCL Unica

product and by your permissions in HCL Unica.

On any page you are viewing, if the Set current page as home option is enabled, you can set
the page as your start page.
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Calendar

Historically, organizations produced paper-based calendars and updated them with the
latest information. The calendar feature provides marketing groups with electronic means

to view and update calendar data.

Field marketers and corporate marketers can use the Collaborate calendar to view the time

horizon for marketing campaigns.

Marketing organizations typically organize their work with calendars. For example, seasonal
events drive marketing programs, and other external dates, such as store openings, and

seasonal product announcements.

You can use the calendar as an aid for planning marketing campaigns.

* You can view and update the timelines for Lists, On-demand Campaigns, or Corporate
Campaigns.
* You can get an up-to-date view of planned or run marketing efforts over time.

You can customize the appearance of the calendar in the following ways.

* You can set a default view of the calendar: Click Settings > Collaborate Settings >
Calendar/Timeline Settings.
* You can choose the look of the calendar in the Set View Options dialog box.

* You can filter the items that are displayed on the calendar with Advanced Search.

Calendar features

The calendar in Collaborate displays Lists, On-demand Campaigns, or Corporate

Campaigns. You can also edit the views.

The Collaborate calendar has the following features:

* The calendar includes start and end dates for the displayed items.
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* You can display Corporate Campaigns and On-demand Campaigns on the same
calendar in different colors for easy differentiation.

* You can open a Corporate Campaign, List, or On-demand Campaign directly from the
calendar.

Default and per session calendar views

You can use one of two types of settings when you view the calendar:

« The default calendar settings, which are in effect every time you log in.

« The per session calendar settings. The per session calendar is the calendar that results
from making temporary changes to the calendar view, without changing the default
settings.

Objects displayed in a calendar

You can display any of the following objects in a calendar:

« Corporate Campaigns
» On-demand Campaigns
* Lists

« Corporate Campaigns and On-demand Campaigns

Calendar item dates

Each List, On-demand Campaign, or Corporate Campaign that is displayed in a calendar has
a start and end date. These are the target start and end dates you set when you create the
object.

Display options for the calendar

You can modify the calendar display in the following ways:

* You can modify the default calendar settings.
* You can set the calendar view for the current session.
« You can toggle between calendar views:

o Timeline view
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o Calendar grid view
o Text view
* You can use the advanced search feature to filter the Lists, On-demand Campaigns, or

Corporate Campaigns that are displayed in the calendar.

Timeline view

This view displays a time-based view of the Lists, On-demand Campaigns, or Corporate
Campaigns you select to display. You can select the time range for the calendar items you
select to display in a timeline view.

In a timeline view, each calendar item is displayed as a horizontal bar across its date range.

If you enable color coding, each calendar item is colored according to attributes you select.

You can select the date range for the timeline from the following options:

» Week displays one week. Each day is listed as a column. The starting day is either
Sunday or Monday, depending on the default calendar settings.

« Month displays a single calendar month. Each day is listed as a column, and days are
grouped into weeks.

* Quarter displays three calendar months. Each week is listed as a column, and weeks
are grouped into months.

« Fiscal Year displays a fiscal year. Your administrator can configure the starting month
for a fiscal year. Each month is listed as a column, and the months are grouped into
quarters.

- Calendar Year displays a calendar year that starts in January and ends in December.

Each month is listed as a column, and the months are grouped into quarters.

[5) Note: Any day that is specified as non-work time is disabled in a timeline view.

Month-based text or calendar grid view
A month-based calendar view displays a calendar for a selected month.

In addition to a month-based timeline view, you can select from the following month-based
calendar views:
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 1-Month Text: Each day contains a text listing of selected, Lists, On-demand
Campaigns, or Corporate Campaigns.

« 1-Month Calendar Grid: Each calendar item is displayed as a horizontal bar that begins
on the item start date and ends on the item end date. If you enable color coding, each

calendar item is colored according to attributes you select.

[5) Note: Any day that is specified as non-work time is indicated by a gray X in the
background in a calendar grid view.

Color-coded by attribute view

You can color-code the calendar display for Lists, On-demand Campaigns, or Corporate
Campaigns by selected attributes. You can apply color-coding to a calendar grid view or to a

timeline view.

You can filter the calendar display for Lists, On-demand Campaigns, or Corporate

Campaigns according to the values of a selected attribute, such as the following.

» Execution status
» Schedule status

» Template type

The calendar displays a legend in the lower-right corner of the screen.

For example, consider the following On-demand Campaign attribute and its possible values:

« Attribute name: Campaign Execution Status

« Valid attribute values: Active, Complete, Under development

If you group and display On-demand Campaigns by Campaign Execution Status, the
resulting calendar is displayed with four colors in the legend. There is one color for each

valid attribute value, and one for N/A.

[5) Note: The color that is assigned to N/A is displayed in the calendar when calendar

items are not assigned a value for the selected attribute.



Corporate Marketer's Guide | 2 - Customize Collaborate | 15

Horizontal bars used in calendars

The timeline view and calendar grid view display calendar items as horizontal bars.

Note the following information about bars:

« The bars represent the date range for objects that are displayed on the calendar.
« The bar color depends on values of an attribute you optionally select for color coding.
« The shape of the bars determines the following about item start and end dates:
> Rounded left end: The start date is the date indicated by the left end of the bar.
> Rounded right end: The end date is the date indicated by the right end of the bar.
o Flat left end: The start date is before the visible date range.
o Flat right end: The end date is beyond the visible date range.

Accessing the calendar

You can access the calendar for Lists, On-demand Campaigns, or Corporate Campaigns by

clicking the Set View Options icon.

1. From the Collaborate menu, select Lists, On-demand Campaigns, or Corporate

Campaigns.
2. From the View menu, select Set View Options.

3. Set the view options.
You can display the calendar as a Timeline, a Text Calendar, or a Graphical Calendar.

4. Click Apply.

Navigating the calendar

All calendar/timeline views contain the following icons:
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lcon

Description

Opens the Set View Options dialog box. Use this link to change the way
that the calendar is displayed.

Opens the Advanced Search dialog box.

Changes the date range that is displayed, moving back one unit in time.

For example, if your current calendar view is a monthly timeline of

September 20009, clicking — displays August 2009.

Current date

range

Opens a drop-down list of available date ranges. Use this link to quickly

change to any other date range.

For example, if you are viewing a monthly calendar for July 2009, you
can change the view to January 2010 by clicking this link and then

choosing January 2010 from the drop-down list.

Changes the date range that is displayed, moving forward one unit in

time. For example, if your current calendar view is a weekly timeline

from 7/20/2009 through 7/26/20009, clicking displays 7/27/2009
through 8/2/2009.

Setting per-session calendar views

You can change the views of the calendar from default settings by clicking View from the

Calendar page or a listing of Lists, On-demand Campaigns, or Corporate Campaigns.

1. Access the calendar.

2. Click View.

The Set View options dialog box opens.

3. Select options to change the view.
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4. Click Apply.

Accessing calendar objects by date

You can filter the calendar to display all of the Collaborate objects for a selected date.

You can view all the objects at a more granular level. For example, if the calendar is
displaying Corporate Campaigns for June 2009, you can click 7 to open a list page that

contains all Corporate Campaigns whose date ranges contain June 7th, 2009.
Click the date in an open calendar that displays Lists, On-demand Campaigns, or Corporate

Campaigns.

Accessing an object from the calendar
You can view the List, On-demand Campaign, or Corporate Campaign from its calendar.

Click the List, On-demand Campaign, or Corporate Campaign on the calendar.

The List, On-demand Campaign, or Corporate Campaign opens.

Exporting the calendar

You can save a snapshot of the current calendar in HTML format.

1. With the calendar open, click the menu next to the printicon ( = ) and select Export.

2. Choose one of the following options:
« Click Open to open the compressed file of the calendar.
« Click Save and choose a location to save the calendar to disk.

« Click Cancel to return to the Calendar screen without publishing.

The system publishes the calendar into a compressed file archive.
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Publishing the calendar

You can save a snapshot of the calendar at a certain moment in time. When you publish the

calendar, you chose which information you want to display and how you want to display it.

To get a snapshot of the current calendar, save it in HTML format (into a ZIP compressed

archive file).

1. Choose the calendar view to publish.

Select the objects, time range, and appearance for the calendar view. You can make

selections in either of the following ways:

« From the Local Marketing menu, select Calendar. Then, select items to view.

« At a list page for Lists, On-demand Campaigns, or Corporate Campaigns, click the

View icon ( ) and choose a calendar view.

[5) Note: If the current calendar view includes projects, Project data is exported as
well. The exact data that is exported depends on how the project template was set up;

Summary and custom tabs might be exported for some or all projects.

2. Click the Print icon (') and select Export.

3. Take one of the following actions.
« Click Open to open the compressed file of the calendar.
« Click Save and choose a location to save the calendar to disk.
« Click Cancel to return to the Calendar page without publishing.

The system publishes the calendar into a compressed file archive. You can use any
application for working with compressed files to access the calendar HTML pages. You can
go to the next and previous pages of the calendar view in your web browser. If you exported

any project data, you can also go to that data from the calendar HTML pages.
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Viewing the timeline

If you choose a timeline view, you can choose from several date ranges. The screen can

display data for a single week all the way up to data for an entire year.

Timeline view of the calendar

If you choose a timeline view, you can choose from several date ranges. The screen can

display data for a single week, up to data for an entire year.

The timeline view displays a grid-like view of the objectsthat you selected and filtered (for
example, Active Lists). The objects are organized by a unit of time, depending on which
timeline view you selected.

Each object is displayed in a horizontal bar across its date range. The name of the object

displays on the bar.

[5) Note: If you select Enable Color Coding from the calendar view options screen, the bar

for each object is displayed in a color that is based on an attribute you chose.

Choose a date-range for the timeline.

» Week: displays one week, with each day listed as a column. The starting day is either
Sunday or Monday depending on the option that is selected in the Calendar/Timeline
Settings page.

« Month: displays a single calendar month. Each day is listed as a column, and days are
grouped into weeks.

« Quarter: displays three calendar months. Each week is listed as a column, and those
weeks are grouped into months.

« Fiscal Year: displays a fiscal year. The starting month depends on a configuration
setting, fi r st Mont hi nFi scal Year. Each month is listed as a column, and the months
are grouped into quarters.

« Calendar Year: displays a calendar year, which starts in January and ends in December.

Each month is listed as a column, and the months are grouped into quarters.
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[5) Note: Any day that is specified as non-work time has its column that is disabled.
Additionally, the name of the non-work time (for example, "Labor Day") displays when you
point to the date. This feature is not available when the time scale is Quarter, Fiscal Year, or
Calendar Year.

Navigating the timeline view

You can navigate the timeline by doing any of the following:

» Click the expand icon (+) next to an object to display objects that are contained in the
hierarchy.

« Click the expand icon (+) next to an object to display tasks within the workflow for that
object.

« Click the object name to drill down to a timeline that contains the objects contained in

its hierarchy.

[5) Note: Clicking a task opens the Workflow page of the project with which the task is

associated.

» Click the zoomin (") and zoom out () icons. These icons are displayed above the
timeline. Zooming changes the date range of the timeline. For example, zooming in
from a monthly timeline takes you to a weekly timeline. The top level is (fiscal) yearly,

and the lowest level is weekly.

Text or graphical calendar views

The calendar views display data for a selected month. The view contains a cell for each day
of the selected month. The cell for a day contains either a list of items active on the day

(text) or a portion of a horizontal bar for each active item (graphical).

The page displays a grid that contains a column for each day of the week: either five
columns that represent the weekdays, or seven, if you choose to display weekend days. You
set this option on the Calendar/Timeline Settings page. The page contains either five or six

rows, each representing a week.
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Monthly calendar

The monthly calendar view displays a calendar of the selected month. It lists the objects

you selected and filtered on (for example, Active Lists).

Choose either of these monthly calendar views.

 1-Month Text: Each day contains a list of objects. An object is displayed for all days in
its date range.

« 1-Month Graphical: Each object is displayed in a horizontal bar that begins on its start
date and ends on it end date. If you select Enable Color Coding from the calendar view

options page, the bar for each object appears in a different color.

[5) Note: Any day that is specified as non-work time is indicated by a gray X in the
background. Additionally, the name of the non-work time (for example, "Labor Day") displays

when you point to the date.

Navigating the text/graphical calendar

Navigate the calendar by performing any of the following actions:

« Click the object to display its summary page. For example, clicking a project opens the
project's List opens the List's Summary page.
« Click the date to display a list page that contains objects that fall on that date.

Calendar color coding

You can display objects in a color-coded manner on either the graphical calendar or in the

timeline views.

First, select the Enable Color Coding check box in either the Calendar/Timeline Settings
page or the Set View Options dialog box. After you check the box, the Based on values
for menu opens. This list contains attributes for your Lists, On-demand Campaigns, and
Corporate Campaigns(depending on which objects you are currently displaying in the

calendar).
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From this list, you can choose any attribute that is an enumerated type. For example,

consider the following attribute:

« Name: Product Family

« Valid values: CDs, Credit Card, Home Mortgage

If you choose to group objects by this attribute, your calendar contains four colors: one for
each valid value, CDs, Credit Card, and Home Mortgage, and N/A. N/A corresponds to any

objects that do not contain a value for the Product Family attribute.

The calendar also displays a legend in the lower-right corner of the screen. The legend
lists all valid values (CDs, Credit Card, and Home Mortgage, and N/A) along with the color
corresponding to that value.

[5) Note: You can also color code by the template on which the project is based.

Horizontal bars on the calendar

The timeline view and graphical calendar view display horizontal bars. The bars help

illustrate the duration and dates of calendar objects.

Note the following information.

« The bars represent the date range for objects that are displayed on the calendar.
« The name of the object displays on the bar.
« The bars can be colored based on an attribute you select.
 The shapes of the bars indicate the following conditions of the object.
> Rounded-end "start": indicates that the object starts on the date where the bar has
arounded end.
> Rounded-end "end": indicates that the object ends on the date where the bar has a
rounded end.
o Flat-end "start": indicates that the object starts before the visible date range.

> Flat-end "end": indicates that the object ends after the visible date range.
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Color-coding calendar items

You can use color-coding to display objects in a calendar according to a selected attribute.

You can display different colors of Corporate Campaigns, according to whether the

Corporate Campaign is active or not.

[5) Note: You can also set color-coding for the default calendar settings.

1. Open one of the following:
« Calendar
* Lists
 Corporate Campaigns
» On-demand Campaigns

2. Click View.

The Set View Options dialog box opens.
3. Check Enable Color Coding.

4. Choose a calendar item and corresponding attribute on which to base color-coding

from the lists that are displayed.

5. Click Apply.

Zooming in or out of a timeline view

When you select a timeline view, you use the zoom feature to expand or collapse the date
range for the view.

The top level for zooming out displays a year-based date range.

The lowest level for zooming in displays a week-based date range.

For example, zooming in from a monthly timeline takes you to a weekly timeline.

Click the zoom inicon ( ") orzoom outicon ( ) to change the view.
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Viewing the server clock and time zone

You can view the server live clock and time zone information on tabs and pages of Lists, On-

demand Campaigns, and Corporate Campaigns.

You can have your administrator set the showServerLiveClock parameter to view the server
time zone and live clock that shows the server time on the Summary and Workflow tabs, the
Scheduler pop-up window, and post-task pop-up pages of Lists, On-demand Campaigns, and

Corporate Campaigns.



Chapter 3. Corporate Campaigns

Corporate Campaigns are marketing campaigns that are planned, scheduled, and executed

by a centralized marketing team.

Corporate Campaigns are campaigns that present a corporate marketing message to
targeted contacts. In Collaborate, Corporate Campaigns execute on a fixed schedule, which

you specify by using scheduled workflow tasks in the Corporate Campaign Workflow tab.

Corporate marketers typically use Collaborate to incorporate recommendations about which
target customers to include with a Corporate Campaign from field marketers throughout
an organization. A Corporate Campaign allows corporate marketers and field marketers to

collaborate on a corporate-level campaign.

Why field marketers participate in Corporate
Campaigns

By participating in Corporate Campaigns, field marketers help distribute the marketing
campaign effort, enabling the organization to take advantage of the marketing design and
strategy expertise that is provided by a central team of marketing specialists, as well as the

familiarity field marketers have with their personal contacts.

Corporate marketer's role in a Corporate Campaign
Using Collaborate, corporate marketers present the following to field marketers:

« The campaign marketing initiative, in the form of marketing messages and other
materials

« The portions of a proposed target list that are assigned to each field marketer

Field marketer's role in a Corporate Campaign

Field marketers participate in specific Corporate Campaigns. Optionally, you can use the
Subscription feature to manage field marketers' participation in Corporate Campaigns.
Participating field marketers review their portions of the proposed target list and provide

input to corporate marketers about whom to add or delete from the campaign. After each
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field marketer provides final feedback on their portion of the list, the corporate office fulfills

the campaign.

Examples
The following examples illustrate situations in which field marketers decide which

customers to include in a Corporate Campaign:

« One field marketer may decide that a particular corporate initiative is not appropriate
for some of their assigned customers and removes those customers from the
proposed target list.

« Another field marketer may not have enough resources to handle the demand that is
generated by the corporate initiative. In this case, the field marketer decides to remove
some customers from the proposed target list.

« Another field marketer may want to include customers that are not originally targeted

by the corporate marketing campaign, and adds them to the proposed target list.

How Corporate Campaigns link to campaigns in
Campaign

You create a Corporate Campaign in Collaborate. Then, through the Corporate Campaign

user interface, you create a linked campaign in Campaign.

The values of the following attributes of the campaign that is created in Campaign match

the values in the Corporate Campaign you created in Collaborate:

« Campaign name

« Campaign code

« Target start and end dates

« Any custom fields that are assigned in the data mapping between Collaborate and

Campaign.
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Matching campaign codes

Corporate marketers must ensure that the Corporate Campaign code matches that of the

campaign in Campaign.

Corporate Campaign template designers can create the templates so that these two codes

match automatically when:

1. Corporate marketers create the Corporate Campaign before they create the linked
campaign in Campaign.
2. Corporate marketers use Collaborate to initially create the linked campaign in

Campaign.

[5) Note: In order for corporate marketers to create linked campaigns, the corporate

template developer must map the data between Campaign and Collaborate.

Corporate Campaign workflow

The workflow for a Corporate Campaign includes designing the campaign, creating a

proposed target list, and incorporating field marketer feedback.

Corporate and field marketers typically work on Corporate Campaigns as follows:

1. Corporate marketers design the corporate marketing campaign.

2. Corporate marketers create a Corporate Campaign in Collaborate.

3. Using the optional Subscription workflow task, corporate marketers invite appropriate
field marketers to subscribe to the Corporate Campaign.

. Field marketers subscribe to the Corporate Campaign.

. Corporate marketers create the proposed target list for the campaign.

. Corporate marketers notify field marketers of the availability of the List.

N o o b~

. Field marketers review the Corporate Campaign and provide feedback to corporate
marketers on the target list.

8. Corporate marketers can check field marketer review status.

9. Corporate marketers incorporate field marketer feedback to generate the final target

list.
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10. Field marketers optionally analyze campaign success.

Example flow for creating a Corporate Campaign
target list

Corporate marketers generate a proposed target list that field marketers review and revise.

Then, the corporate marketer generates the final target list.

In this example, the corporation is a financial institution. A corporate marketer is introducing
a new financial product and expects marketing decision feedback from a team of field
marketers.

The corporate marketer generates a proposed target list

After you design a marketing campaign for the new financial product, the corporate
marketer selects customers from the corporate database who are appropriate recipients of

this campaign.

The corporate marketer may use the optional Subscription task in the workflow to invite the

appropriate field marketers to participate in the Corporate Campaign.

If the corporate marketer does not use the Subscription task, all field marketers who have
access to any records in the original target list (as defined by Data Level Filters) are invited
to participate in the Corporate Campaign through its Field Marketer Notify task. If there
are no data level filters, all field marketers are automatically invited to participate in the

Corporate Campaign, and they receive notifications to review of the target list.

Field marketers review the proposed target list

Field marketers subscribe to the Corporate Campaign. They then review their portions of the
target list.

Field marketer target assignments are made through the corporate database. For this
example, assume the following target assignments for two field marketers within the same

corporation:
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« Field_Marketer_1 is responsible for target_FM11 and target_FM12.
- Field_Marketer_2 is responsible for trget_FM21, target_FM22, and target_FM23.

Field marketers can view only those target customers that are assigned to them from a
Corporate Campaign, as defined through data level filters.

In this example, the following occurs:

- Field_Marketer_1 accepts both of their target customers on the proposed list.

« Field_Marketer_2 declines all of their target customers on the proposed list because of
business constraints.

« Both field marketers finalize their customer selection for the Corporate Campaign.

« Final customer selections that are made by the field marketers are recorded in the
database that is used by Campaign.

The corporate marketer generates the final target list

After the field marketers review the proposed customers and make their final decisions, the
corporate marketer generates a final target list that incorporates field marketer feedback.
When they are satisfied that the list review is complete, they can click Verify and Lock, and
mark the Review List task as complete in the workflow, to enable the Fulfillment tasks to
begin.



Chapter 4. Corporate Campaign tasks

The goal of a Corporate Campaign is to target customers that local field marketers

approved.

To reach the fulfillment of the Corporate Campaign, corporate marketers perform the

following tasks:

1. Create Corporate Campaigns (on page 30).

2. Assign and invite people to a Corporate Campaign (on page 31).

3. Link a Corporate Campaign to Unica Campaign (on page 36).

4. Generate a target list from the flowchart (on page 37).

5. Submitting the target list to field marketers (on page 38).

6. Checking the validation status for target lists (on page 39).

7. Eulfill the Corporate Campaign (on page 40).

Create Corporate Campaigns

Corporate marketers create Corporate Campaigns with a wizard that guides them through

the required steps.

In the first step, corporate marketers select a Corporate Campaign template on which the
new Corporate Campaign is based. The template should have the required tabs, workflow,
people, and other settings for the Corporate Campaign. Corporate marketers can then

modify the Corporate Campaign as necessary.

Required information
The following information is required when you create a Corporate Campaign:

- Target start date
« Target end date
« Corporate Campaign code, which you can generate automatically
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Post-creation tasks
After you create the Corporate Campaign, corporate marketers can do the following tasks.

- Attach campaign messages or other information about the initiative.

« Assign participants to the Corporate Campaign.

Creating a Corporate Campaign

You can create a Corporate Campaign by selecting a template and following the steps of the
Wizard.

1. From the Local Marketing menu, select Corporate Campaigns.

2. Click the Add icon (' ).

The Select a Corporate Campaign Template dialog box opens. Templates are listed on

the left. If you select a template, information about that template appears on the right.
3. Select a template from the list on the left, and click Continue.

4. Continue through the Wizard pages, entering all required information, and optional

information as needed.

5. Click Finish after you enter the necessary information.

The new Corporate Campaign is saved.

You can modify the Corporate Campaign as necessary now.

Assign and invite people to a Corporate Campaign

You can manually assign users to participate in a Corporate Campaign and automate the

invitation process.
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Manually assigning users to a Corporate Campaign
You can manually assign users as participants in a Corporate Campaign in either of these
ways:

» When you create a Corporate Campaign, you can select participants through the

Corporate Campaign wizard.

Assigning field marketers to the Corporate Campaign is automated through the Notify
Field Marketer task in the workflow.
* You can view and assign Corporate Campaign participants from the People tab of a

Corporate Campaign after you create the Corporate Campaign.

You can assign participants as individuals, or by role. When you assign participants by role,
you can assign an entire group of field marketers to participate in a Corporate Campaign at

once.

Automatically inviting field marketers to a Corporate Campaign

You can automate the field marketer invitation process by using one of two tasks in the
Corporate Campaign workflow:

* Notify Field Marketer task
« Subscription task

[5) Note: If you are manually inviting field marketers, ensure that you do not include these
tasks in Corporate Campaign workflow, so that field marketers do not receive automatic

invitations.

People tab
Each Corporate Campaign contains its own People tab.

Use this screen to do the following activities.

« Manage the members of a Corporate Campaign.

« Edit the access level for a member.
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« Replace a person in a role when a team memberuser becomes unavailable.
+ Add or remove a role.

« Track team members or request recipients who are out of the office, their delegates,

and start dates. (Displays for project or request owners only.)

A Corporate Campaign template can contain information about the functional roles for the
project. A template can reduce some of the work necessary to assign people or teams to
units of work within the Corporate Campaign.

[5) Note: By default, the People tab is available only for Corporate Campaigns. For
information about making it available for Lists or On-demand Campaigns, see the
Collaborate Administrator's Guide.

Managing Corporate Campaign members

Use the People tab of the Corporate Campaign to manage team members.

To manage Corporate Campaign members, complete the following steps.

1. Click Edit Member/Role Settings icon ( ™ ).Members.

The Select Team Members dialog box opens.

2. Do any of the following options:

« To add a person or team, select the name from the left pane of the dialog, and click

>>,

» To remove a person or team, select the name in the Select Team Members list box
and click <<.

« To change the role for a person or team, select the name in the Select Team
Members list box then click Up and Down to move it to the required role.

[5) Note: You cannot remove a user or team that is assigned to a task.

3. Click Save Changes.
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The Select Team Members dialog box closes. The People tab becomes the active

window.

The changes that you make are reflected in the list of people and roles. For example, if you

added a creative lead, the screen would contain a line similar to the following example:

Menber/ Access Level Rol e Emmi | Address

P Picasso (participant) Creative Lead ppi casso@ryconpany. com

Selecting team members for a Corporate Campaign
You can select other Collaborate users to participate in the Corporate Campaign.
You can assign participants as individuals, or by role. When you assign participants by role,

you can assign an entire group of field marketers to participate in a Corporate Campaign at

one time.

1. Open the Corporate Campaign.

2. Open the People tab.

3. Click the Edit Member/Role Settings icon ( ™).

The Select Team Members dialog box opens.

4. To assign team members by role:
a. In the upper left of the dialog box, click Roles.
b. Select roles to assign to the Corporate Campaign from the list on the left.
c. Click the right-pointing arrow button to move the selected roles to the Selected

Team Members list on the right.

5. To assign individual users:

a. In the upper left of the dialog box, click Folders.
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b. Expand the folder entries and select individuals to assign to the Corporate
Campaign from the list on the left.
c. Click the right-pointing arrow button to move the selected users to the Selected

Team Members list on the right.

6. Click Save Changes.

You can now assign work for the Corporate Campaign by role.

Editing Corporate Campaign member access levels

You can control the access level other Collaborate users have to the Corporate Campaign.

You can specify whether users are Owners or Participants of the Corporate Campaign. The
specific privileges of Owners and Participants are determined by the user permissions that

are defined by the Collaborate administrator.

1. Open the Corporate Campaign.

2. Open the People tab.

3. Click the Edit Member/Role Settings icon ( ™).

The Select Team Members dialog box opens.

4. To add users:
a. Expand the folder entries and select individuals to assign to the Corporate
Campaign from the list on the left.
b. Click the right-pointing arrow button to move the selected users to the Selected

Team Members list on the right.
5. To make a user an owner of the Corporate Campaign:
a. In the Selected Team Members list, select the user.

b. Click Up.



Corporate Marketer's Guide | 4 - Corporate Campaign tasks | 36

Repeat this step until the user appears under Owner in the list.
6. To make a user a participant in the Corporate Campaign:
a. In the Selected Team Members list, select the user.

b. Click Down.

Repeat this step until the user appears under Participant in the list.

7. Click Save Changes.

Link a Corporate Campaign to Unica Campaign

After you create a Corporate Campaign and assign members, you must create a campaign

in Campaign that is linked to the Corporate Campaign.

You must link a Corporate Campaign to a campaign in Campaign so that flowchart run
tasks in the workflow of a Corporate Campaign can execute flowcharts that are part of the

campaign.

You can create a linked campaign directly from Collaborate. After you do this, you can

create and run the flowchart for the linked campaign in Campaign.

After you link a campaign in Campaign to a Corporate Campaign, you can open the

campaign in Campaign from the Corporate Campaign.

Creating a campaign linked to a Corporate Campaign

You can create a campaign that is linked to a Corporate Campaign in Campaign while you
work directly with a Corporate Campaign.

1. Open the Corporate Campaign.

2. In the Summary tab, click the Create a Linked Campaign icon ().

3. From the icon's drop-down list, select Create a Linked Campaign.
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The linked campaign is created in Campaign.

Accessing a Corporate Campaign from Campaign

If you are working on a campaign in Campaign, you can open a Corporate Campaign.

1. Open the Summary tab of the campaign.
2. Click the Collaborate link in the form of the tab.

The Summary page of the Corporate Campaign opens.

Generate a target list from the flowchart

After you create a Corporate Campaign and link it to a campaign in Campaign with the same
ID, you must create and publish the campaign flowchart in Campaign to generate the list of

proposed targets for the Corporate Campaign.

Opening a linked campaign in Campaign
The Implementation icon shows you the summary page of the campaign.

Click the Implementation icon in the form of a tab of the Corporate Campaign page.

The Summary page of the campaign in Campaign opens.

Creating and running the flowchart for the linked campaign

From the Flowchart tab for the linked campaign, you can create a flowchart with the same

name and run the flowchart.

1. In Campaign, select the Flowchart tab for the linked campaign.

2. Create the flowchart with the same name as defined in the Corporate Campaign
workflow to select the target list according to your corporate campaign strategy.

3. Publish the flowchart.
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You can now confirm the target start and end dates and start the Corporate Campaign.

Submitting the target list to field marketers

You can notify field marketers that you are distributing the target list for them to review their

portion.

You can use the field marketer notification feature to notify participant field marketers who

are responsible for targets on the list.

Notifying field marketers

Note the following about notifying field marketers to review a proposed target list for a

Corporate Campaign:

* You must first generate the proposed target list.

* You must be the Corporate Campaign owner.

« Only field marketers responsible for targets on the proposed target list are notified.
« Each field marketer who is responsible for targets in the list receives a personalized

message you type, along with a message similar to the following.

The canpai gn Name has just started. You have until Date to validate

the |list content.

[5) Note: A field marketer becomes responsible for target records through data level
filters. If data level filters are not defined, then all field marketers are notified during the

execution of the Notify Field Marketer system task.

Notifying field marketers to review a proposed target list using
notifications

You can use notifications to alert field marketers to review the Corporate Campaign

proposed target list.
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1. Open the Summary tab of the Corporate Campaign.
2. Click Notify the Field Marketers.
[5) Note: This task depends on a List Generation task.

3. Optional: Select a role to assign the Corporate Campaign review to a group of field

marketers.
4. Type a personalized message.

5. Click OK.

Checking the validation status for target lists

You can check the review status for a Corporate Campaign to see that participating field
marketers made final decisions on the proposed target list before you generate the final

target list.

Checking the validation status for Corporate Campaign lists

You can check the validation status for Corporate Campaign lists by viewing the data.

1. Open the Summary tab of the Corporate Campaign.
2. Open the Analysis tab.

3. View the validation data.

The work of each field marketer is complete when the status of all records is Validated
or Added.
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Fulfill the Corporate Campaign

After your participating field marketers finalize selections for the proposed target list, the
field marketers' choices are recorded in the uacc_corporate_l i st s table in the Campaign

database.

In this table:

* Records with a value of Ain the status column were added by field marketers.
« Records with a value of Vvin the status column were validated by field marketers.

Validated records are accepted in the target list, and locked.

The final stage of the Corporate Campaign consists of running the campaign to deliver the

offer to the final targets through a selected channel such as mail or email.

You fulfill the Corporate Campaign by running the fulfillment flowchart in Campaign.

Selecting the finalized list for the new flowchart

1. Open the linked campaign in Campaign.
2. Create a flowchart.

3. Select target records from the uacc_cor porate_| i st s database table for which the
status is A (for added records) or V (for validated (accepted and locked) records from

the original list).

4. Complete the flowchart with any required exclusion rules with processes for any of the
following.
* Generating targets
- Generating output data

« Response tracking
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Fulfilling a Corporate Campaign

To fulfill a Corporate Campaign, you must set the dates for the campaign and run it.

1. In the workflow for the Corporate Campaign, create the flowchart run task.
2. In Campaign, create and publish the flowchart.

3. Set the dates for the Corporate Campaign and run it.



Chapter 5. Corporate Campaigns and field
marketers

When a corporate marketer uses the Subscription task in the workflow for a Corporate

Campaign, invited field marketers choose whether to subscribe to the Corporate Campaign.

When field marketers subscribe to a Corporate Campaign, they provide corporate marketers

with recommendations about which target customers to include in the campaign or wave.

By using field marketer recommendations, central marketing teams can run programs on
behalf of some or all of their field marketing teams, while they allow field marketers to

provide input about specific individuals to contact.

Multi-wave Corporate Campaigns and field marketers

When a Corporate Campaign contains multiple waves, and uses the Subscription system
task in the workflow, invited field marketers choose which waves to subscribe to. A field

marketer can subscribe to any subset of waves in the Corporate Campaign.

Field marketer access to Corporate Campaigns

By default, only corporate marketers are authorized to create and modify all aspects of
Corporate Campaigns. As a field marketer, you can view Corporate Campaigns to dwhich

you subscribed.

You can view proposed target customers that are assigned to you. You cannot view target

customers that are assigned to other field marketers.

You can typically perform the following tasks:

« View the Corporate Campaign summary.

« View any attachments included with the Corporate Campaign.

* Review, accept, add, or remove target customers from the proposed target list.
« Finalize your portion of the proposed target list.

« View the calendar to see the Corporate Campaign schedule.
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For more information about your access privileges, see you administrator.

Corporate Campaign proposed target lists

The proposed target list for a corporate marketing campaign is the initial list of customers
for whom the campaign is intended when the campaign is first designed by a corporate

marketer.

These customers are associated with field marketers in the corporate database; for

example, the associations may be based on the customer's region.

Field marketers are assigned those proposed target customers in a Corporate Campaign to
whom they are associated. They must then review those customers and decide on the final

list for the Corporate Campaign.

Field marketers can:

« Accept or decline each customer.
« Add target customers to the list of proposed customers.
- Finalize the target list for the Corporate Campaign.

Corporate Campaign proposed target lists review
There are several tasks field marketers can perform for Corporate Campaigns.

Field marketers typically perform the following tasks for Corporate Campaigns to which

they are subscribed:

* Review Corporate Campaign status information and other data in the Corporate
Campaign Summary page.
« Review attachments to the Corporate Campaign.

Corporate marketers may include attachments to provide field marketers with
information that is relevant to the Corporate Campaign. For example, an attachment
may contain marketing messages.

« Review their portion of the proposed target list.



Corporate Marketer's Guide | 5 - Corporate Campaigns and field marketers | 44

« Provide the corporate marketer with recommendations for modifications to the

proposed target customer list.
Note the following:

« The changes field marketers make to the proposed target customer list are stored in
the corporate database; corporate marketers access the changes there.
« When field marketers finalize their portions of the proposed target list, target customer

review data status is updated in a database table.

Adding customers to a Corporate Campaign

Field marketers can add target customers to a proposed list for a Corporate Campaign to

which they subscribe.

Corporate marketers may propose that the list targets previous customers, for example,
while field marketers have new target customers in mind. Field marketers can filter their

lists of personal contacts to select target customers to add.

When field marketers add customers to the proposed list for a corporate marketing
campaign, they can select a set of customers with specific characteristics. For example,
corporate marketers can allow field marketers to select from the following criteria when

adding customers to a proposed list:

*« Name
* Age

* Income range

Making permanent additions and deletions to a list

When you work with a recurring workflow, you might be tasked with several list review steps

within the course of a single Corporate Campaign.

If wanted, you can make permanent additions or deletions from the list; these additions or

deletions remain in effect for all future occurrences of the List Review task.
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[5) Note: The ability to make permanent additions or deletions to a contact list is controlled
by the Review List task in the Corporate Campaign workflow. If this option is not selected
for a List Review task, you are not able to add or delete contacts permanently in the

corresponding list.

When to add or remove contacts permanently

You should make permanent additions or deletions to a list when the following statements

are true:

* You are using a recurring workflow.

« The recurring workflow includes several List Review tasks.

* You know that the list as generated is incomplete; you need to add or delete contacts.
You want these additions and deletions to remain in effect for each future occurrence

of the recurring campaign.

Reviewing proposed target customers for a Corporate Campaign

When you participate in a Corporate Campaign, you must review the proposed target

customers for that campaign.

When you are presented with a proposed list of target customers for review, you must either
accept or decline each customer before you can finalize your target list selections for the

corporate campaign.

You can accept or decline proposed target customers individually, or all at one time. You

can also add one or more of your customers to the proposed list.

In recurring Corporate Campaigns, if you are allowed to do so by the campaign creator, you
can add to or exclude contacts from a list for each recurrence of the workflow. When you
add or remove contacts in this way, the changes you make remain in effect throughout all
list review tasks within the recurring workflow. If you are not allowed this option, you can

modify only the target list for the current occurrence of the workflow.

1. Open the Corporate Campaign.
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2. In the Summary page, click Waiting items.

The Contact to Validate page opens.

3. Accept or decline customers as needed.

« To accept all proposed customers, click Accept All Records.

« To decline all proposed customers, click Decline All Records.

« To accept specific customers only, check the Accept column in the rows for those

customers.

« To decline specific customers only, check the Decline column in the rows for those

customers.

« To decline specific customers permanently, check the Dec. Perm. column in the

rows for those customers.

» To add customers:

a.

Click Search and Add Records.
Records added using this link get added to the Newly Added by Field Marketer

list.

[5) Note: This link is not available on the list manager screen for Declined

Records.

. Select one or more target list filtering criteria from the options that are

presented on the form, then click Search.

The target records resulting from your search are displayed.

c. Check one or more of the customer records to add to the target list.
d. Click Accept Selected.

If you selected to add or delete contacts permanently, a message opens
asking whether you want to add the contacts permanently for recurring

campaigns.

. Click OK to make the additions permanent.

Or click Cancel to make the additions apply to the current occurrence only.

4. Optional: Check After the next save, consider my review complete to validate and lock

this list when you save changes.
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[5) Note: If you do not check this option, any customer records that you do not accept

or decline are displayed when you next review the target contacts.

[5) Note: Added contacts do not display until you close the window and click Newly
added by Field Marketer.
5. Click Save to save changes and complete your review of the proposed target list.

Accepted and removed contacts disappear from the list, and are only viewable in the

Accepted/removed lists page.

Viewing or accepting previously declined targets

You can view previously declined target customers before you finalize your portion of the

proposed target list, and, if wanted, accept those customers.

1. Open the Corporate Campaign for which you declined target customers on the

proposed list.
2. Click View Declined.

3. You can accept any declined target customers from this list by checking the customer

entries under the Accept column.

You can also select Accept All Records or Set All Records to Review to accept or

review all the previously declined records.

Those customers are now included in the list.

You must now finalize the list.

Viewing or declining previously accepted targets

You can view previously accepted target customers before you finalize your portion of the

proposed target list, and, if wanted, decline those customers.
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1. Open the Corporate Campaign for which you accepted target customers on the

proposed list.
2. Click View Accepted.

3. You can decline any accepted target customers from this list by checking the customer

entries under the Decline column.

You can also select Decline All Records or Set All Records to Review to decline or

review all the previously accepted records.

Those customers are now removed from the list.

You must now finalize the list.

Viewing or removing added targets

You can view previously added target customers before you finalize the proposed target list.

You can also remove previously added target customers.

1. Open the Corporate Campaign for which you added customers to the proposed list.
2. Click View Additions.

3. You can remove any added target customers from the list by checking the customers

under the Remove column.

You can also select Decline All Records to decline all the previously accepted records.

Those customers are now removed from the list.

You must now finalize the list.

Finalizing your portion of a Corporate Campaign target list

You can finalize the proposed target list for a Corporate Campaign by validating and locking

the target list.
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You can finalize the proposed target list after you have:

« Reviewed the proposed target list.
« Accepted or declined each customer in the proposed target list.

« Optionally, added target customers to the proposed list.

1. Open the Corporate Campaign.
2. In the Summary page, click Validate and lock list.

@ Note: You cannot reverse this action.

The list is now finalized.



Chapter 6. Subscriptions

A subscription is the invitation to a field marketer to include their territory in a Corporate

Campaign, or a wave of a multi-wave Corporate Campaign.

Through subscriptions, field marketers can control which Corporate Campaigns and waves,

and potentially which territories within a campaign or wave, they participate in.

In addition, supervisors can control the Corporate Campaigns or waves their staffs
participate in. When a supervisor subscribes to a Corporate Campaign, field marketers
that are under the supervisor in a defined territory hierarchy are also subscribed to the
campaign. For example, if the territory supervisor for New England subscribes to a

corporate campaign, the state manager for Vermont also participates in the campaign.

Subscriptions and data level filters

Subscriptions can be used in combination with data level filters to control both what data is
included in the generated list of customers for a Campaign, and who is invited to review the

list of customers that is generated.

Example

If MA_FM is the field marketer for Massachusetts (MA), you can use a state-level
subscription to invite MA_FM to include or exclude Massachusetts customers from the
Corporate Campaign contact list. If MA_FM accepts the invitation, MA customers are on the
contact review list. Using data level filters, MA_FM can also be configured to see only MA
customers, thus limiting their view to those customers of interest to them. When data level
filters are present, only Field Marketers who have data of interest on the generated list are
invited by the Notify Field Marketer system task.

Subscriptions can operate at multiple levels. So for example, NE_LFM might be the Northeast
Regional FM who supervises the state field marketers in their region, which might include
Massachusetts. The corporate marketer can invite regional field marketers to subscribe for
their region.

If NE_LFM is invited to subscribe, they can accept or decline. If they accept, data for all

customers in their region are included in the list generation. So continuing the example
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above, data for Massachusetts's customers would be included in the list. In this case,

the MA_FM has no control over whether MA data is included, because the subscription
invitation is issued at the region level. However, if the data level filters are configured to
allow MA_FM to see MA customers, MA_FM is invited to review the MA customers when the

Corporate Campaign contact list is generated.

Defining territories

To support subscriptions, the administrator must define a territory hierarchy on the

Collaborate server. For more information, see the Collaborate Administrator's Guide.

The Subscription task in a Corporate Campaign
workflow

Corporate marketers enable subscriptions by adding the Subscription task to the Corporate

Campaign workflow or to each occurrence in a recurring workflow.

By defining Subscriptions tasks in workflows, as opposed to the Corporate Campaign as
a whole, you enable field marketers to subscribe to individual waves, drops, and lots of

recurring Corporate Campaigns.

The Subscription task is a system task and starts and stops automatically according to its

target start and end dates.

The Subscription task and territories

Subscription invitations are sent to field marketers based on their associated territories.

Territories are defined in a hierarchical relationship. For example, a typical hierarchy would
be:

Country
Regi on

State
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In this scenario, there could be a Country manager for each country, under which there
would be several region managers for the regions in the country. Under each region

manager, there would be managers for each state in the region.

When a corporate marketer configures the Subscription task, they specify the following.

1. Selection Level
2. List of Territories
3. Subscription Level

Selection Levels

The Selection Level in a Subscription task filters territories and subscription levels that are

available to the corporate marketer.
All levels of the defined territory hierarchy are available values for the Selection Level.

For example, the corporate marketer might select one of the following.

- Country, in this case the top level in the territory hierarchy. These countries, for example
the United States, France, and Germany among others, become the options in the List
of Territories field.

« Region, the second level in the territory hierarchy. Each country contains multiple
regions; each region contains multiple states.

- State, the bottom level in the territory hierarchy. Each state is grouped under a region.

List of Territories

The Selection Level determines the territories that appear as options in the List of

Territories field.
All territories that are defined at the selected level are shown.

For example, if you select Region as the Selection Level, all regions, from all countries, are

listed as options in the List of Territories field.
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You must select one or more of the territories listed.

Subscription Levels

The Subscription Level is the level in the hierarchy for which users receive subscription

invitations.

The Subscription Level can be at the level of the Selection Level, or beneath that level, but

not above that level. For example:

If you select Region as the Selection Level, you can select Region or State as the

Subscription Level:

« If you select Region, regional managers for the regions you select in the List of
Territories field receive a subscription invitation.

« If you select State, state managers for the states within the regions you select in the
List of Territories field receive a subscription invitation.

* You cannot select Country as the Subscription Level, as it is a higher level than the

Selection Level.

Subscription example

A corporate marketer can specify a country or region for a Subscription task.

A corporate marketer may specify that for a Subscription task:

1. The Selection Level is Country.
2. The List of Territories is the United States
3. The Subscription Level is State

When this Corporate Campaign starts, each user that is designated as a state manager
for a state within the United States receives an invitation to subscribe to the Corporate

Campaign.
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The corporate marketer might instead set the Subscription Level to Region. In this case,
each user that is designated as a region manager receives an invitation to subscribe to

the Corporate Campaign. State managers, lower in the territory hierarchy than region
managers, do not receive the invitation. However, if the region manager subscribes to the
Corporate Campaign, managers of states within that region also participate in the Corporate
Campaign.

Subscriptions and user variables

When a Corporate Campaign has a Subscription system task that is linked to a Flowchart
Run system task, the Flowchart Run system task needs to have an associated flowchart
that makes use of the subscription response information. You do this by defining a user
variable in the flowchart called Subscri pti onLi st . This user variable can then be used in a

query such as the following:
Contact _Info.State I N (UserVar. Subscri ptionLi st)

When the flowchart is run from Collaborate, the list of states or regions that are subscribed

is sent as a parameter to Campaign, and the query above is run as something like:

Contact _info.state in (" MA', 'VI')

How territories, hierarchies, and user associations are
defined

The Collaborate administrator defines the territories, hierarchical relationships, and territory

managers by loading an XML file on the Collaborate server.

For more information, see the Collaborate Administrator's Guide.



Chapter 7. Workflows

To help you complete different workflow-related efforts, the Workflow tab offers different

view modes and an edit mode.

To record and track the tasks that need to be completed during a project, you add
information to the project Workflow tab. Project managers add tasks, organize them
into stages, and identify dependencies, personnel, and other related information. Project

participants update task status and scheduling data, add attachments.

You can manage tasks that are associated with an Advanced List, On-demand Campaign,
or Corporate Campaign. The Workflow tab provides a spreadsheet on which you can list all

tasks. You can assign dates and team members to each task.

When a project manager creates a Corporate Campaign, On-demand Campaign, or
Advanced List, the selected template can provide an initial workflow. The project manager
can then use the Workflow tab to customize the workflow that is provided by the template

to meet specific needs.

Team members that are assigned to a Corporate Campaign, On-demand Campaign, or
Advanced List use the Workflow tab to track their work. Any team member that is involved
in the Advanced List, On-demand Campaign, or Corporate Campaign (with the appropriate

access permission) can edit any value on the Workflow tab.

Workflow concepts

Workflows organize the tasks, stages, and milestones for each project. Workflows measure
the time that is spent on each part of the project and the people who are assigned to work
onit.

Tasks

Tasks are steps in the workflow where a user or the system acts. The task is not complete
until the action is complete.
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Stages

You can group tasks together under headings called stages. Stages can help you with task
organization. For example, you can create a stage that has all tasks your field marketers-
specific users do. In spreadsheet view mode or edit mode, stages are the headings in bold
that group the tasks together.

Milestones

You can identify workflow tasks as milestones for your project. Example milestones include
Job Start, Meeting, and Event.

Dates

Workflows contain the following types of dates.

- Forecast/Actual dates begin as forecast dates: future dates when a task owner plans
on starting and completing a task. These dates are specified while the task is still
pending. When a team member a starts and completes a task, the same dates can be

used or different dates that are supplied as the actual dates.

Actual dates specify when tasks start and finish.

- Target dates are dates that are used to plan the project schedule. Typically, they are set
at the beginning of the project.

 Anchored dates are fixed dates that cannot change, even if the dates of the tasks upon
which they are dependent change.

« Non-work time represents dates when people do not work, so the system skips those
dates when it calculates durations for tasks. Collaborate currently supports system-
wide non-work time that applies to all tasks. It is up to the project managerList, On-
demand Campaign, or Corporate Campaign manager to determine whether overriding
any of these dates is necessary. System administrators enter and maintain these dates.

» Weekend dates are dates that you use to specify work that occurs on a weekend on
a per-task basis. You can schedule work on a weekend date by using the Schedule

Through option for each task.
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Duration

Duration is the actual number of days that are assigned to a task. When you assign start
and end dates, the system automatically calculates the difference between the forecast or
actual start date, and the forecast or actual end date for a task. The actual number of days

between the start and end dates equals the duration of the task.

You can assign duration by using any non-negative number. For example, you can use 0.25

to assign a quarter of a day for the task duration.

Duration is the actual number of days that are assigned to a task. The duration control is
in a DD- HH MMformat. You can enter up to 999 days value for the DD field, your applicable
business hours that are based on the beginningOfDay and numberOfHoursPerDay

configuration settings for the HH field, and a value in 30-minute intervals for the Mufield.

Effort

The work effort in days (as opposed to duration) that it takes a user to complete a task. For
example, a task takes three calendar days to complete, but the task owner spends only half
a day on the task for each of the three days. In this case, the effort for the task is one and a

half days even though the duration is three days.

Locked tasks

When you edit a task, the task is locked so no other user can edit it at the same time.

People and roles

You can assign tasks to individual team members or you can assign tasks to all team
members in each role. When you assign a task to one or more team members, they are
considered to be task owners. You assign roles to team members on the People tab of the

List, On-demand Campaign, or Corporate Campaign.project.

Workflows use the following concepts to identify people in the workflow.

- Task owners are the people responsible for running or managing workflow tasks.
* Roles are used as a bridge between tasks and people. They are useful for assigning

work on a generic basis. For example, each type of project you create can have its own
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workflow template, and the template can contain standard roles for certain tasks. Then,
when you create a project, some (or all) of the tasks have a default role that is already
associated with them.

* Roles are used as a bridge between tasks and people. When a role is assigned to a task
in a List, On-demand Campaign or Corporate Campaign, all users that are associated
with that role are owners of the task. Templates can contain roles for certain tasks.
Then, when you create a List, On-demand Campaign or Corporate Campaign, some (or

all) of the tasks have a default role that is already associated with them.

[5) Note: Each workflow might contain users from different timezones. You chose whether
Collaborate displays the timezone after the time stamps on the workflow and workflow

columns.

System tasks

System tasks are workflow tasks that start automatically, based on a combination of start

date and completion of tasks on which they are dependent.

You can create these types of system tasks:

« Subscription

* Flowchart Run

« Notify Field Marketers
* List Review

* Recurrence

[5) Note: When you pause a workflow, system tasks that are scheduled during the time the

workflow is paused do not run until the workflow resumes.

Subscription system task

A Subscription system task allows you to have field marketers subscribe to, and participate

in, a Corporate Campaign.
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The Subscription system task is only used in Corporate Campaigns.

A Subscription system task starts and finished automatically, according to the target start

and end date. You can also mark it complete manually.

Flowchart Run system task

A Flowchart Run system task allows you to specify a flowchart that should run at a

particular place in the workflow.

When you create a Flowchart Run system task, you specify one of the following:

« For corporate marketers that are working with Corporate Campaigns, the name of the
flowchart in the linked campaign (in Campaign) in the workflow.

« For field marketers that are working with On-demand Campaigns and Lists, the name
of the tab that is associated with the flowchart in the On-demand Campaign or List that

you want to use to gather data.

When Collaborate runs a Flowchart Run system task, flowchart run is started in Campaign.

Flowchart Run system tasks start and finish automatically when there is a matching
flowchart in Campaign, when the target start date is reached and when all tasks it depends
on are finished; you do not need to manually start or stop a Flowchart Run system task. The

% Complete field completes automatically as the task proceeds.

Flowchart Run tasks with no assigned flowchart

The icon for the Flowchart Run system task displays red when no known flowchart is

assigned to the task. After you assign a flowchart, the color of the icon changes to black.

Flowchart Run tasks and Corporate Campaigns

For Corporate Campaigns, for the Flowchart Run system task to run correctly, you must

save and publish the flowchart of the linked campaign in Campaign.
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Notify Field Marketers system task

The Notify Field Marketers system task allows you to include automatic notification to Field

Marketers within the workflow.
This type of system task is used only with Corporate Campaigns.

When a Notify Field Marketers system task starts, Collaborate sends notification to Field
Marketers, informing them that contact lists are ready for their review. Collaborate also adds

all selected Field Marketers to the People tab of the Corporate Campaign.

The Notify Field Marketers system task starts and finishes automatically; you do not need
to manually start or stop a Notify Field Marketers system task. The % Complete field

completes automatically as the task proceeds.

[5) Note: A Notify Field Marketers system task must depend on a Run Flowchart system
task.

List Review system task

The List Review system task allows you to identify time within the workflow during which

Field Marketers review contact lists that result from a flowchart run.

Unlike any other Workflow Task, this task can be finished by a link present on Summary Tab
of On-demand Campaign. Without going to workflow tab, you can finish this task directly
from Summary Tab.

[5) Note: A List Review system task must depend on a Flowchart Run system task.

List Review system tasks start and finish automatically. You can manually finish a List
Review system task when you are sure that all Field Marketers completed the review. After
you manually finish the List Review task, the next dependent task (if any) in the workflow

starts when its target start date is reached.

When the List Review is completed, manually or automatically, the List is locked to field

marketers; field marketers can no longer change their portions of the List.
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The two permissions, Update System Task status and Update all System Task, are applied
to all Workflow System Tasks along with List Review Task. If these permissions are not
granted, then a task cannot be completed from workflow along with List Review Task. List
Review can be finished from the Summary tab of an On-demand Campaign by clicking

Finish List Review, even if these security permissions are not granted in the Security Policy.

To specify the number of records to show, you can use the Limit List View option. In
List Manager, only the number of records that are specified in the List Review Task are
displayed.

If you use a third-party tool to create a list of IDs, you can import them by clicking Import
IDs. From the Import IDs window, you can specify a . csv file that contains the customer
IDs, the delimiter in the . csv file, and the audience level. The . csv file should include
columns required to uniquely identify a customer based on an audience level. After you click
Import, the List Manager data is updated with the new imported data to the newly added
List. Data from the . csv that is a duplicate or is invalid is displayed.

The fields to limit additions are as follows:

« On list review pop-up for templates of On-demand Campaign, Corporate Campaign, and
Advanced Lists.

« Corporate Campaign - it is displayed and editable for corporate marketers only. In the
case of corporate campaigns, field marketers cannot access this pop-up that is based
on security settings. Even if they are allowed access, they can view but cannot edit the
settings.

« On-demand Campaigns and advanced lists - these fields are displayed but cannot be
edited

If the value of Limit List View option is set to limit the number of records that can be viewed,
then the field is automatically set to select the second radio button option with value set to
"0." You get an explicit message that no records can be added when the list view is limited.
If Unicode characters are present in the List code either by adding an ID prefix or entering

manually, then you are not able to export a customer list from List Manager window.
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[5) Note: User cannot set both number and percent. For example, to limit to 10% with a

maximum of 100.

In the List Manager task, you can specify the available Display Formats. You can identify or

filter by Audience Level. Only formats that are selected in the List Review Task are available.

List Review system tasks and recurring workflows

In recurring On-demand Campaigns or Corporate Campaigns, you can enable permanent
updates so that any additions or removals that take place during List Review are applied

automatically in all occurrences.

List Review system tasks and multi-offer campaigns

In multi-offer On-demand Campaigns or Corporate Campaigns, you can divide a list that is
generated by a single Flowchart Run system task into several segments. The results of the

Run Flowchart system task are presented as several Lists.

Recurrence system task

Recurrence starts when predecessors are complete. It then recalculates previous
dependent tasks that target the start date when these previous tasks are set.

The available recurrence types are Monthly, Weekly, Daily, and Hourly. Date and time

calculations must apply to working hours and business days.

On the Recurrence tab, you are given the option to choose the Campaign Workflow Type
(Nonrecurring or Recurring). After selecting the workflow type, you are able to choose

Frequency and Time between occurrences.

There can be only one recurrence task in a sequence of dependant tasks. A control is made

when saving the workflow.

Hourly recurrence

For Template Run Flowchart Task Recurrence, you have the Ending option where you can
choose No End or Total number of occurrences. You also choose Permissions to modify

the recurrence in the instance (All options, No option, and All options but frequency). Run
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Flowchart Task properties if the recurrence on task is chosen. You can also get a preview of

the next occurrences.
[5) Note: All options allow you to turn from Not recurring to Recurring.

For Instances Run Flowchart Tasks, under the Recurrence tab, you have a start date to

choose along with the Ending (no end, total number of occurrences, and end by).

Creating a flowchart run task

You create a flowchart run task through the workflow spreadsheet.

1. In the workflow spreadsheet, in Edit view, select the row after which you want the

Flowchart Run task to appear.

2. Click the Add a Row icon ( ).

3. Select Flowchart Run.
A new task row is added to the flowchart.
4. In the Flowchart Name column, perform one of the following tasks:
« For Corporate Campaigns, enter the name of the flowchart from your linked
campaign.
« For On Demand Campaigns and Lists, select the name of the tab that runs the

Campaign flowchart.

5. Complete the Schedule Through, Target Start, Target End, Duration, and Member Role

fields as desired.

You can also change the name of the task.

6. Click Save and Finish.

If the workflow is part of a Corporate Campaign, you must save and publish the associated

flowchart in Campaign.
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Creating a Notify Field Marketers system task

You can create a Notify Field Marketers system task through the workflow spreadsheet.

1. In the workflow spreadsheet, in Edit view, select the row after which you want the
Flowchart Run task to appear.
2. Click the Add a Row icon ( ).

3. Select Notify Field Marketers.

A new task row is added to the flowchart.

4. Complete the Schedule Through, Target Start, Target End, Duration, and Member Role

fields as desired.

You can also change the name of the task.

5. Make the new Notify Field Marketers system task dependent on a Run Flowchart

system task.

6. Click Save and Finish.

Creating a List Review system task

You can create a List Review system task through the workflow spreadsheet.

1. In the workflow spreadsheet, in Edit view, select the row after which you want the

Flowchart Run task to appear.

2. Click the Add a Row icon ( ).

3. Select List Review.

A new task row is added to the flowchart.
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4. Complete the Schedule Through, Target Start, Target End, Duration, and Member Role
fields as desired.

You can also change the name of the task.
5. Make the new List Review system task dependent on a Run Flowchart system task.
6. Click Save and Finish.
7. If you are working on a multi-offer campaign:

a. Click the name of the List Review system task.

The Task properties screen opens.

b. In the Segment Code field, enter the name of the segment as it appears in the

flowchart in your linked campaign.

c. Click Save and Return.

You can now enable permanent updates to a list.

Enabling permanent updates to a list

To enable permanent updates to a list, check the Allow permanent updates check box.

1. In the workflow spreadsheet, in Edit view, double-click the List Review system task that

you want to change.

The Post Task dialog box opens.

2. Check the Allow permanent updates check box.

Creating a Subscription task

You can create a Subscription task through the workflow spreadsheet.
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1. In the workflow spreadsheet, in Edit view, select the row after which you want the
Flowchart Run task to appear.
2. Click the Add aRow icon ( ).

3. Select Subscription.

A new task row is added to the flowchart.

4. Complete the Schedule Through, Target Start, Target End, Duration, and Member Role

fields as desired.

You can also change the name of the task.

5. Click Save and Finish.

You must now configure the Subscription task.

At least one flowchart run task must depend on the subscription task. You must add the

flowchart run task with this dependency.

Configuring the Subscription task

When you configure the Subscription task, in addition to setting the target task dates, you

set the subscription Selection Level, the List of Territories, and the Subscription Level.
Before you complete these instructions, you must create the Subscription task.

These settings determine which field marketers receive invitations to subscribe to the

Corporate Campaign.

1. View the workflow spreadsheet, not in Edit mode.

2. Double-click the Subscription task.

The Post Task dialog box opens.

3. Enter the Target Start and Target End dates as needed.
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4. Select a Selection Level.
5. Select one or more territories in the List of Territories field.
6. Select a Subscription Level.

7. Click Save and Finish.

Example of a Corporate Campaign workflow with system tasks

A typical workflow for a Corporate Campaign might include two flowcharts: one that initially
selects a list of contacts, and another that fulfills the campaign after Field Marketers

reviewed and approved the initial list.

Task 1: Subscription

Task 1 is a Subscription system task. You configure a subscription task to invite relevant

field marketers to participate in the Corporate Campaign.

Task 2: Flowchart Run

Task 2 is a Flowchart Run system task. The Flowchart Name column identifies the name of
the flowchart in the linked campaign (in Campaign) that should be run to complete this task.
When task 2 runs, the flowchart Corporate Campaign Selection runs in the linked campaign
in Campaign to create a list that Field Marketers should review. Task 2 starts and finishes
automatically.

Task 3: Notify Field Marketers

Task 3 is a Notify Field Marketers system task. This task notifies Field Marketers that the
flowchart run is complete and a list is ready for their review. This task starts automatically

when Task 2 completes. Task 3 also finishes automatically.

Task 4: List Review

Task 4 is a List Review system task. This task identifies time within the workflow during
which Field Marketers should be reviewing the list that is generated in Task 2. Task 4 starts

automatically when Task 3 finishes and finishes automatically when its target end date is
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reached; however, you can still manually finish the task when all Field Marketers complete

their reviews.

Task 5: Flowchart Run

Task 5 is a Flowchart Run system task. The Flowchart Name column identifies the name
of the flowchart in the linked campaign (in Campaign) that should be run to complete this
task. When task 5 runs, the flowchart Corporate Campaign Fulfillment runs in the linked
campaign in Campaign This fulfillment flowchart creates the final list of contacts by using
the results of the Field Marketer review that occurred in Task 4. Task 5 starts and finishes

automatically.

Task 6: Recurrence

Task 6 is a Recurrence system task. This task identifies how often a flowchart is run.
Acceptable recurrences are hourly, daily, weekly, and monthly. By choosing All Options under

Permissions, Field Marketers can turn recurrence from not recurring to recurring.

User tasks

User tasks are workflow tasks that you define and that must be started manually.

You can add a user task to the workflow to accommodate the time necessary to develop

creative material for the campaign, followed by a user task to approve the creatives.

Users must manually update the status and progress for user tasks.

Task status

Each task in a workflow has a status, which is shown in the spreadsheet view.

You can also view and modify the status by clicking the task to open the Post Task dialog

box.

The task status can be;

» Active
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« Pending
« Finished
« Skipped

/\ Important: If you change the status of a task from Finished to Pending, you must

change the percent complete value to 0%

Editing workflow spreadsheets

When you create a Corporate Campaign, Advanced List, or On-demand Campaign, a wizard
that is based on the template you selected collects information. After you complete the
wizard pages, you can customize the default workflow that is provided by the project

template.

Before you can edit a workflow, the Advanced List, On-demand Campaign, or Corporate

Campaign must not be in the In Progress state. If it is, you must pause it.

In addition to project templates, which can include workflow tasks and values, your
installation can maintain a set of workflow templates. Workflow templates are template
components that are independent from project templates. While a project is in the Not
Started status, you can assess whether the workflow supplied by the project template is
adequate or if a different workflow template provides a better starting point. For more

information about workflow templates, see the Collaborate Administrator's Guide.

The ability to customize template-supplied workflows is controlled by your user
permissions. If toolbar icons are unavailable or if values are read-only, you do not have the
appropriate permissions to edit the workflow.

1. Open the new Advanced List, Corporate Campaign, or On-demand Campaign and click
the Workflow tab.
The workflow displays as supplied by the template.

2. Click Edit (I ).
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The spreadsheet displays in edit mode. For information about the options in this mode,

see Edit mode toolbar (on page 108).

3. To replace all spreadsheet rows and values with data from a previously defined
workflow template (if the project is in Not Started status), click Tools > Import and save
workflow.

A warning that this procedure deletes the current workflow displays. Click OK, then

select a workflow template and click Import.

4. To change default task and stage names to reflect your specific tasks and stages, click
in the cells in first column to make your edits. You can also change task dependencies.

For more information about dependencies, see Task dependencies (on page 95).

5. To add rows to the spreadsheet, click Add a Row ( ') and then select User Task, one
System Task, or Stage.

For more information, see Adding a stage or task (on page 97).

6. To add a stage, click Add a Row icon ( ) and then select Stage.

7. Enter target or forecast/actual dates for the tasks, depending on how you want to use
the schedule.

* You can enter a start date, end date, and duration for a task. If you enter any two of
these values, the system calculates the third value automatically. For example, if
you enter a target start and a target end date, the system calculates the duration.

 While the Schedule Through column indicates work days for a task, you can enter
any date as a start or end date. For example, for a task that is not scheduled to

include weekends you can still pick a Sunday as the end date.

8. To specify that a task is a milestone, such as a drop date, click the Milestone Type
column and select a milestone from the list.
Your administrator sets the milestones options in this list.

9. Select members or roles to assign the task to in the Members and Member Roles

columns .
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For more information, see Adding roles and members to tasks (on page 71).

10. Make other selections and entries in the spreadsheet to reflect the workflow for your

Advanced List, Corporate Campaign, or On-demand Campaign.
11. Enter any instructions or notes about a task in the Notes column.

12. Click Save to save your changes.
« Click Save and Finish to save your changes and return to spreadsheet view mode.
« Click Save and Resume to change the status to In Progress and return to
spreadsheet view mode.

« Click Cancel to undo any changes and return to view mode.

Adding roles and members to tasks

When you create a Corporate Campaign, Advanced List, or On-demand Campaign, the
workflow automatically includes member and reviewer roles for all tasks if the template you
selected provides this information. However, you can edit workflow tasks to assign different

roles.

To add roles and members to tasks, complete the following steps.

1. Navigate to the Workflow tab of your Corporate Campaign, Advanced List, or On-

demand Campaign.

2. Click Edit ().

3. To select or change the member roles, click in the Member Role cell for the task you
want to change.

4. Click the turndown icon (+) to view the list of available roles.

5. Click to select one role, or Ctrl+click to select more roles to assign to this task.

6. To select or change specific members, click in the Member cell for the task you want to
change.

7. Click the turndown icon to view the list of available members.

8. Save your work.
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If you have the "View people tab" and the "Edit team members and roles" permissions,
you can select any users or roles, even if they were not included on the People tab.
When you add a user to the project workflow, the system adds the user to the People tab

automatically.

Filling data into a range of cells

To reduce data entry time, you can copy data that is entered for one or more tasks and

supply it for another task or tasks by using Tools options.

For example, you have 10 consecutive tasks with the same values for target start, target
end, target duration, and target effort. You enter the data for the first task. To copy the
values that are in the first row into the remaining nine rows, Shift+click to select the cells in

those four columns for all 10 tasks. Then, use the Fill Down option.

You can also copy the data in one or more adjacent cells and paste it into one or more

adjacent cells. See Workflow copy and paste (on page 90).

[5) Note: The options for working with a range of cells apply to adjoining cells only: use
Shift+click to select the cells.

1. Open the Advanced List, On-demand Campaign, or Corporate Campaign that has the

task values to duplicate, and click the Workflow tab.
2. Click Edit.
3. Shift+click in the first cell to select it.

4. Move the cursor to the last cell you want to include, then Shift+click in this cell.

The range of cells you selected is highlighted.

[5) Note: You must select a continuous range of cells, rather than selecting multiple,
disconnected cells.

5. Click Tools (“ ) and select one of the following options:
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Option Description

Fill Down Copies the values in the top-most
selected cell (or cells) to all the other

selected cells, including the bottom-most.

Fill Up Copies the values in the bottom-most
selected cell (or cells) to all the other

selected cells, including the top-most.

6. Click Save.

Printing the Workflow tab

You can either print all information found on your Advanced List, On-demand Campaign, or

Corporate Campaign Workflow tab, or select certain columns of information to print.

1. From the Workflow tab, click Print ( * ).

A dialog opens with a list of the spreadsheet columns. By default, all columns are

selected.
2. Click to clear any columns you do not want to include when you print.

3. Optional: Clear the Shrink to Fit Landscape Page Width check box to print the columns

at a size of 100%.

If you keep this option checked, all selected columns print on a single page. If you use

this feature, change your printing preference (for this print job) to landscape.
4. Click Print Selected Columns. A preview dialog opens.
5. Click Print.
6. Select your printer and printer options. Choose landscape mode for best results.

7. Click Print to print the selected workflow columns.
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8. In the preview dialog, click Close to close the print preview.

Adding an attachment to a task

To add attachments for a task, a project owner must enable adding attachments for the

task. New attachments are added to the Attachments tab for the task.

The following users can add or remove task attachments.

« Task owners can add attachments only to their tasks.
« Task owners and users with the Delete Attachment security permission for projects can

delete task attachments.

Adding attachments to tasks is similar to adding attachments to other objects. However,

note the following behavior that is specific for adding attachments to tasks.

Note the following restrictions:

« There is no versioning for task attachments: uploading a new version overwrites the
existing version of the attachment.

« It is possible to have multiple task attachments with the same name for the same task.
This situation can occur if multiple owners of the task each upload a file with the same
name. You can differentiate the files by the user who created the attachment.

* You can add and remove attachments no matter the state of the task. That is, even if a
task is marked complete or skipped, you can still add and remove attachments.

 The Attachments tab for a Corporate Campaign, On-demand Campaign, or Advanced
List is divided into two sections: one for files that are attached directly to the Corporate
Campaign, On-demand Campaign, or Advanced List, and one for files that are attached
to the tasks.

- If a task owner adds task attachments, and later the Corporate Campaign, On-demand
Campaign, or Advanced List owner sets the Enable Task Attachment flag to false,
attachments can no longer be added or removed from the Post Task Update dialog.
However, task attachments for the Corporate Campaign, On-demand Campaign, or

Advanced List can still be removed from the Attachments tab.
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1. Navigate to the task to which you would like to add an attachment.
Click the task from a project workflow or from the Tasks list page.

The Post Task Update dialog box opens.

2. Click the Attachments tab.

The tab displays any attachments that exist for the task.
3. In the File to Attach field, select From My Computer or URL.

4. Complete one of the following actions:
« Click Browse to attach a file that is on your computer. When the dialog box
appears, navigate to the file you want to attach and click Open.
« Enter the URL in the field provided.

5. Add any comments about the attachment.

6. After you add all your attachments, click Save and Return to close the dialog box.

Milestones

A milestone is a point in time within workflow at which all tasks until that time must be

complete in order for work to continue.

Your system relies on the display order of the task to find out the prior tasks. All tasks that
are displayed before the milestone task on the workflow screen are assumed to be a part
of that milestone. If tasks before the milestone are not complete, then the milestone is not
met and the next task cannot begin. If the prior tasks are not complete, your system shows
the appropriate error message, saying all prior tasks in the milestone should be complete to
mark the milestone as complete or active. In that case, the system stops you from updating

the milestone task.
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Why use milestones

By using milestones within a workflow, you can better enforce process for your lists
and campaigns, so that tasks take place in the intended order. In addition, the specific

milestones you select in a workflow aid in reporting.

How available milestones are defined
To add milestones, click Collaborate Settings > List Definitions > Workflow Milestone
Types.

[5) Note: You must have administrative privileges to define milestones. Specific milestones

are also available for selection as defined in a database table by your administrator.
A milestone cannot be removed if it is used in an instance (Corporate Campaign, On-
demand campaign, or Advanced List).

Note: A milestone can be removed if it is used in template, but it cannot be removed if it is

used in instance.

Disabled milestones are not shown while you create an instance or template. They are

shown in instances or templates where they are already used, however.

Setting milestones in a workflow

You can set milestones for tasks within a workflow for an Advanced List, On-demand

Campaign, and Corporate Campaign from the Milestone Type column.

When you set a milestone, the next task in the workflow cannot begin until the milestone is
reached.

Example

Consider a scenario of three user tasks followed by flowchart run system task. A milestone

is declared at 1.3 task.

If you try to update the status of the milestone task (1.3 in this case), your system performs

a check to ensure that all prior tasks are complete.
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When your system tries to start Task 1.4, it checks the status of the earlier milestone task.
If milestone is complete, only then can task 1.4 begin. Otherwise, the appropriate error

message would be shown to you and the task does not start.

By using a milestone at task 3, you can ensure that all creatives for the On-demand

Campaign are approved by the necessary people before campaign fulfillment begins.

Defining a milestone for a task

You can set a milestone for a task to ensure that task is complete before the workflow

proceeds.

Before you can define a milestone for a task:

* You must define milestones by going to Collaborate Settings > List Definitions >

Workflow Milestone Types.

[5) Note: You must have administrative privileges to define milestones.
« The Milestone Type column must be present in the workflow layout. You can ensure
that it is present by basing the Advanced List, On-demand Campaign, or Corporate

Campaign on a template that uses milestones or by editing the workflow layout.

1. Open the Advanced List, On-demand Campaign, or Corporate Campaign, then open the
Workflow tab.

2. If necessary, change the layout of the spreadsheet view to show the Milestone Type
column.

3. Click Edit to make the workflow spreadsheet editable.

4. In the Milestone Type column, in the task row for which you want to set a milestone,
select a milestone from the drop-down list.

5. Click Save or Save and Finish to save the milestone you set.

The milestone is now in effect for the Advanced List, On-demand Campaign, or Corporate

Campaign.
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Date dependency calculations

When you enter or change the date for a task, the system calculates other dates that are
based on your entry. It uses an internal algorithm to bidirectionally calculate the dates of

dependencies, starting with the cell where you entered the date.

When you initiate date dependency calculations for a workflow, note the following issues:

« In addition to factoring in non-work days and hours, date dependency calculations use
two additional system-wide properties: start time of day and number of hours per day.
Your system administrator configures these settings.

- If a task row is anchored, the date dependency calculation does not update its dates

(even if the date columns are empty).
« Date dependency calculations do not affect active and finished tasks; only tasks with a

status of Pending.

« Date dependency calculations observe the per-task options for non-work time. The
calculation algorithm takes into account whether a task is scheduled to progress during
non-work time, weekends, or both.

« Do not log forecasttarget times outside of business hours if you intend to do date
dependency or other automatic calculations afterward. That information is overwritten

by the automated process.

Calculating workflow dates automatically

When you enter or change the date of a task, the system calculates other dates that are

based on your entry.

To calculate workflow dates automatically, complete the following steps.

1. Enter or change the date for a task in any of the date fields.

2. Select the date and click anywhere on the screen except for another date field.
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=I5+

The Date Dependency Calculation icon ( * ) is displayed next to the end date.

3. Click the Date Dependency Calculation icon.

Alternatively, you can select one of the toolbar icons for recalculating dependency

dates.

The other dates in the workflow are updated, because of the new entry.

Calculating date dependencies above a locked task

If a workflow has a locked task, and you change the date of a task that is located above that

task, you receive a warning when you calculate date dependencies.

To clarify this task, the procedure that follows assumes:

 Task 1.8 is locked.
* You need to change the duration of task 1.5 from five days to 10 days.

« All tasks depend on the previous task.

1. Open the workflow for editing, and change the duration on task 1.5 from five days to 10

days.

2. Click the Date Dependency Calculation icon ( %) next to the end date of task 1.5.

The system displays a warning message, saying you cannot recalculate through the

locked row.
3. Click the start date of task 1.8

4. Click the Date Dependency Calculation icon.

The system calculates the dates below the locked task.
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Schedules

There are two options for scheduling in workflows: baseline and up-to-date.

Baseline scheduling

You use baseline scheduling when you want to compare actual dates to fixed target dates.
With baseline scheduling, you never change the target dates, allowing them to serve as
a baseline. Users who are assigned tasks receive reminders on completing the actual/

forecast dates.

While you work with a baseline schedule, the owner of the Advanced List, On-demand
Campaign, or Corporate Campaign sets the initial Target Start and End dates for each task.
These dates stay fixed throughout the entire workflow. As the List, On-demand Campaign, or
Corporate Campaign progresses, the owner can update the actual/forecast dates with real

data based on status information received from team members.

Up-to-date scheduling

You use up-to-date scheduling when you want to use actual dates to update the official
schedule (defined by the Target Start and End dates) regularly. This mode enables project
managers to capture the most up-to-date, official schedule; however, it does not provide an

easy way of viewing a baseline version of the schedule.

Using a baseline schedule

System administrators set up permissions and reminders for baseline schedules. Schedule
owners set the dates for each task in the baseline schedule. Team members update the

progress for their tasks in the baseline schedule.

Before you create your projectsLists, On-demand Campaigns, or Corporate Campaigns, have

the system administrator set up the following permissions and reminders:

« Set permissions so that only projectList, On-demand Campaign, or Corporate Campaign

owners can update Target dates.
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- Set reminders (alerts) that are based on the Actual/ForecastActual dates.

While you work with a baseline schedule, team members perform the following high-level

steps.

1. The owner sets the Target Start and End dates for each task.

These dates stay fixed throughout the entire projectList, On-demand Campaign, or

Corporate Campaign.

2. As the projectList, On-demand Campaign, or Corporate Campaign progresses, team

members update the Actual/ForecastActual dates with real data.

Keeping an up-to-date schedule

System administrators set up permissions and reminders for schedules. Schedule owners
set the dates for each task in the schedule. Team members update the progress for their

tasks.

Before you create your projectsLists, On-demand Campaigns, or Corporate Campaigns, have

your system administrator set up permissions and reminders as follows.

- Set permissions so that only projectList, On-demand Campaign, or Corporate Campaign
owners can update Target dates.

« Set reminders (Alerts) that are based on the Target dates.

« Set reminders to be sent only to the owner or owners.

« Optionally, set reminders on the Actual/ForecastActual dates to be sent to team

members.

While you work with an up-to-date schedule, team members perform the following high-level

steps.

1. The owner sets the initial Target Start and End dates for each task.
2. As the projectList or On-demand Campaign progresses, team members update the

Actual/ForecastActual dates with real data.
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3. If atask is delayed (the owner receives reminders that are based on Target dates), the

owner assesses the situation and adjusts the Target dates and durations as necessary.

Design for multiple drops, lots, waves, and offers

With Collaborate, you can design Corporate Campaigns, On-demand Campaigns, and Lists

that fulfill a number of business needs.

Multi-drop design

Multi-drop Corporate Campaigns, On-demand Campaigns, or Lists are recurring campaigns

or lists that run at specified intervals (each month, for example) over a defined time.

Multi-drop campaigns and lists use a workflow or a workflow stage that is configured to
repeat at specified intervals. Each drop, or stage, in the workflow is made up of the tasks

necessary to fulfill one complete drop, or stage, of the campaign.

When to use a multi-drop design
Organizations use multi-drop campaigns or lists to manage campaigns that span time
and require multiple contact points, usually at regular intervals. Examples of multi-drop

campaigns are:

* Newsletter campaign: You might create a multi-drop Corporate or On-demand
Campaign to manage distribution of newsletters at regular intervals on an ongoing
basis.

« Birthday campaign: You might create a multi-drop Corporate or On-demand Campaign
to manage a campaign where some offer and greeting are sent to contacts during the

months of their birthdays.

Set up multi-drop Corporate Campaigns, On-demand Campaigns, and Lists
Multi-drop Corporate Campaigns, On-demand Campaigns, and Lists use recurring

templates. In the multi-drop template, you must:
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« Define the stage of your workflow that contains the tasks you want to recur (only one
stage can be recurring)
« Define properties for recurrence by using the Recurrence tab

Multi-drop design is applied when you create a Corporate Campaign, On-demand Campaign,

or List by using the recurring templates that you established.

Multi-lot design

Multi-lot Corporate Campaign and On-demand Campaigns are campaigns that distribute the

effort of customer contact over time when you deal with a large list of targeted customers.

When to use a multi-lot design

Organizations use multi-lot features to manage customer lists that are too large to handle
at one time. A multi-lot design allows Field Marketers to accept a subset of a list for contact
in one "lot." Field Marketers can then accept more contacts for contact at subsequent lots,

distributing the effort over time.

Set up multi-lot Corporate Campaigns and On-demand Campaigns

To achieve a multi-lot design, your Corporate Campaigns or On-demand Campaigns must
use flowcharts in Campaign that are designed specifically for each lot. You can use a single

flowchart for all lots or a separate flowchart for each lot. In either case:

* The list generation task for the initial lot selects from your Campaign database to
create the first list for Field Marketer review.

* The list generation task for the second lot targets those contacts that were left in the
Waiting state after the first list review, as well as any new contacts included from the

latest list generation.

Multi-wave design

A multi-wave design for Corporate Campaigns and On-demand Campaigns allows you to

distribute offers through several waves of contact. Multi-wave Corporate Campaigns and
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On-demand Campaigns are typically nonrecurring campaigns, with workflows made up of

different stages, or waves.

Multi-wave campaigns take advantage of Campaign response tracking. You can design a

"second wave" of offers to be sent to contacts who did not respond to the initial offer.

When to use a multi-wave design
Use a multi-wave design when you want to manage campaigns that present a series
of offers to customers. For example, an organization may want to create a multi-wave

Corporate Campaign to:

1. Send an offer to a list of contacts.

2. Send a second offer to contacts who did not respond to the initial offer.

For example, Field Marketers may use the same flowchart each month to identify
prospects who have birthdays in the current month. In this case, the first wave of the
campaign must complete, so that you can identify the non-responders. After this wave
is complete, the second wave of the campaign can be used to distribute the second

offers to the non-responders.

Understanding multi-wave Corporate Campaigns and On-demand Campaigns

To achieve a multi-wave design, your Corporate Campaigns and On-demand Campaigns
must use flowcharts in Campaign that are designed to accommodate each wave of contact.
You can use a single flowchart for all waves, or create a separate flowchart for each

individual wave. In either case:

« The list generation task for the initial wave selects from your Campaign database and
creates the first list for Field Marketer review.

* The list generation task for all subsequent waves should select from only those
contacts that are generated by the previous wave as input. For example, if you want
to send an offer to contacts who did not respond to the first wave, the flowchart that
is used for the second wave filters out the responders and select the non-responders

from the first wave.
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Multi-offer design

You use a multi-offer design for Corporate Campaigns, On-demand Campaigns, and Lists to

create a campaign or List that sends different offers to different customers.

Multi-offer Corporate Campaigns, On-demand Campaigns, or Lists can be nonrecurring or
recurring. These campaigns take advantage of the segmenting capabilities in Campaign to

target different contact segments with different offers.

When to use a multi-offer Corporate Campaign, On-demand Campaign, or
List
Organizations use multi-offer design to manage campaigns and Lists that target different

segments of the customer population. Examples of multi-offer design include:

- Offers for responders and non-responders: You might create a multi-offer campaign to
provide one offer to those who respond to a campaign, and another separate offer to
those who do not respond.

« Offers for different audiences: You might create a multi-offer campaign to manage
different offers for different audiences. For instance, a financial institution might
send one offer to college students and another offer to individuals who are head-of-

household.

Flowchart design in Campaign for multi-offer campaigns and Lists

Corporate Campaigns, On-demand Campaigns, and Lists must use Campaign flowcharts

that divide contacts into Segments to achieve multi-offer design.

Each segment represents a different customer list; each customer list is paired with a

different offer in Campaign.

You can use Collaborate to ensure that each customer list is reviewed by the right Field

Marketers.

The List Review task matches the segment code in the task with the code written into the

List Manager table; it can then filter the list by segment code.
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[5) Note: The flowchart must be configured to write the Segment Code for a segment into

the List Manager table

List Review task/segment association for multi-offer campaigns and Lists

For multi-offer campaign and Lists, you create a workflow that consists of user and system

tasks, just as you would for any other Corporate Campaign, On-demand Campaign, or List.

With multi-offer campaigns and Lists, however, you must ensure that all customer lists
created by the flowchart are reviewed. You do so by associating each List Review task in

your workflow with each segment created by the flowchart in the campaign in Campaign
You use the Segment Code field that is displayed to identify the appropriate segment for the

review.

[5) Note: The Segment Code that you enter must match the segment name as it is

displayed in Campaign.

Creating a multi-offer Corporate Campaign

You can create a multi-offer Corporate Campaign by creating your linked campaign in

Campaign and starting it in Collaborate.

1. Create a Corporate Campaign.

2. Modify the workflow.

Enter the flowchart names that are used for each Flowchart Run task. For each List

Review system task:

a. Click the task name.

The task properties window is displayed.

b. Complete the task properties window as wanted.

In the Segment Code field, enter the appropriate segment name as it is displayed

in the flowchart in your linked campaign (in Campaign).

3. Create the linked campaign in Campaign.
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4. Create the flowcharts corresponding to one or more Flowchart Run tasks in the

workflow.
Ensure the following:
« The flowcharts create different segments.
« The Segment Codes are written to the List Manager table.

5. Save and publish each flowchart.

6. Start the Corporate Campaign in Collaborate.

Creating a multi-offer On-demand Campaign or List

Field marketers can create multi-offer On-demand Campaigns and Lists by selecting a
template in which a corporate marketer or administrator already set up the necessary

segments, flowcharts, and workflows.

The instructions below describe the steps to take before the field marketer creates the On-
demand Campaign or List to be performed by others that are working with Campaign and

Collaborate templates.

1. Create flowcharts and forms for your On-demand Campaign or List.
Ensure the following:

« The flowcharts create different segments.

» The Segment Codes are written to the List Manager table.
2. Create an On-demand Campaign or List template and add forms as a custom tab.

3. Modify the workflow.

For each List Review system task:

a. Click the task name.

The task properties window is displayed.

b. Complete the task properties window as desired.
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In the Segment Code field, enter the appropriate segment name as it is displayed

in the flowchart that is used to create your forms/tabs.

4. Create an On-demand Campaign or List by using the template.

5. Start the On-demand Campaign or List.

Workflow task status

Each new workflow task has a status of Pending. As project managers and participants

work on tasks, they update the status to indicate the current progress.

You can change the status of a task when you are working in spreadsheet view mode or

timeline view mode by clicking the task name. For more information, see Post Task Update

dialog (on page 92). You can also change the status of a task when you are in edit mode:

Click the Status column of the task, then choose the appropriate status from the drop-down

list.

Table 5. Task status

Status Description

Pending Indicates that a task is not yet in progress. When you create a task,
it defaults to the pending state. The pending state is symbolized by
a blank status field.

Active Indicates that a task is in progress. Symbolized by the = icon.
You can also type Ato place a task in the active state

Skipped Indicates that a task was skipped. Symbolized by the icon.
Skipped tasks are tasks for which members no longer do work.
Any dependencies of this task are also disregarded. You can also
type Sto place a task in the skipped state.
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Status

Description

Finished

Indicates that a task is complete. Symbolized by the © < icon.

You can also type F to place a task in the finished state.

Note the following relationships between the task status and the % Complete for a task.

« If you enter 100 as the % Complete for a task, the status is updated to Finished.

« If you enter 0 as the % Complete for a task (if it was previously finished), the status is

updated to Pending.

« If you enter any number from 1 to 99 as the % Complete for a task (if it was previously

finished), the status is updated to Active.

« If you mark the status for a task as Skipped, all of the dates for the task are cleared.

Until you click Save (or Save and Finish), you can retrieve the dates by canceling the

editing session. However, after you save the spreadsheet with the dates cleared you

cannot retrieve them.

Completing multiple tasks

If you are assigned tasks for one or more projectsAdvanced Lists, On-demand Campaigns,

or Corporate Campaigns, you can set them to complete at the same time.

To complete multiple tasks at one time, complete the following steps.

1. Open the Tasks list page to view all of your assigned tasks.

2. Select the check box for each task you want to complete.

3. Click Complete Selected.

4. In the Complete Selected Tasks dialog box, select one of the following options:

Option

Description

Leave all dates as they are

The tasks are marked as complete, but no

end dates are modified.
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Option

Description

Set all actual end dates to now

Each selected task is marked complete,
and its actual end date field is set to the
current date and time.

5. Click Continue to complete the selected task or tasks or Cancel to return to the list

page without saving your changes.

Any tasks that you selected are removed from the Tasks list page and their status is

changed to complete. Additionally, their end dates are set, if you selected that option.

Skipping multiple tasks

You can skip tasks when you are assigned tasks for one or more projectsAdvanced Lists,

Corporate Campaigns, or On-demand Campaigns.

1. Open the Tasks list page to view all of your assigned tasks.

2. Select the check box for each task to skip.

3. Click Skip Selected.

4. In the confirmation dialog box, click OK to skip the selected tasks, or Cancel.

Any tasks that you selected and skipped are removed from the Tasks list page, and their

status is changed to Skipped.

Workflow copy and paste

For efficiency, you can copy and paste most kinds of tasks in the workflow.

When you are copying and pasting tasks, note the following behavior.

« To copy, you must select a continuous range of cells by using Shift+click. You cannot

select multiple, disconnected tasks by using Ctrl+click.

« To select a single cell, you must use Shift+click.
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« If you do not insert enough blank tasks to correspond to the ones you are copying,
existing task values are overwritten.

« To paste rows at the insertion point, you can click Paste from the Tools menu or press
Ctrl+V. To paste rows after the selected row, you must click Paste Rows After from the

Tools menu.

Copying data in Internet Explorer

You can copy data from a continuous group of cells to another place in the same workflow,
or into the workflow for another Advanced List, On-demand Campaign, or Corporate

Campaign.

1. Open the Advanced List, On-demand Campaign, or Corporate Campaign that has the
tasks to copy and click the Workflow tab.

2. Click Edit.

3. Shift+click to select the first source cell. If this value is the only one that you are

copying, skip to step 5.

4. Point to the final source cell, then press Shift+click over this cell.
A range of cells you selected is highlighted.

5. From the workflow toolbarTools menu, select Copy to copy the selected task or tasks.
If you are pasting the tasks into the same workflow, skip to step 7.

6. If you are copying the tasks to another project workflow, go to the destination Workflow

tab, and open it for editing.

7. Optional: Insert enough blank rows below the destination to act as placeholders for the

task values you are copying.

For example, if you copied data from six tasks, make sure that there are six consecutive
task rows available. If you do not create the necessary rows, existing values for tasks

below the insertion point are overwritten.
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8. Shift+click the destination cells.

9. From the workflow toolbar, select Paste from the Tools menu item to paste the values.

The source data is placed in the workflow, starting from the selected destination task.

Post Task Update dialog

To provide a quick update for a workflow task when the Workflow tab is in spreadsheet view
mode or timeline view mode, click the task name. The Post Task Update dialog opens. Use
this dialog as a quick alternative to editing the entire workflow, when you need to update a
single task only. From this dialog, you can update a subset of task values, add attachments,

and add comments.

The Post Task Update dialog box contains the Status and Attachments tabs.

Task status tab
The Status tab contains the following fields.

Table 6. Fields on the Status tab

Field Description

Owners Display only. The task owner or owners. At the task level, Advanced List,
On-demand Campaign, or Corporate Campaign members are identified

as task owners.

To change the task owners, you use workflow spreadsheet edit mode.

In the Members column, add people to a task.

Target Display only. Calculated start and end dates and duration for the task.
DatesActual To update these values, change the values in the date and time fields.
Dates

Status The status of the task. Select a value from the supplied list.

Enable Project owners and the administrators who design workflow templates

attachments can indicate whether members can add attachments for the task.
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Field

Description

% Complete

Progress for the task. Enter a whole number 0 - 100.

[5) Note: To change the state of a task marked as finished back to
active, you must change the status to Pending and the % Complete
to a number less than 100. If you do not change both values, the task

remains marked as completed after you save.

Actual Effort

The time that is spent on the task. Click the field to enter a value in

days, hours, and minutes, for example, 03D- 02H 00M

Forecast /
ActualTarget

date and time

The begin and end dates and times for the task.

Collaborate calculates these dates for your task based on the status if

you do not enter a start date, end date, or both

When you start a task (change the status from Pending or empty to

Active), and save:

« If the start and end date are empty, then the start date is set to the
current date and time. The end date is set to the current date time
plus duration.

« If the start date is set, but the end date is not set, the end date is
set to the start date plus duration.

« If the end date is set, but the start date is not set, the start date is

set to the end date minus duration.

When you complete a task (change status from Pending or empty to

Finish), and save:

« If the start and end date are empty, then the end date is set to
current date and time. The start date is set to the end date minus
duration.

« If the start date is set, but the end date is not set:
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Field

Description

o |f the start date is set prior to the current date, then the end
date is set to the current date and the duration is set to the
end date minus the start date.

o If the start date is set later than the current date, then the end
date is set to the current date and the start date is set to the
end date minus duration.

« If the end date is set, but the start date is not set, the start date is

set to the end date minus duration.
When you change a task to pending, and save:

« If the start and end dates are empty, those dates are kept empty.

« If the start date is set but the end date is not set, then the end date
is set to the current time plus duration.

« If the end date is set but the start date is not set, then the start
date is set to the end date minus duration.

Comments for

revision history

Enter notes to include in the revision history of the project and in any
notifications that are sent about the task.

Workflow Notes

Enter notes to display with the task in spreadsheet view or edit mode.

Task attachments tab

The Attachments tab contains the following fields.

[5) Note: Only the owner of a task can add an attachment. You can identify member roles

and members for tasks in edit mode.

Table 7. Fields on the Attachments tab

Item

Description

Attachments

The top of the page lists current task attachments. The following

information displays for each attachment:
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Item Description

« The attachment name, which is a link to the attachment.

* The file type and size.

« A description, including the date and time the attachment was
added, the name of the person who added it, and any additional
comments.

« Links for removing attachments or for sending the attachment by

email.
File to Attach Select the source of the file to attach.
Browse Click to browse your computer for the file to attach. Supported file

formats include DOC, PPT, XLS, PDF, GIF, JPEG, PNG, and MPP.

Comments Enter text to describe the attachment.

Save Attachment | Click to attach the selected file or URL.

Task dependencies

Collaborate offers different options for managing task dependencies as new rows are

added to a workflow spreadsheet and existing rows are removed.

In spreadsheet edit mode, you click In Series and select one of the following options:

» No Dependencies: the system does not create dependencies for new rows
automatically. If you need dependencies for the new tasks and stages, edit the task
name to add them manually.

« In Series: the system inserts new rows into an existing chain of tasks.

« In Parallel: the system inserts new rows in a dependency branch that is parallel to an
existing chain of tasks.
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Inserting tasks in series

Inserting In Series makes a new task dependent on the task before it, and then makes all

items that depended on that task dependent on the new task.

You insert a task in series when it can start only after the previous task is complete. For
example, in this figure, if task X cannot be worked on until task B is complete, you insert

task X in series.

Insert a step "X" after
"B" in series

A gy B g C BEECUEEE A o B Cc
D D

Inserting tasks in parallel

Inserting In Parallel makes the task dependent on the items (tasks or stages) that the task
before it depended on. This action makes the items that are dependent on the previous task

also dependent on the new task.

You insert a task in parallel when it can be worked on at the same time as another task. For
example, in this figure, if task X can be worked on simultaneously with task B, you insert

task X in parallel.

Insert a step after
"B"in Parallel

A B (e becomes AB'C
‘D
Deleting tasks

Deleting a task removes the selected task from the chain. Then, the system relinks the two

remaining segments of the chain together so that it is one continuous chain again.
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Remove step "C"
preserving chains

Age B X gD ECEWEEE A o B g D

A Ba XD EECUEE A g B g D
= =

When a task is deleted, its dependent tasks are made dependent on its dependencies
before the deletion takes place. This practice preserves all sequential chains of
dependencies.

Default and "last used" modes

To make adding a task as simple and consistent as possible, Collaborate provides the
following behavior.

« The default mode is In Series. When you begin an editing session, this mode is used as
the insertion mode.

« The "last used mode" is remembered for each editing session. When you select a
different dependency mode, it is used each time that you add a task until you change it
again or end the editing session.

« For example, to add several tasks in parallel, you need to select In Parallel mode only
one time. Then, every time you insert another task, the system inserts it in parallel
unless you explicitly select another mode.

If needed, you can change the dependency that is assigned by the system manually.
Click the task name, then edit the comma-separated list of task numbers that display in
parentheses after the name.

Adding a stage or task

To add a task or stage to a workflow, you must have the appropriate permission for the
related template.

If the Add option is missing from the toolbar, contact your administrator about obtaining the
appropriate access rights.
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Note the following information about stage and task rows.

« To differentiate stages from tasks, the rows for stages display in the spreadsheet with
a shaded background.
» When you add a stage or task, you can indicate where in the spreadsheet to insert it:

enter the stage number and the task number before the task name.

For example, if you enter 2. 3 Have team meet i ng anywhere in the task list, the task
is placed under the task that is labeled 2.2. Any subsequent tasks in that stage are
automatically renumbered: the step that was previously labeled 2.3 is now 2.4.

* You can move a stage or task to a different part of the spreadsheet. Use the up and
down options on the toolbar to move the stage or task to the appropriate place.

« There are several options for managing dependencies on tasks as new rows are added

and existing rows are removed. For more information, see Task dependencies (on page

95).

Stage and task sequence

If you change the number for a task or stage, the task is inserted before the row that

matches the new number.

For example, assume the following stage order:

1. Planning

2. Collateral Design

3. Lead Generation

4. Show Setup-to-Breakdown
5. Marketing Review

If you edit task 5, Marketing Review, changing its number to 3, the new order is as follows.

1. Planning
2. Collateral Design

3. Marketing Review
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4. Lead Generation

5. Show Setup-to-Breakdown

Now suppose that you edit task 2, Collateral Design, changing its number to 4. The new

order is as follows.

1. Planning

2. Marketing Review
3. Collateral Design
4. Lead Generation

5. Show Setup-to-Breakdown

To move a task or stage to the end, give it any number higher than the final task or stage.
For example, to move stage 2, Marketing Review to the end, change its number to 6 or

higher.

Adding rows to the workflow spreadsheet

Add rows to the workflow spreadsheet to add more tasks, System tasks, and stages.

Before you can add a row to the workflow spreadsheet, you open the workflow in edit mode.

For more information, see Edit mode toolbar (on page 108).

1. Decide what dependency option you want the new task or stage to use: Click In Series

( ) and select No Dependencies, In Series, or In Parallel.

Your selection remains in effect until you change it again.

2. In the workflow spreadsheet, click the stage or task name that you want the new row to

follow.

3. Add the stage, task, or system task: Click Add a Row ( ' ) and then select User Task, a

system task, or Stage.
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Collaborate adds the new row to the spreadsheet. Stages display with a shaded

background; tasks.

4. Optional: Change the dependency that is assigned by the system to the row. The
numbers of the tasks that a task or stage depends on display in parentheses after
the name. If a date for one task changes, the system changes the dates for all the

dependent tasks.

For example, suppose that you add a task and its name is 2. 5 Deliver draft to
vendor (2.4)2.5 Generate List (2.4).Tomake thistask dependent on task 1.3
instead of task 2.4, change the task nameto 2.5 Deliver draft to vendor (1.3)2.5
Generate List (1.3).To make thistask dependent on both task 1.3 and task 2.4,
separate the task numbers with commas: change the task nameto 2. 5 Del i ver draft
to vendor (1.3, 2.4)2.5 Generate List (1.3, 2.4).

For more information, see Task dependencies (on page 95).

5. When you finish editing the workflow, save your changes.

The stage or task is added to the workflow after the insertion point.

Spreadsheet view mode

When you display the Workflow tab in spreadsheet view (the default), information about the

stages and tasks in your workflow display in tabular format.

For information about the columns that display, see Workflow spreadsheet columns (on
page 104).

In addition to viewing data for the workflow, you can update task status and scheduling

information and add attachments. For more information, see Post Task Update dialog (on

page 92).

To customize the spreadsheet view, click Layout ( ) on the Workflow tab. You can select
the columns to display and the width of the first (task name) column. For more information,

see Spreadsheet or timeline view customization (on page 102).
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Process flowchart view

The process flowchart view displays the tasks in a network diagram style.

- Each task is displayed as a box with a task number and ID.

« Tasks that have dependencies are connected to any tasks they depend on.
« Sequential tasks are displayed on the same line.

- Parallel tasks are displayed on different lines.

« Independent and orphan tasks are displayed on their own line, with no connections.

Timeline view mode

When you view the workflow on a timeline, you can update the task status and scheduling

information and add attachments.

The Workflow tab timeline view presents a view of the tasks for a projectList, On-demand
Campaign, or Corporate Campaign over a period of weeks or months. To display tasks
on a timeline, click View > View as a Timeline/Gantt chart Timeline View “* . To replace,
naviagte to Spreadsheet view or Weekly timeline.

For more information, see Post Task Update dialog (on page 92).

To customize the timeline view, click Layout ( ) on the Workflow tab. You can customize

the timeline view in any of the following ways:

» Choose weeks or months as the time scale.
- Select the dates to plot: Actual/Forecast or Target.

« Select captions for timeline bars.

For more information, see Spreadsheet or timeline view customization (on page 102).
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Spreadsheet or timeline view customization

When you view the Workflow tab in spreadsheet view mode or timeline view mode, you can

make choices about the information that you want to see.

To customize the view, click Layout ("= ).

Options on the Project Workflow Tab Layout dialog

The Project Workflow Tab Layout dialog displays the following options:

Table 8. Options on the Project Workflow Tab Layout dialog

Option Description
Spreadsheet To hide the options in the Spreadsheet Layout section on this dialog,
Layout click the icon next to the section title. To view a hidden section, click
again.
Columns to A list of check boxes that corresponds to the columns you can include
Display in spreadsheet view mode. Click a link above the list to select a preset

group of columns to display:

- all: default setting; all boxes checked (all columns display).

- targets: hides Status, % Complete, and Actual date columns.

- actuals: hides Target Dates/Effort and Member/Reviewer roles
columns.

- all dates: displays all columns that are related to target and actual
dates.

« responsibility: displays columns that are related to who is

assigned to complete the tasks.

Alternatively, you can check individual columns to include them or clear

columns to remove them.
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Option Description
First Column Defines the width for the first column, which displays task names
Width and dependencies. You can set a different first column width for

spreadsheet view mode and for timeline view mode. Select:

« Remember Last Setting: When you view the workflow spreadsheet,
you can adjust the first column width to see more or less of the
task names.

« Exactly: Select to enter a number that sets the column to an exact
width in pixels.

Timeline Layout

To hide the options in the Timeline Layout section, click the icon next to

the section title. To view a hidden section, click again.

Time Scale

The increment of time that is used for measurement. Select Weeks or
Months. The default setting is Weeks.

Bars Represent

The bars in the timeline view indicate durations. You can choose to
display Actual/Forecast dates, Target dates, or both. The default is to
display both.

Bar Captions

By default, the bars do not have captions. Select an option to display
task information as bar captions. For example, you can have task

names or milestone types display as the captions.

First Column
Width

Defines the width for the first column, which displays task names
and dependencies. You can set a different first column width for

spreadsheet view mode and for timeline view mode. Select:

« Remember Last Setting: When you view the workflow spreadsheet,
you can adjust the first column width to see more or less of the
task names.

« Exactly: Select to enter a number that sets the column to an exact
width in pixels.
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Option

Description

Make these the
default settings

for this project

Check this box to make your selections the default for the Workflow
tab. This option ensures that your display settings for this tab do not

change until you make another change and check this box.

settings for
current workflow

only

workflow tab
[5) Note: Your settings become the defaults for all users for this
workflow, until someone changes the defaults.

Use these Check this box to apply your selections to the current workflow only.

This option ensures that your display settings for this workflow do not

change until you make another change and check this box.

Clear this box to make your selections the default for the Workflow tab.
Your settings become the defaults for all users for this workflow until

someone changes the defaults.

Workflow spreadsheet columns

When the workflow displays in spreadsheet view mode (the default view) or in edit mode,

data is presented in a spreadsheet of columns and rows. You review and enter information

in the spreadsheet cells for each column.

Table 9. Workflow spreadsheet columns

Column

Description

Tasks, Stages

Lists the tasks and stages that make up the Advanced List, On-demand

Campaign, or Corporate Campaignproject.

When in edit mode, click a stage or task to revise or change its

sequence, hame, or dependencies.

When in view mode, click a task to update status and scheduling

information. For more information, see Post Task Update dialog (on

page 92).
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Column

Description

Status

Displays an icon to indicate the status of the task. Tasks can have one

of the following statuses.

* Pending
« Active

« Skipped
« Finished

% Complete

The percentage value that represents how complete a task is.

In edit mode, click the measuring bar for a task and enter a new %
Complete number. The measuring bar expands to display a comparable

level.

Forecast/Actual
Start

For tasks in the pending state, this field represents the Forecast Start
date. Forecast Start dates display in italic font. After you change a
task from Pending to Active, this field represents the Actual Start date.

Actual Start dates are in regular font.

In edit mode, click in the cell to use a calendar to select a date and

time.

Forecast/Actual
End

For tasks in the pending state, this field represents the Forecast End
date. Forecast End dates display in italic font. After you change a task
from Active to Finished, this field represents the Actual End date. Actual

End dates are in regular font.

In edit mode, click in the cell to use a calendar to select a date and

time.

Forecast/Actual

Duration

The duration of the task, in days, hours, and minutes.

If you enter both start and end dates, the system automatically
calculates a value for this field (the Forecast/Actual End date minus the
Forecast/Actual Start date).




Corporate Marketer's Guide | 7 - Workflows | 106

Column

Description

Actual Effort

The actual effort that it took to complete the task, as opposed to

calendar duration. Effort is measured in days, hours, and minutes.

Anchored Dates

Indicates whether the task is anchored. If a lock icon displays, the
dates for the task are anchored.

To specify anchored dates for a task, click the column, then select
Anchored from the menu. The task date cannot move even if the dates

of the tasks it depends on change.

If a dependency is not met, the dates in conflict appear with a different
icon and in a different font.

For example, suppose task 2.2 depends on task 2.1. If the target end
date of task 2.1 is after the target start date of task 2.2, both the target
end date of 2.1 and the target start date of 2.2 appear in red. This
action occurs only if you anchored the date for task 2.2 by selecting the

lock icon in the Anchored Dates column.

Schedule
Through

Indicators for which dates to use when you determine task dates. The

following options are available.

* Bus. - Business days only: include only standard, non-holiday, non-
weekend dates in date calculations that are made for this task.
This schedule is the default for all tasks.

» Wkd. - Business days + Weekends: include weekends in date
calculations that are made for this task.

- Off. - Business days + Days off: include predefined system-wide
non-work time in date calculations that are made for this task.

« All - All calendar days: include all dates in date calculations that
are made for this task. No dates are ignored when dates are
calculated for this task.

Target Start

The targeted start date of the task. In edit mode, use the calendar to
select a date.
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Column

Description

You can add a custom milestone type to set a target and forecast dates
for all tasks in a workflow in a project template. To do this, create a
milestone with code START. Then, create a project template. In the
workflow of this template, assign one task with this milestone type.
When you create and save a project with a target start date that uses
this template, the task with the new milestone type copies the project
start date as its own target start date as well as its forecast start date.
These target and forecast dates are then rippled to all dependent tasks

in the project.

The milestone type START can only be assigned to one task in a

workflow.

Target End

The targeted end date of the task. In edit mode, use the calendar to

select a date.

Target Duration

The duration of the task, in days, hours, and minutes. The Target End

minus the Target Start dates.

Target Effort

The targeted effort that is estimated to complete the task, as opposed

to calendar duration.

Milestone Type

A task milestone that you choose from a list. Example options might be
Meeting, Event, and Job Start. System administrators set the milestone

types that are on the list.

For more information about setting up milestones, see the Collaborate

Installation Guide and Collaborate Administrator's Guide.

Member Roles

A role or roles that are associated with the task. These roles can be
loaded automatically from the project template that is used to create

the project, or the project owner can set them up manually.

Members

The people that are associated with the task.
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Column

Description

If a workflow task has a role in its Member Role(s) column, when you
assign people to roles, the workflow automatically adds a person in the

corresponding Members column.

You can also add people to the Members column manually while you

edit the workflow.

Enforce Dep.

If this task depends on other tasks, determines how strictly the system
interprets dependencies. When this option is selected, the system
restricts project members from updating this task until the tasks it

depends on are finished.

Required Indicates whether this task is required. Required tasks cannot be
skipped or deleted and their names cannot be changed.

Task Code A read-only code that identifies each task uniquely within a project.
System integrators use this code to implement custom business logic
for tasks.

Notes Any comments about the task.

Edit mode toolbar

When you switch from a view mode to edit mode, you can change the workflow. You click

the icons on the toolbar to add, move, and delete stages and tasks.

The following table describes the toolbar options.

Table 10. The edit toolbar for the Workflow tab

lcon

Description

Add Row. To add a row after an existing row in the workflow, select the

row then click this icon to specify the type of row. You can add:

- Stage: stages organize tasks into groups
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lcon

Description

* User Task

* Flowchart Run

* List Review

« Notify Field Marketers (Corporate Campaigns)
« Subscription (Corporate Campaigns)

« Recurrence

Collaborate adds the task and renumbers the subsequent tasks.

In Series. By default, the system adds rows to the spreadsheet in
series, so each task depends on the task that precedes it. To use a
different dependency option, click this icon and make a selection

before you add the next task to the workflow.

Select a dependency option.

* No Dependencies: when you add a row, the system does not make
it dependent on any other row

« In Series: when you add a row, the system makes it dependent on
the row above it

« In Parallel: when you add a row, the system makes it dependent on

the same task or tasks as the row above it

Each row that you add uses the same dependency option until you

change your selection.

You can also change dependencies manually; click the task or stage
name and supply a comma-separated list of numbers in parentheses.

For more information, see Task dependencies (on page 95).

Add Stage Row. Adds a stage in the spreadsheet. Tasks are grouped in

stages.

Move row up. Click a task or stage name to select the row, then click

this icon to move the selected row upward.
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lcon

Description

[5) Note:

« When you move a row, its task dependencies do not change.

« When you move a stage, all of its associated tasks move with it.

Move row down. Click a task or stage name to select it, then click this

icon to move the selected row downward.

[5) Note:

» When you move a row, its task dependencies do not change.

» When you move a stage, all of its associated tasks move with it.

Delete row. Click a task or stage name to select it, then click this icon

to delete the component.

Epl Note:

* You cannot delete the first stage in a workflow spreadsheet.
* When you delete a stage, its associated tasks are appended to the

previous stage. The tasks are not deleted.

Recalculate Dates. Shift+click to select one or more adjacent cells
in the spreadsheet, then click this icon to apply one of the following

options:

« Preserving slack time between Tasks: recalculates all date
dependencies that are based on your changes; any slack time
between dependent tasks is not removed.

* Removing slack time between Tasks: recalculates all date
dependencies that are based on your changes; any slack time

between dependent tasks is removed.

Tools. Offers options that affect the values in specific spreadsheet

cells, or that affect a column or the entire spreadsheet.
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lcon

Description

To apply any of the following options, you must first Shift+click to

select one or more adjacent cells in the spreadsheet:

« Copy: copies the contents of the selected cells to the clipboard.

- Paste: pastes the contents of the clipboard, beginning at the
selected cell.

« Paste Rows After: pastes the contents of the clipboard below the
selected row.

» Mark as: changes the Status and % Complete values for the
corresponding task or tasks. For example, Mark as Finished
changes the Status to Finished and % Complete to 100%. You can
mark tasks as Skipped, Finished, Active, or Pending.

« Fill Down/Up: copies the value in the selected cell or group of cells
to the cells below or above it.

« Clear: erases all entries in the selected cell or group of cells.

[5) Note: You must apply these options to cells that are adjacent; that

is, Ctrl+click selections are not supported.

The other options on the Tools menu function as follows:

« Import and save workflow: available if the project is in Not Started
status only. Replaces the entire spreadsheet with the tasks and
values in a previously defined workflow template.

« Clear Column: click a single cell, then select this option to erase all
entries in that column. For columns that have a default value, such
as Schedule Through, every cell is set to the default.

« Clear All: erases the entire spreadsheet.

Click to recalculate dependent dates while preserving slack time.
Recalculates all date dependencies that are based on your changes;

leaves any existing slack time between dependent tasks.




Corporate Marketer's Guide | 7 - Workflows | 112

lcon

Description

Click to recalculate dependent dates while removing slack time.
Recalculates all date dependencies that are based on your changes;

removes any slack time between dependent tasks.

Undo. Click to undo your last change.

Redo. Click to reapply a change you undid with the Undo action.

Save. Click this icon to select one of the following options:

« Save: Interim save, the spreadsheet remains in edit mode.

« Save and Finish: Saves your work and displays spreadsheet view
mode.

« Save and Return to List: Saves your work and displays the most

recently selected list of projects.

Cancel. Return to spreadsheet view mode without saving edits that are

made since your last save.

Click one of the following options to complete your work:

« Cancel. Return to spreadsheet view mode without saving edits that are made since

your last save.

- Save: Interim save, the spreadsheet remains in edit mode.

- Save and Finish: Saves your work and displays spreadsheet view mode.

Work in spreadsheet view mode

When you initially click the Workflow tab, it displays in spreadsheet view mode and offers

the following user interface controls.
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Table 11. Controls on the Workflow tab

Control Description

Breadcrumb links Breadcrumbs (links to the pages you visited before you arrive at
the current page) are located above the projectList, On-demand

Campaign, or Corporate Campaign name. Click any active link in
the breadcrumb trail to go to that page.

Edit. Changes the display to edit mode so that you can add,
remove, and change workflow stages and tasks and enter detailed
information for the tasks. For more information, see Edit mode

toolbar (on page 108).

Save as Template. Saves the workflow definition as a reusable

workflow template (if you have the permission to do so).

A dialog opens for you to name the template. For more information
about using template components, see the Collaborate

Administrator's Guide.

Spreadsheet View. Changes the display to spreadsheet view mode,

which provides information about each task in tabular format.

When you view the workflow as a spreadsheet, each task name is
a link. Click a task to open a dialog where you can add and change
information about the task. For more information, see Post Task

Update dialog (on page 92).

Weekly Timeline View. Changes the mode to present a graphic
display of scheduling information for the tasks, including duration

and status. For more information, see Timeline view mode (on
page 101).

When you view the workflow on a timeline, each task name is a

link. Click a task to open a dialog where you can add and change
information about the task. For more information, see Post Task
Update dialog (on page 92).
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Control Description

Layout. Opens a dialog where you can select the columns that
you want to display in spreadsheet view mode, and choose the
time scale and dates to include in timeline view mode. For more

information, see Spreadsheet or timeline view customization (on

page 102).

Changing the layout of the workflow

You can change the layout of the spreadsheet and timeline views of the workflow to display

the information that you need.

1. In the Workflow tab, click Layout.

The Instance Workflow Tab Layout dialog box opens.

2. In the Spreadsheet Layout section, select the check boxes of all columns you want to
show in the workflow.

You can also use the links after Columns to display: to select subsets of available

columns.
3. Set the first column width for the spreadsheet view.

4. In the Timeline Layout section, select values from the Time Scale, Bars Represent, and
Bar Captions drop-down lists.

5. Set the first column width for the timeline view.

6. To have these settings apply only to the currently opened workflow, as opposed to all

workflows you view, check Use these settings for current workflow only.

7. Click Apply or Apply and Close to save your selections.

The view of the workflow is updated to reflect your selections.
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Setting the first column width

You can change the width of the first column in the workflow spreadsheet view and keep

this setting for your entire session.

To set the first column width, complete the following steps.

1. Navigate to the Workflow tab of the projectAdvanced List, On-demand Campaign, or
Corporate Campaign.
2. Use the column width control to resize the first column to your preferred width.
3. Click Layout in the upper right section of the screen.
4. In the Instance Workflow Tab Layout dialog, complete the following steps:
a. In the First Column Width section, select Remember Last Setting.
b. At the bottom of the dialog, check the Make these the default settings for this
project's workflow tab box.
5. Click Apply and Close to save your changes and close the dialog.

The first column width is now set for this Advanced List, On-demand Campaign, or

Corporate Campaign for the remainder of your session.



Chapter 8. Flowcharts for Corporate
Campaigns

For a Corporate Campaign, two flowcharts are typically run by corporate marketing through

Campaign.

The two flowcharts are:

« A List selection flowchart selects target customers from your customer database. Field
marketers then accept or decline the target customers who are associated with them.
« A second flowchart runs the campaign. It selects those customers that are approved by

field marketers, associates them with offers, and fulfills the campaign.

Flowcharts for On-demand Campaigns

For On-demand Campaigns, field marketers typically specify selection criteria made

available by the administrator in the On-demand Campaign template.

That selection criteria is sent to the associated List selection flowchart in Campaign and

used to select customers from the customer database.

A second flowchart runs the On-demand Campaign that is based on criteria you configure.
For example, the On-demand Campaign can have an attribute to indicate whether it should
be fulfilled locally or by the corporate office. If it is to be fulfilled locally, the flowchart
generates a file that is attached to the On-demand Campaign, and the field marketer can
use this file to fulfill the campaign. If it is to be fulfilled by the corporate office, then the

results are written to a table that the corporate marketer can use for fulfillment.

While the flowcharts run in Campaign, field marketers can complete all their work through
Collaborate. The Flowchart Run tasks in the workflow execute the Campaign flowcharts in

the background.

Typically, corporate marketers design and create the flowcharts in Campaign, as well as

templates and forms in Collaborate; field marketers work only within Collaborate.
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Flowcharts for Lists

For Lists, field marketers typically specify selection criteria made available by the

administrator in the List template.

That selection criteria is sent to the associated list selection flowchart in Campaign and

used to select customers from the customer database.

While the flowchart runs in Campaign, field marketers can complete all their work through
Collaborate. The Flowchart Run task in the workflow executes the Campaign flowchart in

the background.

Typically, corporate marketers design and create the List selection flowcharts in Campaign;

field marketers work only within Collaborate

List selection flowcharts

A list selection flowchart in Campaign uses certain criteria to select customers from the

customer database.
This criteria is specified in a Select process.

The flowchart must also contain a Snapshot or Extract process to write the selected list to

the Collaborate database.

List selection flowcharts for Corporate Campaigns

For Corporate Campaigns, the corporate marketer creates and generates the List through
Campaign. The contact list is then made available to subscribed field marketers using

Collaborate for validation.

Steps for generating the Corporate Campaign List

The following steps outline the tasks for generating the Corporate Campaign List:
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1. The corporate marketer creates the Corporate Campaign and the linked campaign, by
accessing the Corporate Campaigns page through the Corporate Campaign command
in the Local Marketing menu.

2. The corporate marketer configures the linked campaign, by accessing the campaign
through the Campaigns command in the Campaign menu.

3. The corporate marketer builds the List selection flowchart, by accessing the campaign
through the Campaigns command in the Campaign menu.

4. A Corporate Campaign workflow task runs the List selection flowchart.

5. In Campaign, the flowchart runs, resulting in the List being written to the Collaborate
database.

6. The corporate marketer accepts the contact list.

How Corporate Campaign selections are stored

You should design the list selection flowchart that is associated with a Corporate Campaign
so that when it runs in Campaign the selected customers are stored in the Collaborate

system database, in the uacc_corporate_|ists table.

Generating and storing the list through the flowchart

[5) Note: Before the flowchart can store the list selections in the uacc_corporate_lists

table, the table must be mapped in Campaign.

List selections are made through a Select process in the flowchart. You define the SQL
statements to select desired customers for the Corporate Campaign. For example, the

Select process might select all customers with a savings account within a specific range.

You can use one or more Select processes to select the target customers for the Corporate

Campaign list.

Following the Select processes, you add a Snapshot or Extract process. When you configure

the Snapshot or Extract process, ensure that you:

 Export the selections to the uacc_corporate_li sts table.
- Select the Append to Existing Data radio button.
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[5) Note: The uacc_corporate_lists table contains the history of all the generated

lists. If you select either Replace All Records or Update Records, the contents of the

table are overwritten or updated and all the lists are deleted or updated.

Mapping database fields to the uacc_corporate_lists table

In the list selection flowchart, you must map fields in your customer database to the

following fields in the uacc_cor porate_li st s table:

Field

Field Type

Saved Value

Listld

Campaign
Generated Field

CampaignCode. Generated field CampaignCode
should be mapped against Listld field.

Audiencelevel

Derived Field

The audience levels configured in the List Manager
module must be hardcoded with the values
configured inthe | i st manager _t abl es. xm file
(for example, "P" for People Table or "P/C" for People
Table/Contract Table).

UserBranch

N/A

Not required.

UserlD

<Customer_Userj

>The user name of the field marketer or corporate

marketer that is running the flowchart.

[5) Note: Internally, all flowcharts are run by the
same Campaign user. The flowchart uses the
UserName variable to store in the UserlD field
the user name of the field marketer or corporate

marketer who ran this flowchart.

GenerationDate

<Generate_Date>

Date on which the records are generated. This can be
a specific date, a formula, or a date indicated in the

campaign.

Status

Derived Field

All records are initially set to T, for To Accept, which

corresponds to Waiting in the user interface.
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Field Field Type Saved Value

List records can have one of four status values,
depending on the actions of field marketers during

validation:

* T: To Accept
* V: Accepted
* A: Added

* D: Deleted

Audience Level |<CustomerID> | The unique ID for the target of the campaign,

ID or <AccountIlD> |typically a Customer ID Or Account ID.

You may need to map additional fields for filtering purposes. For example, if the r egi on_i d

column was added for Data Level Filtering, you need to map it as well.

List selection flowcharts for On-demand Campaigns and Lists

For On-demand Campaigns and Lists, the corporate marketer typically creates the flowchart

in Campaign, then field marketers run the flowchart and generate the lists.

Steps for generating the On-demand Campaign or List customer list
The following steps outline the tasks for generating the customer list for an On-demand

Campaign or List:

1. In Campaign, create and publish the list selection flowchart.

2. In Collaborate, create and publish forms, then add them to a template with custom tabs
for displaying the flowchart forms.

3. In Collaborate, create the On-demand Campaign or List using the appropriate template.

4. In Collaborate, select the list composition criteria.

5. In Collaborate, generate the list by running the flowchart.
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User variables for list selection flowcharts

When you build the List selection flowchart in Campaign, you must first specify the user

variables to be used in the queries to select your contacts.

You must define two types of user variables:

« All user variables that map to selection criteria that you want field marketers to be able
to set when creating an On-demand Campaign or List. For example, if you want field
marketers to be able to select an | ncone Range for an On-demand Campaign, you must
define a user variable for | ncone Range in the list selection flowchart.

« All user variables that are specified in the following table:

Data
User Variable Type Value
UserName Text | <User_name> (the ID that the user enters to log in to

Collaborate).

This parameter is never displayed in Collaborate.

Listld Text |<ID_List>

This parameter is displayed as the List Code in the List
Summary page, or the On-demand Campaign Code on

the On-demand Campaign Summary page.

ListSection Text | Allows you to combine lists to form new lists.

<Anycharacter_string> All variables with the prefix "ListSection" are linked to
the list of Lists.

The list of all Lists contain the field marketer's active

Lists that can be included or excluded.
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Guidelines for list selection flowcharts for On-demand Campaigns and Lists

When you build the list selection flowchart in Campaign, you must follow specific

guidelines.

The specific guidelines are as follows.

* You must specify the flowchart name in the template for On-demand Campaigns or
Lists from which the flowchart is run.
* You cannot use the following processes in a list selection flowchart:
° Plan
o Create Segment
> Cube

If you are using the List Manager, follow these additional guidelines:

« For On-demand Campaigns, the flowchart must end with a Snapshot or Extract process
that writes the selections to the uacc_ondemand_lI i st s table in the Collaborate system
database.

« For Lists, the flowchart must end with a Snapshot or Extract process that writes the

selections to the uacc_l i st s table in the Collaborate system database.

How On-demand Campaign or List selections are stored

When the list selection flowchart associated with an On-demand Campaign or List runs in

Campaign, the selected customers are stored in the Collaborate system database.
On-demand Campaign selections are stored in the uacc_ondemand_l i st s table.

List selections are stored in the uacc_Ii st s table.

Generating and storing the list through the flowchart

[5) Note: Before the flowchart can store the list selections in the uacc_ondemand_I i st's or

uacc_l i st's table, the table must be mapped in Campaign.
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List selections are made through one or more Select processes in the flowchart. You define
the SQL statements to select desired customers for the On-demand Campaign or List. For
example, the Select process might select all customers with a savings account within a

specific range.

You also use user variables to specify parameters in Collaborate that are used as selection

criteria in the flowchart in Campaign.

If you are using the List Manager following the Select processes, you add a Snapshot or

Extract process. When configuring the Snapshot or Extract process, ensure that you:

« Export the selections to the uacc_ondemand_I i sts oruacc_| i st s table.
« Select the the Add to Existing Data radio button.

[5) Note: The uacc_ondenand_l i sts and uacc_l i sts tables contain the histories of
all the generated lists. In the flowchart in Campaign, if you select either Replace All
Records or Update Records, the contents of the tables are overwritten or updated and
all the lists are deleted or updated. The lifecycle of data in these tables is meant to be
managed through Collaborate. For example, when you delete a List, the data for that
List is cleared. In addition, when the List is rerun, entries from previous runs of that list

are cleared from the table.

Mapping database fields to the uacc_ondemand_lists or uacc_lists table
In the list selection flowchart, you must map fields in your customer database to the

following fields in the uacc_ondemand_I i sts oruacc_| i sts table:

Field Field Type Saved Value
Listld User Variable UserVar.Listld
AudiencelLevel | Derived Field The audience level(s) configured in the List Manager

module must be hardcoded with the values
configured in the | i st manager _t abl es. xn  file (for
example, "P" for People Table or "P/C" for People
Table/Contract Table).

UserBranch N/A N/A
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Field Field Type Saved Value

UserlD User Variable UserVar.UserName

User to which the selected customer is associated.
The value must correspond to the ID that the user

uses to log in.

GenerationDate | <Generate Date> Date on which the records are generated. This can be
a specific date, a formula, or a date indicated in the

campaign.

Status Derived Field "V"is hardcoded.
All records are set to "Accepted” by default.

List records can have one of four status values,
depending on the actions of field marketers during

validation:

* T: To Accept
« V: Accepted
 A: Added

* D: Deleted

AudiencelevellD | <CustomerID> ID of references

You may need to map additional fields for filtering purposes. For example, if the r egi on_i d

column was added for Data Level Filtering, you need to map it as well.

Campaign fulfillment flowcharts

A campaign fulfillment flowchart in Campaign begins the actual marketing campaign and

controls how specific offers are sent to selected customers.
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For On-demand Campaigns, corporate marketers build the campaign fulfillment flowchart
in Campaign and associate it with an On-demand Campaign template in Collaborate. Field

marketers then run the campaign fulfillment flowchart from within Collaborate.

The selected customers are handled differently for Corporate Campaigns and On-demand

Campaigns.

Campaign fulfillment flowcharts for Corporate Campaigns

The Corporate Campaign fulfillment flowchart can be executed by a Run Flowchart task in
the workflow, or the corporate marketer can create and run the fulfillment flowchart through

Campaign.

How you select target customers in the campaign fulfillment flowchart

You select target customers in the campaign fulfillment flowchart from the

uacc_cor por at e_| i st s table in the Collaborate system database.

In a Corporate Campaign, field marketers must approve their associated target customers
for inclusion in the campaign. Field marketers can also add customers who were not in
the original list that is generated by the list selection flowchart. Only approved or added

customers should be selected by the Corporate Campaign's fulfillment flowchart.

The list selection flowchart records the original list of customers in the
uacc_cor porat e_l i st s table in the Collaborate system database. When field
marketers review the customer list, their rejections, and additions are recorded in the

uacc_corporate_|ists table as well.

Therefore, the campaign fulfillment flowchart must select the approved target customers

from the uacc_cor porate_li st s table, not the original table in the customer database.

Filtering targets in the uacc_corporate_lists table to select the right
customers
When you select customers from the uacc_cor porat e_l i st s table in the Collaborate

system database, you must filter your selections that are based on two criteria:

* Project Code
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You must select only target customers for this Corporate Campaign by matching the
campaign's unique code with the pr oj ect _code value. For example, the Select process
in the flowchart could include the statement:
proj ect _code = " Cor pCanp029"
« Status
You must select only approved target customers by matching values of Aor vin the

St at us column. The Select process in the flowchart should include the statement:

Status in (A, 'V)

Campaign fulfillment flowcharts for On-demand Campaigns

For On-demand Campaigns, the corporate marketer creates and publishes the campaign

fulfillment flowchart through Campaign.

Corporate marketers, or administrators, add the form that is automatically created by the
publishing of the flowchart to an On-demand Campaign template. Field marketers then use

the On-demand Campaign template to create new On-demand Campaigns.

A field marketer runs the campaign fulfillment flowchart for an On-demand Campaign

through Collaborate.

How you select target customers in the campaign fulfillment flowchart

You select target customers in the campaign fulfillment flowchart from the

uacc_ondemand_l i st s table in the Collaborate system database.

The list selection flowchart for the On-demand Campaign records the list of customers in
the uacc_ondemand_I i st s table. Field marketers refine this list by refining the selection

criteria for the On-demand Campaign and rerunning the list selection flowchart.
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Filtering targets in the uacc_ondemand_lists table to select the right
customers

When you select customers from the uacc_ondenmand_I i st s table in the Collaborate system
database, you must filter your selections that are based on the User var. 1 D_Li st user
variable.

On-demand Campaign fulfillment

Corporate marketers can specify On-demand Campaign fulfillment requirements to field

marketers through a custom tab on the On-demand Campaign template.

Local or corporate service fulfillment

Depending on how your administrator configured the On-demand Campaign template, you
might have to fulfill the On-demand Campaign. Or, you might be required to use a corporate

service to fulfill the campaign. Or you might have to choose between these methods.

When you are permitted by the corporate office to fulfill the On-demand Campaign, the

corporate marketers might configure the mail merge feature to facilitate fulfillment.

The mail merge feature

Field marketers or corporate marketers can use the Collaborate mail merge feature to
personalize standard letters by merging a Microsoft™ Word letter document with a file that

contains contact data for on-demand marketing campaign target customers.

View campaign and list attributes in Collaborate

Corporate marketers can expose the list and campaign attributes. The attributes can then

be viewed by field marketers for On-demand Campaigns and Lists.

Field marketers view of campaign and list attributes

Field marketers can view the selection criteria for a List or On-demand Campaign, and the
fulfillment specifications for an On-demand Campaign. This information comes from the

flowchart attributes the corporate marketer exposes in Collaborate.
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Selection criteria and fulfillment specifications are made available as tabs in the template

for the On-demand Campaign or List.

Field marketers cannot view this information for Corporate Campaigns; therefore, these

tabs are not available in Corporate Campaigns.

Making flowchart attributes visible in Collaborate
For On-demand Campaigns, corporate marketers can make list and campaign attributes

visible to field marketers by using Collaborate.

Before you can complete this task, you must define the selection criteria as user variables.

1. Edit the flowchart with the criteria you want to make visible to field marketers.

2. In the flowchart editor, click the Options icon ().

3. From the drop-down menu, select Parameter List.
The Campaign Settings window displays the Expose Parameters tab.
This tab contains all the settings that are used in the processes that are contained in
the flowchart, as well as the user variables that you have already defined.

4. Check the box next to the parameters that you want to be visible to field marketers.
Only the selected parameters are visible in Collaborate.
/\ Important: Each published flowchart must have the user variables UserName and
ListID. If these two user variables are not present when the flowchart is published, the

associated form in Collaborate is not saved. These variables must also be exposed to

publish and create forms.

5. Select the name of each checked user variable or setting to define how they are

displayed in Collaborate:

a. Enter the name of the setting that is selected in the Prompt field to use as the

name of the linked field in Collaborate.



Corporate Marketer's Guide | 8 - Flowcharts for Corporate Campaigns | 129

b. Enter the text that is displayed in a help bubble if the field marketer selects the

associated help icon in Collaborate.

c. Select desired interface in which the criteria value are input or selected in

Collaborate.

The following types are available:

« Edit Box

« Select One From Drop-Down List

« Select One using Radio Buttons

« Select Multiple From List

« Select Multiple Using check box

6. Redefine the default value if it is not correct.

The default value of the user variable is specified in the Default Value field, if it is

assigned to the variable.

[5) Note: If you do not select a user variable, Collaborate uses the value that is

specified in the Default Value field. If no default value is specified, then all possible

values are selected.

7. Click OK when finished.

Process display settings and field marketer actions

Each process in Campaign has its own group of settings to which you can provide access.

The following table describes the possible actions a field marketer can take for each

selected setting.

Processes Display Settings Supported Field Marketer Actions
Select Query Expression Enables the user to edit the
Export Cell Size Limit request that is used by the

process.
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Output

Export Operation

Processes Display Settings Supported Field Marketer Actions
Cell Size Limit Method Enables the user to set this limit
Cell Size Limit Random Seed Not supported
Result Cell Size (output) Not supported
Displays the total number of
customers who meet the selection
or export criteria in the Results
tab.
Merge Cell Size Limit Enables the user to set a target
Reference Result Cell Size (output) count limit.
Displays the total number of
customers who meet the selection
or export criteria in the Results
tab.
Segment Mutually Exclusive Segments Not supported.
For each segment: See above. Query Expression is
Cell Size Limit / Query not supported.
Expression / Result Cell Size
(output)
Sample Random Seed Enables the user to select records
Specify Size by randomly.
For each sample: Enables the user to specify the
type of sample (percent or number
Cell Size Limit / Result Cell Size
of records).
(output)
See above.
Snapshot Export To Enables the user to save the

extraction result in a table or a file.
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Processes Display Settings Supported Field Marketer Actions
Event Export Table/File Name If the process is configured to
Delimited file export data to a table or a file,
you can view the file name and
Include Headers ) )
location, or let the user specify her
Output File/Table Name own name and location for the file.
Enables the user to include the
column headers in the tables.
If the process is configured to
export data to a table or a file, the
name of the output file must be
entered for the generated file to be
attached to the list or campaign in
Collaborate.
Segment Mutually Exclusive Segments Not supported.
For each segment: See above. Query Expression is
Cell Size Limit / Query not supported.
Expression / Result Cell Size
(output)
MailList Random Seed If the process is configured to
CallList export a contact list, the name

of the export table/file must also
be entered for the generated file
to be attached to the On-demand
Campaign in Collaborate.
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Running flowcharts

For Corporate Campaigns, the corporate marketer must run the list generation flowchart

through a Flowchart Run task in the workflow.

Running flowcharts for Corporate Campaigns

For fulfillment flowcharts, the corporate marketer has the option of running the flowchart

through Campaign.

Running flowcharts for On-demand Campaigns and Lists

For On-demand Campaigns or Lists, the field marketer schedules the flowcharts when
editing the On-demand Campaign or List workflow, or runs them directly via the Generate
List and Run Campaign links in the Summary tab of the On-demand Campaign or list in

Collaborate.
A field marketer can also run the flowchart from the Summary tab of the On-demand

Campaign or List, by clicking Run Campaign or Generate List.

[5) Note: Field marketers typically do not work directly in Campaign.

Reviewing run history

You can view the history of flowchart runs in the Analysis tab of the Corporate Campaign,
On-demand Campaign, or List. In the Analysis tab, select Run History from the drop-down

list in the upper-right corner.

For each run, the run history shows user variables, input, and output parameters and counts

for the generated lists.

Attaching flowchart output files to On-demand Campaigns

For an On-demand Campaign, you can have flowchart output files that are attached

automatically.

To attach files, follow these guidelines:
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« Output files must be exported by the flowchart to a single folder on the Campaign
server under partitions/partition_x.

* You must expose the Output File output parameter to Collaborate so that the system
knows which file in the directory to attach to the List or On-demand Campaign.

« You must make flowchart attributes visible in Collaborate

* You must specify the access mode and path between the Collaborate server and the

Campaign server in the col | abor at e_confi g. xni file.

You can choose to retrieve files by:
> Accessing the Campaign folder (the default)
o FTP
s HTTP
o TFTP



Chapter 9. Working with Lists, On-demand
Campaigns, and Corporate Campaigns

This section contains common information about working with Lists, On-demand

Campaigns, and Corporate Campaigns.

The content in this section applies to each of these objects, as the instructions are the
same. For example, you delete a List, On-demand Campaign, or Corporate Campaign in the

same way; therefore information about deleting these objects is presented together.

Where necessary, differences between Lists, On-demand Campaigns, and Corporate

Campaigns are noted.

[5) Note: You may not have the necessary permissions to perform all tasks that are
described in this section, or you may have permissions to perform the task on some objects,
but not others. For example, field marketers can typically make changes to Lists and On-
demand Campaigns, but can only view Corporate Campaigns. For more information, see

your administrator.

Viewing and editing the Summary page

You can edit some, but not all, data on the Summary page for a List, On-demand Campaign,

or Corporate Campaign.

By default, the Summary section for a List, On-demand Campaign, or Corporate Campaign is

collapsed while in view mode. You can expand the section by clicking the header.

1. Open the List, On-demand Campaign, or Corporate Campaign to view the Summary

page.

2. Click the Editicon ().

Certain fields in the Summary page become editable. For example, fields that you can
typically edit are
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* Name

* Description

* Target Start Date
- Target End Date

« Other custom attributes that are created by your administrator

Typically, you cannot edit campaign codes or List Review data.
3. Edit data as necessary.

4. Click Save Changes.

The Edit Summary page closes, and the changes you made are reflected in the Summary

page.

Modifying the default contents of the Lists, On-
demand Campaigns, and Corporate Campaigns pages

You can change which Lists, On-demand Campaigns, or Corporate Campaigns are displayed

by default, as well as the columns included in the page.

When you select Lists, On-demand Campaigns, or Corporate Campaigns from the Local

Marketing menu, a page opens listing those objects.

1. While you are viewing the Lists, On-demand Campaigns, or Corporate Campaigns page,

click the Optionsicon ().
The Options dialog box opens.

2. In the Default drop-down list, select the set of Lists, On-demand Campaigns, or

Corporate Campaigns that you want shown by default when you open that page.

3. Determine which columns to show by selecting columns from the Available Columns
list and Selected Columns list and by using the horizontal arrow keys to move columns

between lists.
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Continue until the columns you want to display are all in the Selected Columns list.
4. Determine the order of columns by selecting columns in the Selected Columns list and
by using the vertical arrow keys to move columns up and down.

Continue until the columns are in the wanted order.

5. Click Save Changes.

The Lists, On-demand Campaigns, or Corporate Campaigns page changes to reflect your

selections. These changes remain in effect when you view the page later.

Modifying how Lists, On-demand Campaigns, and
Corporate Campaigns are displayed

You can change how Lists, On-demand Campaigns, or Corporate Campaigns are displayed

in multiple ways.

When you select Lists, On-demand Campaigns, or Corporate Campaigns from the
Navigation pane, a page opens listing those objects. The exact content depends on settings

that are defined by your administrator.

1. To change how objects are displayed, click the View icon ().
The Set View Options dialog box opens.
You can select:

- Timeline, to show the objects in a table format.
« Text Calendar, to show the objects as text entries in the calendar.

- Graphical Calendar, to show the objects as graphics in the calendar.
You also select the time period and color coding.

To return to the table view, click the object name in the Navigation pane.
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2. To sort the objects when you view as a table, click the name of the column to sort by.

You can click the name again to switch between ascending and descending order.

The number of objects may be too high for a single screen. If there are multiple screens,
you can click the screen number to view at the bottom of the table to see other objects.

Additionally, you can click Show All to fit all objects in one screen.

Viewing specific Lists, On-demand Campaigns, or
Corporate Campaigns

You can change which Lists, On-demand Campaigns, or Corporate Campaigns are displayed

in multiple ways.

When you select Lists, On-demand Campaigns, or Corporate Campaigns from the Local
Marketing, a page opens listing those objects. The exact content depends on settings that

are defined by your administrator.

1. To view all objects, click All ... at the top of the page.

All objects are displayed, as well as various filters for the display, for example, Last
Weeks ..., My ..., and Completed .... You can click a filter name to see only objects that

meet that criteria.
2. To view objects that meet certain criteria, click the Filter icon ( V).
The Search for dialog box opens.

3. Complete the search criteria that you need, then click Apply.

Opening and editing a List, On-demand Campaign, or
Corporate Campaign

You can open a List, On-demand Campaign, or Corporate Campaign from the Dashboard or

from the page listing that object.
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You must have the required permissions to open and edit a List, On-demand Campaign, or

Corporate Campaign. For more information, see your administrator.

After you open a List, On-demand Campaign, or Corporate Campaign, you can edit any of its
tabs.

1. Click the name of the List, On-demand Campaign, or Corporate Campaign.

The Summary tab for that object opens.

2. Click the name of the tab you want to edit, or remain on the Summary tab to edit it.
For example, if you edit the Workflow, you must open the Workflow tab before you click
Edit.

3. Near the top of the page, next to the object's name, click the Edit icon ( ).
4. Edit the contents of the tab as necessary.

5. Click Save Changes.

Edits that you made to the tab are saved.

List, On-demand Campaign, and Corporate Campaign
status

A List, On-demand Campaign, or Corporate Campaign each have a status.

The following states are:

* Not Started
* In Progress
« Paused

« Canceled

« Finished
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Simple Lists begin in the In Progress state.

Advanced Lists, On-demand Campaigns, and Corporate Campaigns, whether recurring or

not, begin in the Not Started state.

Changing the Lists, On-demand Campaigns, or Corporate
Campaign status

The status of the List, On-demand Campaign, or Corporate Campaign is shown in the home

page, the pages that list these objects, and in the Summary page.

To change the status, you must be viewing the List, On-demand Campaign, or Corporate

Campaign Summary page.

1. View the Summary page for the List, On-demand Campaign, or Corporate Campaign.

2. From the drop-down list, select the status to change to. Your options are Pause, Cancel,

or Finish.

A dialog box prompts you to add comments about the status change.

3. Add a comment and click Continue to close the dialog box.

The status of the List, On-demand Campaign, or Corporate Campaign changes to your

selection.

Printing a List, On-demand Campaign, or Corporate
Campaign

When you view a List, On-demand Campaign, or Corporate Campaign, you can print it on

your local printer.

1. Open the List, On-demand Campaign, or Corporate Campaign.

2. Click the Print icon ( = ), and select Print.
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The Print dialog box opens.

3. Complete the Print dialog box as needed.

Exporting a List, On-demand Campaign, or Corporate
Campaign

When you view a List, On-demand Campaign, or Corporate Campaign, you can export it to a

Microsoft Excel file.

1. Open the List, On-demand Campaign, or Corporate Campaign.

2. Click the Printicon ( = ), and select Export.

The File Download dialog box opens.

3. Click Open to open the Microsoft Excel file directly, or Save to save it to your computer.

If you choose to save it, you are prompted for the location on your computer.

Copying a List, On-demand Campaign, or Corporate
Campaign

When you view a List, On-demand Campaign, or Corporate Campaign, you can copy it to

create one with the same settings.
1. Open the List, On-demand Campaign, or Corporate Campaign.

2. Click the Copy icon ( ).

You are prompted to confirm the copy.

3. Click OK.
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The Summary page for the new List, On-demand Campaign, or Corporate Campaign

opens. The name of the new object is Copy of existing object nane.
4. Edit information in the Summary page as needed.

5. Click Save Changes.
The object closes.

6. To edit other pages in the List, On-demand Campaign, or Corporate Campaign, open,

and edit the object.

People and teams

In Collaborate, you assign work to teams or individual users.

You assign people or teams to units of work. You make assignments primarily through the
People tab on a project, on a List, On-demand Campaign, or Corporate Campaign. You can

also add and assign members, teams, and roles when you edit the workflow tab.

[5) Note: You might see only a subset of the people and teams available. Your organization

can limit the view of available resources.

People tab
Each Corporate Campaign contains its own People tab.

Use this screen to do the following activities.

« Manage the members of a Corporate Campaign.

« Edit the access level for a member.

* Replace a person in a role when a team memberuser becomes unavailable.

« Add or remove arole.

- Track team members or request recipients who are out of the office, their delegates,

and start dates. (Displays for project or request owners only.)
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A Corporate Campaign template can contain information about the functional roles for the
project. A template can reduce some of the work necessary to assign people or teams to
units of work within the Corporate Campaign.

[5) Note: By default, the People tab is available only for Corporate Campaigns. For
information about making it available for Lists or On-demand Campaigns, see the
Collaborate Administrator's Guide.

Managing Corporate Campaign members

Use the People tab of the Corporate Campaign to manage team members.

To manage Corporate Campaign members, complete the following steps.

1. Click Edit Member/Role Settings icon ( ™ ).Members.

The Select Team Members dialog box opens.

2. Do any of the following options:
« To add a person or team, select the name from the left pane of the dialog, and click
>>.
- To remove a person or team, select the name in the Select Team Members list box
and click <<.
« To change the role for a person or team, select the name in the Select Team

Members list box then click Up and Down to move it to the required role.
[5) Note: You cannot remove a user or team that is assigned to a task.

3. Click Save Changes.

The Select Team Members dialog box closes. The People tab becomes the active

window.

The changes that you make are reflected in the list of people and roles. For example, if you

added a creative lead, the screen would contain a line similar to the following example:
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Menber/ Access Level Rol e Emai | Address

P Pi casso (participant) Creative Lead ppi casso@ryconpany. com

Selecting team members for a Corporate Campaign

You can select other Collaborate users to participate in the Corporate Campaign.

You can assign participants as individuals, or by role. When you assign participants by role,
you can assign an entire group of field marketers to participate in a Corporate Campaign at

one time.

1. Open the Corporate Campaign.

2. Open the People tab.

3. Click the Edit Member/Role Settings icon ( ).

The Select Team Members dialog box opens.

4. To assign team members by role:
a. In the upper left of the dialog box, click Roles.
b. Select roles to assign to the Corporate Campaign from the list on the left.
c. Click the right-pointing arrow button to move the selected roles to the Selected

Team Members list on the right.

5. To assign individual users:
a. In the upper left of the dialog box, click Folders.
b. Expand the folder entries and select individuals to assign to the Corporate
Campaign from the list on the left.
c. Click the right-pointing arrow button to move the selected users to the Selected

Team Members list on the right.

6. Click Save Changes.
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You can now assign work for the Corporate Campaign by role.

Editing Corporate Campaign member access levels

You can control the access level other Collaborate users have to the Corporate Campaign.

You can specify whether users are Owners or Participants of the Corporate Campaign. The
specific privileges of Owners and Participants are determined by the user permissions that

are defined by the Collaborate administrator.

1. Open the Corporate Campaign.

2. Open the People tab.

3. Click the Edit Member/Role Settings icon ( ).

The Select Team Members dialog box opens.

4. To add users:
a. Expand the folder entries and select individuals to assign to the Corporate
Campaign from the list on the left.
b. Click the right-pointing arrow button to move the selected users to the Selected

Team Members list on the right.
5. To make a user an owner of the Corporate Campaign:
a. In the Selected Team Members list, select the user.

b. Click Up.

Repeat this step until the user appears under Owner in the list.
6. To make a user a participant in the Corporate Campaign:
a. In the Selected Team Members list, select the user.

b. Click Down.
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Repeat this step until the user appears under Participant in the list.

7. Click Save Changes.

Assigning work by role

You can add a user to any list of existing users that are assigned to a task or replace any

existing assigned users by clicking the Assign Work by Role icon.

Before completing this task, you should select team members for the Corporate Campaign.

1. Open the Corporate Campaign.

2. Open the People tab.

3. Click the Assign Work by Role icon ( F?‘: ).
A dialog box opens asking how you want to assign work. You can choose to do the
following.
 Add the new user to any existing users assigned to the task.

« Replace any existing assigned users with the new user.

4. Select append the new user to add the new user to any existing users assigned to the
task, or select replace the existing assignment to replace any existing assigned users

with the new user.

5. Click Apply.

Users are assigned to tasks as you specified.

6. Click Close.
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Attachments

You can include attachments with a List, On-demand Campaign, or Corporate Campaign.

These attachments provide information that is relevant to the campaign or List.

Corporate or field marketers might include the following as attachments, for example:

« Marketing messages for the initiative, including content for a mail campaign

« Data, such as customer names, generated after you run a List or On-demand Campaign

A List or On-demand Campaign owner or participant can include attachments only if the
corporate template developers include the Attachments tab in the List or On-demand

Campaign templates.

If the template developer includes attachments in the On-demand Campaign templates,

field marketers or corporate marketers can use the attachments to help fulfill campaigns.

Corporate marketers can also add attachments to an On-demand Campaign when the

Attachments tab is available through the On-demand Campaign template.

You can also include restricted attachments, such as upl oad_al | owedFi | eTypes and

upl oad_fi | eMaxSi ze. upl oad_al | owedFi | eTypes indicates the types of files that can be
uploaded in Collaborate, and upl oad_fi | eMaxSi ze indicates the limit on the maximum size
of the file that can be uploaded.

Adding an attachment to a List, On-demand Campaign, or
Corporate Campaign

If the template designer allowed it, when you view a List, On-demand Campaign, or

Corporate Campaign, you can add a file as an attachment.

The file that you add can come from your computer or a URL.

1. Open the List, On-demand Campaign, or Corporate Campaign.

2. Open the Attachments page.
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3. Click the Add Attachments icon ( = ).
4. In the File to Attach field, select From My Computer or URL.

5. In the field to the right, enter the path to the file.

If you selected From My Computer, you can click Browse to visually find the file on your

computer.
6. Optional: Add notes about the attachment.

7. Click Save Changes.

The file is attached to the List, On-demand Campaign, or Corporate Campaign.

Removing an attachment from a List, On-demand Campaign, or
Corporate Campaign

You can delete an attachment from a List, On-demand Campaign, or Corporate Campaign by

clicking the Remove button.

1. Open the List, On-demand Campaign, or Corporate Campaign.
2. Open the Attachments page.

3. In the row for the attachment to remove, click Remove.

You are prompted to confirm the deletion.

4. Click OK.

The file is no longer attached to the List, On-demand Campaign, or Corporate Campaign.
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Posting a message

When you view a List, On-demand Campaign, or Corporate Campaign, you can post a

message.

This message is associated with the List, On-demand Campaign, or Corporate Campaign
only. You have the option of having these messages sent to other Collaborate users.
You might need to post messages to convey to others that work on the List, On-demand

Campaign, or Corporate Campaign about important information about the project.

[5) Note: These messages are separate from alerts. An alert is created when you create a

message, but the alert does not contain the content of your message.

1. Open the List, On-demand Campaign, or Corporate Campaign.
2. While you view any page of the List, On-demand Campaign, or Corporate Campaign,

click the Communicate icon ( 3 ), then select Post a Message.

The Messages dialog box opens.
3. Enter your message in the message field.
4. Select the delivery option.

5. Click Post Message.

The message is then associated with the List, On-demand Campaign, or Corporate

Campaign. If indicated, it is also sent to users by email.

For those working with the List, On-demand Campaign, or Corporate Campaign, the number

next to the Communicate icon ( ), indicating that the new message is there.
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Reading messages
Other Collaborate users might attach messages to a List, On-demand Campaign, or

Corporate Campaign to pass on important information to other team members.

When you view the List, On-demand Campaign, or Corporate Campaign, you can view these
messages. These messages might also be sent to you by email, if the other users chose

this option.

1. Open the List, On-demand Campaign, or Corporate Campaign.
The number of messages that are associated with the List, On-demand Campaign,

3

or Corporate Campaign is indicated next to the Communicate icon ( ). In this

example, there is one message to read.

2. Click ¥ then select Read Messages.

The Messages dialog box opens, listing the messages that are associated with the List

On-demand Campaign, or Corporate Campaign.
[5) Note: You can post a new message from this dialog box.

3. Click Close when finished.

Deleting Lists, On-demand Campaigns, or Corporate
Campaigns

You must have the required permissions to delete a List, On-demand Campaign, or

Corporate Campaign.

Typically, field marketers cannot delete Corporate Campaigns. For more information, see

your administrator.
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1. From the Local Marketing menu, click Lists, On-demand Campaigns, or Corporate

Campaigns.

The page listing that object type opens.
[5) Note: To complete this task, you must view the objects in the Timeline view.

2. Check the field next to the name of one or more List, On-demand Campaign, or

Corporate Campaign you want to delete.

You can also check the field next to the Name column header at the top of the table to

select all currently displayed objects.

[5) Note: Checking this field selects only the objects that are currently displayed on
screen. If the list of objects spans multiple pages, those objects on other pages are not

selected.

3. Click the Delete icon (™ ).

You are prompted to confirm the deletion.

4. Click OK.

The selected objects are deleted.

Deleting a List, On-demand Campaign, or Corporate Campaign

You must have the required permissions to delete a List, On-demand Campaign, or

Corporate Campaign.

Typically, field marketers cannot delete Corporate Campaigns. For more information, see

your administrator.
While you view a List, On-demand Campaign, or Corporate Campaign, you can delete it.

[5) Note: You can also delete multiple Lists, On-demand Campaigns, or Corporate

Campaigns from the pages that list each of these objects.
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1. Open the List, On-demand Campaign, or Corporate Campaign.

2. Click the Delete icon (" ).

You are prompted to confirm the deletion.

3. Click OK to delete the object.

The List, On-demand Campaign, or Corporate Campaign is deleted.



Chapter 10. Alerts

You can use alerts to communicate information to specific people about the state of an
object or about an action that the user needs to take. Default alert subscriptions are set by
administrators, but can be overridden on a per-object basis by owners and participants of

the specific objects.

For workflow tasks, alerts are either brief or detailed.

Subscribing to alerts for an object

Users who are not administrators can override default settings within a plan, program,
project, or project requestList, On-demand Campaign, or Corporate Campaign. By overriding

the default, you can control the alerts that each object owner and participant receives.

If there are permissions that are configured for any of the tabs of a project or requestList,
On-demand Campaign, or Corporate Campaign, the system filters the alerts. For example,
alerts about attachments are not sent to users who do not have access to a project
Attachments tab.

1. Open the object for which you want to change alert subscriptions.

2. Click the Communicate icon ( "~ ) and select Subscribe to Alerts.
3. From the list of alerts, select the alert that you want to change. You can set or clear

alert subscriptions for each type of user: Owner or Participant. The possible entries are

as follows:
Option Description
Check mark The user receives the alert or alarm.
Blank The user does not receive the alert or
alarm.
n/a You did not specify team membersusers

for this access level (for example,
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Option

Description

Program Participant) when you

created the object. After you add team
membersusers with the corresponding
access level, you can set alerts for that

access level.

4. Click Accept to save your changes or Cancel to leave the alert settings as they were.

The Alerts page

When you receive an alert, go to the Alerts page to view it. Alerts are also sent to affected

users' email addresses (for each user that has a valid email address that is set up).

For a detailed list of events that might trigger an alert and for more information about

setting up alerts, see the Collaborate Administrator's Guide.

To view alerts, log in and click the Alerts icon (7). Clicking, or scrolling, over the alerts

icon shows a drop-down menu that separates the alerts for your installed applications. The

number of alerts is displayed to the left of each application name. After you choose which

application's alerts to view, the page displays the following information:

Table 12. Columns on the Alerts page

Column

Description

Page heading

The number of unread alerts, in parentheses, and the total number of
alerts

Check box

Select alerts for a specific action, for example, to mark a group of alerts

for deletion.

Select the box in the first line, next to the Message Text label, to select
all the alerts.

Message text

Text of the alert
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Column

Description

Date/Time

The time of the event that triggered the alert

You can perform the following actions from the Alerts page:

Table 13. Controls on the Alerts page

Link/Button

Description

Select the envelope icon next to an alert to mark the alert as read.

After you click the icon, the alert is disabled. Reselect the icon to mark

the alert as unread.

Alert title

Click the link in the alert to go to the object that is the subject of the

alert.

[5) Note: The Alerts page remains open while you view the information

in a separate window.

Pages

Click a page number to list the corresponding page of alerts.

Delete Selected

Click to delete the selected alerts.

Delete All

Click to delete all of your alerts.

Mark All as Read

Click to mark all your alerts as read, graying out each alert. A
confirmation screen is displayed to ensure that you want to mark all

alerts as read.

Mark All as If you have no unread alerts, click this link to mark all your alerts as
Unread unread.
Close Click to close the Alerts page.




Chapter 11. Templates

Templates are definitions of a List, On-demand Campaign, or Corporate Campaign that

corporate and field marketers use to create new objects.

As an administrator, you create templates and specify various parts of the object. For

example, among the many settings you determine for a Corporate Campaign template are:

« The associated flowchart in Campaign
« Team members
» Workflow

» Custom tabs

All Lists, On-demand Campaigns, and Corporate Campaigns are based on a template you
create, and the object inherits all settings from the template. Corporate or field marketers

can change the object's settings as needed.

Why use templates?

Templates are the required building blocks for Lists, On-demand Campaigns, and Corporate

Campaigns. Users cannot create these objects without templates.

By using templates, you help users save time because they do not have to configure
objects from the beginning; they need to only change settings that are specific to the List or

campaign.

For example, if your organization is running multiple Corporate Campaigns that have the
same team members and workflow, you can create a template with the right settings for
the team and workflow. Corporate marketers then create the Corporate Campaigns that are

based on this template, and do not have to configure the team members or workflow.

Template components

Templates are made up of other components that the administrator creates and manages.

Specifically, templates can include the following components.
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Component Description
Tabs Individual screens for the campaign. Tabs contain one or more forms.
Forms Subsection of a tab, containing fields.
Field Data element that is contained within a form. Each field has a specific

format; some fields, for example contain text, and others contain a set
of radio buttons. You can place fields into groups, and display them in

either a 1- or 2-column layout.

Data mapping

Mappings of data between Collaborate and Campaign.

Icons Small images that represent the object within the Collaborate user
interface.

Attachments Files or folders that are displayed on the Attachment tab of the List, On-
demand Campaign, or Corporate Campaign.

Custom links Hypertext links are displayed on selected tabs.

Workflow The set of stages and tasks that are displayed in the project's workflow

tab.

Template creation

You create a template by assembling existing components. As you set up your system, you

must create the other components before you can create templates.

Plan your templates

Before you begin building templates, you must analyze your organization's needs, then

decide on the templates you need.

For example, your organization might run three different types of On-demand Campaigns,

with different target selection criteria and different workflows. You most likely need three

different templates for these On-demand Campaigns.
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In addition to planning the number and types of templates, you must plan for the types
of objects you need in those templates. For example, the three On-demand Campaign
templates you need can share the Summary form, but require different Selection Criteria

forms and Workflows.

Plan template contents

After you plan the types of templates you need, you must determine the contents of those

templates; that is, you must decide which fields to include, and how to organize those fields.

You should capture this information about paper or in a spreadsheet, then use the Forms

Editor to define the tabs and fields you need.

For example, you might determine that an On-demand Campaign template must include a
field for the business unit that requests the campaign. You could list the requirements for

this field as follows:

Field Attribute Value
Internal Name Business Unit
Display Name Business Unit
Tab/grouping In the Summary tab, under the Collateral Request Info section

Input field type Single-Select

Possible values Retail Banking, Investment Services, Insurance, Credit Card Brochure,
or database table |Postcard, DataSheet, Intro Folder, White Paper, Print Ad, or a table
to retrieve values | name or column name where Collaborate should look up these values.

from

Required field/ Business Unit is a required field.
error message, if

missing

Help Tip Enter the business unit that requests this collateral piece.

As a best practice, create a similar table for each field you require before you begin creating
fields and tabs in the Forms Editor.




Corporate Marketer's Guide | 11 - Templates | 158

Before creating templates

Templates depend on the existence of other, lower-level components. Therefore, you must

set up the following objects before you set up templates:

1. Forms

2. Icons

3. Data Mapping
4. Workflows

5. Roles



Chapter 12. Building and managing templates

To create and manage templates and template components, you use the Template
Configuration page. Select Settings > Collaborate Settings. Then, click Template

Configuration.

The items and functions on the Template Configuration page are organized into two
sections, Template Configuration and Templates Components. There is also an option to

validate all templates.

Template Configuration section

The template configuration section of the Template Configuration page contains the
Templates link. This link opens a page that lists all the existing templates and template
folders that are organized by marketing object type. You use the links on that page to create,

delete, and organize templates, and to edit or export individual templates.

Validating templates

To run a utility that validates templates and forms and shows any validation errors, click

Validate Templates in the template configuration section.

Templates Components section
The templates components section of the page contains the following links.
Table 14. Links in the Templates Components section

Links in the Templates Components section

Link Description

Forms Opens the Form Definitions page, which lists the form definitions
and provides options for working with forms. The following

information shows for each form definition:

» Name of the form definition

Name of the form
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Link

Description

- List of templates that use the form

Click Create Form ( ~ ) to add a form.

Use the links and icons on the Form Definitions page to create,
import, enable, disable, delete, export, copy, publish, and manage
forms.

Workflow

Opens a list of separately saved workflow templates and shows

the following information.

* Name

« The number of stages and tasks in the workflow template
» When it was first created and last modified

« Whether it is enabled

You create workflow templates by saving the work that is done
on the Workflow tab of a projectList, On-demand Campaign, or
Corporate Campaign template or instance. You can use the links
on this list page to delete, enable/disable, import, or export a

workflow template.

Data Mapping

Opens a list of data maps and shows the following information.

« Data mapping file names
 Type: Campaign Data Mapping

Type: Campaign Metrics Import (if you have data maps from
previous versions, you might see other values)

« List of templates that use the mapping.

« Click Add () to add a data mapping file.

You can use the links on the Data Mapping page to add and

delete data mapping files.
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Link

Description

For more information, see Data Mapping Definitions (on page

185).

Icons

Opens a list of icons and shows the following information.

« lcon images; large and small

* lcon name

« List of templates that use the icon

« Delete link for deleting the icon (does not delete the file from

its location on disk)

Click Add ( ) to add anicon.
Click Add Icon to add an icon.

For more information, see Icons page (on page 187).

You can also transfer templates from one computer system to another using the export and

import features.

Templates Definition page

Use the links and commands on the Templates Definition page to work with

templatesassemble template components into project, templates.

The page is organized by object types and lists all the existing templates for these object

types. The sections, from top to bottom, are in the following order:

* Project templates

From this page, you can perform the following actions:

Action

Description

Edit

Click the template name to edit the template.
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Action

Description

Enable or disable

Click the link to toggle the state of the template, from Enabled to
Disabled and back.

When a template is enabled, you can use it to create an object.

Delete Click to delete a template from the system. The link is only
available for templates that do not have any objects that are
created from them.

Add Click Add template in the section of the list for the type of template
you want to add a template.

Click the Add icon () to add a template. From the icon's drop-
down list, select the type of object for which you want to create the
template.

Open folder Click the folder name to open the folder.

Jump to Folder

Click Jump to Folder to navigate to and open another template
folder.

Move items

Select the items to move, then click the Move Items icon ( ~ ) to
display a screen where you can choose a new folder for selected

items.

Select the items to move, then click Move Item(s) to. You then

select a template folder to which to move the template.

Add folder

Click Add Folder to create a template folder.

Click the Add Folder icon ( ) to create a template folder.
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Building a template

Before you create templates for objects Lists, On-demand Campaigns, and Corporate
Campaigns, determine whether you must add custom tabs. If you do, see the chapter on
the Forms Editor and use the procedures in that chapter to create forms for custom tabs or

metrics templates.

When the template components you need are available, create a template and assemble the
pieces. The steps to create a template are generally the same for each object type, with the

following exceptions..

* You can specify a workflow template for project templates and you can create

workflow templates from project templates

1. From the Settings menu, select Collaborate Settings.

The Administrative Settings screen opens.

2. Click Templates.

The Template Configuration Screen opens

3. Click the Add icon ().
4. Click Add Template in the section of the page in which you want to create a template.

5. From the icon's drop-down list, select the type of object for which you want to create a
template.

6. Use the information that is provided in the rest of this chapter to determine how to

complete each of the tabs for this template.

/\ Important: When you assemble a template, click Save Changes when you finish
editing a tab, before you navigate to another tab in the template. Otherwise, your

changes are not saved.
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Effects of template changes

When you edit a template, be aware you are changing all instances of objects that were

previously created from the template.

The exceptions are workflow and attachment folders. When you change the workflow
or metrics template for an object template, or add or remove an attachment folder, your
changes apply only to objects you create after the changes are made. Existing workflows

are not changed, nor are the attachment folders.

The exceptions are workflow, people, or an attachment. When you change the workflow
template, add or remove roles, or add or remove an attachment, your changes apply only
to objects you create after the changes are made. Existing workflows are not changed,
nor are roles or attachments for any existing Lists, On-demand Campaigns, or Corporate
Campaigns.

Template folders
You can create folders for templates in the Templates Definition screen.
You can move templates to any existing folders.

You can create folders for any template. You can move templates between any of the

folders for that type of template.

You can jump to any of the folders for a specific template type.

Editing a template

Template editing is spread across the following tabs. Depending on the object type, only a

subset of these tabs may be available.

« Properties: basic template properties, such as name and description.
« People: roles definition.
« Campaign: Campaign integration settings Project templates only, when

Collaborate-Campaign integration is enabled.(Corporate Campaign templates only)
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* Recurrence: recurrence settings.

 Workflow: workflow settings (not available for simple Lists).

« Tabs: Tab definitions; add additional forms and custom tabs.

- Attachments: files that are attached by default to all objects created from the template.

« Custom Links: custom links to web pages, and so on.

1. Click Settings > Collaborate Settings.

2. In the Administrative Settings screen, select Template Configuration (located under
Other Options).

3. Select Templates.

4. Select the name of the template you want to edit.

The Properties tab of the selected template is displayed. You can edit fields on any of

the object templates tabs; click a tab in the menu bar to navigate to it.

5. Click Save Changes to save any changes you made to the template.

Template Properties tab for defining the template

For all objects, the template Properties tab contains properties for you to set, such as name,

description, and security policies.

The properties that you set on this tab display on the Summary tab when you create a

project. More properties display on this tab for project templates.

Table 15. Properties for all templates

Property Description

Name The display name for the template, which displays on the Templates list

page.
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Property Description
Description Short description of the template. Displays on the template selection
page when users add a marketing object instanceList, On-demand
Campaign, or Corporate Campaign.
Icon Large and small icon images for the template. The large icon displays

when users create an instance that is based on this template. The
small icon displays next to the template name in the Templates list

page. Click Change Icon to import different image files.

Security Policies

List of security policies that determine which users have access to the

template.

[5) Note: Different fields display for project templates.

Template ID

Internal identifier for the template. Use lowercase alphanumeric values

only. Do not include accented or non-roman characters or spaces.

[5) Note:

« Template IDs must be unique across Collaborate.object type. For
example, you cannot have two project templates, both having an
identical ID, such as tradeshow. If you have two trade show project
templates, use a different ID for each one, such as tradeshow01

and tradeshow02.

Additionally, after you use a template ID, you cannot use it again,
even if you delete it.
* You can edit this field only until a user creates the first object

instance that is based on this template.

Default Name

The default name to give to an object instance.

You can leave this field blank.

ID Prefix

Prefix for the external ID of the object. For example, the ID for the first
project might be 1001.Each List, On-demand Campaign, and Corporate
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Property

Description

Campaign has an external ID assigned to it. For example, you enter an
ID Prefix of TRS for the Tradeshow On-demand Campaign template. The
first tradeshow On-demand Campaign that you create would then have
an ID of TRS1001.

You can set the ID prefix by template, to easily determine the template
on which an object is based. For example, you choose an ID Prefix of
TRS for the Tradeshow project template. The first tradeshow project

that you create would then have an ID of TRS1001.

ID Generation

Class

Java™ class to specify a numbering algorithm for objects. By default,

Collaborate assigns a sequential number to each object (project).

However, you can configure Collaborate to use an algorithm that you
define to set the external ID. If you choose this configuration option, the
ID Generation Class specifies the Java class that is used to generate
the code. You must edit this attribute only if you want to generate IDs

according to an algorithm other than the default.

To export metadata for an individual template, click Export Template at the top of this tab.

See Exporting a single template (on page 193).

In addition to the properties that apply to all templates, templates for projects contain the

following properties.

Table 16. Properties for project templates

Property

Description

Security Policy
Use Model

Specifies how a "use" security policy is determined when a project
request becomes a project. When the value of this field is User Security
Policy, the Use Security Policy field on this tab is disabled. The person
who creates a project or request from this template specifies the "use”
security policy when the item is created. When the value of this field is
Template Security Policy, the Use Security Policy field on this tab is

enabled and the template developer selects the "use" policy.
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Property

Description

View Security

Policies

Specifies the security policy that determines which users can select

this template when they create a project or request.

Use Security
Policy

Specifies the security policy that determines which users can access

the projects or requests after they are created.

Export Tab

Select the project tab to export when you export the Calendar. You can

choose the Summary tab or any custom tab.

When users export a Calendar, a link to the specified tab and the data
for the tab are included with the exported calendar data. Users can

click the link to view the data that is exported for the project.

Template People tab

The People tab of a template defines roles that are added to Lists, On-demand Campaigns,

or Corporate Campaigns that are created from this template.

You must define list definitions for roles before you add roles to a template.

To add a role, select a role from the drop-down list. The available values are populated from

the list definitions.

To delete a role, click Remove next to the role you need to delete.

[5) Note: You do not need to add roles here if they exist on the workflow template. Roles

that are defined in the workflow template are added to the People tab when an instance is

created.
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Template Recurrence tab

The Recurrence tab establishes properties for a recurring campaign. Recurring campaigns
reference a basic workflow; you can set up recurrence properties to define how many times
the basic workflow should recur.

Depending on permissions, users can modify recurrence properties when they create or
edit a Corporate Campaign, On-Demand Campaign, or List. If they do so, all tasks in the
workflow are replaced by new tasks, with dates that are calculated based on the new

recurrence properties.

This tab is displayed in both templates and in the actual instance of a Corporate Campaign,
On Demand Campaign, and List. When you create a template, you can access this tab only

after you create a Workflow template.

The Recurrence tab contains the following settings:

Property Description

Campaign Specifies whether the workflow used by the Corporate Campaign, On-

Workflow Type | Demand Campaign, or List contains a recurring stage. Options are:

» Nonrecurring

* Recurring

If you select Recurring, the properties on this tab are applied to the

stage in the Workflow that is marked for recurrence.

[5) Note: Recurrence properties that you set up here can apply to only
a single stage of a workflow.

Frequency Specifies the recurrence pattern. Options are:

Daily-Occurs on a daily basis. When you select Daily, you must specify
the number of days between each occurrence of the workflow or

workflow stage.
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Property

Description

Weekly-Occurs on a weekly basis. When you select Weekly, you must
specify the number of weeks between each occurrence of the workflow
or workflow stage. (To specify every other week, enter 2 for the number
of weeks between each occurrence.) You must also specify the day or

days of the week on which the occurrence should take place.

Monthly-Occurs on a monthly basis. When you select Monthly, you
must specify the number of months between each occurrence of
the workflow or workflow stage. You must also choose one of these

options:

« Each date of month-Choose this option if you want the occurrence
to take place on a specific date each month.

« Each day of week-Choose this option if you want to schedule the
occurrence to run on a specific day of a specific week each month.
For instance, if you want to run the campaign monthly, on the third

Thursday of each month, you should select this option.

Keep in mind that your calendar options apply to your recurrence
schedule; that is, the recurrence schedule is built using your settings for

valid working days.

Ending

Specifies the total number of occurrences of the workflow or workflow
stage. You can also choose to specify a date by which the recurrence

should end.

Permissions
to modify the
recurrences in
the instance

Allows you to specify the recurrence options that can be changed in

each Corporate Campaign, On-Demand Campaign, or List.

This field is displayed only in the Corporate Campaign, On Demand
Campaign, or List template; it is not displayed in the actual instance of

the Corporate Campaign, On-Demand Campaign, or List. Options are:

« All options-Users can change all recurrence options.
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Property Description

* No options-Users cannot change any recurrence options.
« All options but frequency-Users can change all options except
frequency.

Project template Workflow tab

The Workflow tab identifies and organizes tasks for a projectList, On-demand Campaign, or
Corporate Campaign. When you create a template, you can include data on its Workflow tab
to provide an initial workflow structure for each marketing object instance that users create.
To review and define a workflow on the template, you use a spreadsheet-style interface.
Users access a similar spreadsheet interface to update the supplied workflow as needed for
individual instances.

For more flexibility, the data on the Workflow tab in any template or any individual instance
can be saved as a separate workflow template component. Template components, which
can include metrics and forms in addition to workflows, make designing templates to meet
different needs more modular and efficient. Any workflow template component can be
imported into any projectList, On-demand Campaign, or Corporate Campaign type template

or instance.

Initially, the Workflow tab displays in view mode. To set up the stages, tasks, milestones,

dependencies, and other data that make up the workflow, you switch to editing mode.

[5) Note: When you design the workflow for a template, you can specify team member roles

to associate with each task. To do so, you must first define values on the Project Roles tab.

[5) Note: When you design the workflow for a template, you can specify team member roles
to associate with each task. To do so, you must first define values on the People tab. For

more information, see Template People tab (on page 168).

For detailed information about configuring a workflow, including options for scheduling,

calculating dates, and updating tasks, see the Collaborate User's Guide.
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Creating and editing workflow templates

The workflow that you create on the Workflow tab of any projectList, On-demand Campaign,
or Corporate Campaign template or instance can be saved as a workflow template. Then,
you can reuse the workflow in similar projectsLists, On-demand Campaigns, or Corporate

Campaigns.

1. In any projectList, On-demand Campaign, or Corporate Campaign template or instance,
select the Workflow tab.
You can start with a new template or instance, or select one that already has a defined

workflow.

2. For a new template or instance, change to edit mode. Set up the tasks, dependencies,
and values that you want the template to supply as a starting point for new
projectsLists, On-demand Campaigns, or Corporate Campaigns. For an existing

template or instance, review the workflow.

3. With the Workflow tab in view mode, click task names to review or define settings.

4. Click Save as Template ( ' ).
5. Enter a descriptive name for the template and click Continue.

6. Click Save. The workflow template displays on the Workflow Templates page, and can

be imported into any template or instance.

To edit a workflow template, open a projectList, On-demand Campaign, or Corporate
Campaign template and import the workflow template that you want to edit into its
Workflow tab.

Typically, you set up a new template for this purpose because importing a workflow
template overwrites any previously defined values. You can then edit the workflow and save

the workflow as a new template with the same or a different name.
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Importing workflow templates

You can import an existing workflow template into your projectList, On-demand Campaign,
or Corporate Campaign template. Then, you can customize the workflow template for your

new projectList, On-demand Campaign, or Corporate Campaign template.

Before importing a workflow template that references role data in list definitions, ensure
that the role data in the import and export environments is the same. For example, if you
export a workflow template, import the template into another environment, and then try to
change the template's role data in the import environment, the role data reverts to the data

that was exported.

1. Create the projectList, On-demand Campaign, or Corporate Campaign template.
If the workflow template you plan to use includes Project Roles, you do not need to

define them. The Project Roles are imported with the workflow template.

2. Select the Workflow tab.

3. With the Workflow tab in view mode, click Import Template ( ' ).

The system presents a warning displays that the import overwrites the existing

workflow.

4. Click OK.

A list of workflow templates opens.

5. Select a template from the list and click Import.

The Workflow tab displays the workflow tasks and stages from the workflow template.

Any roles that are referenced by task rows also display on the Project Roles tab.
6. With the Workflow tab in view mode, click tasks to configure approvers.

7. To modify or add stages or tasks, click Edit.
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Then, customize the workflow as necessary for the project template. Remember to

save your changes.

8. When the workflow is complete, click Save and Finish to return to view mode.

Adding workflow to templates

To set up a projectList, On-demand Campaign, or Corporate Campaign template that
includes workflow data, you create the template, specify team member roles, and then edit
the Workflow tab.

If the integration with Workflow Services is configured, you can use the Advanced Workflow

capabilities for workflows.

1. Select Settings > Collaborate Settings.

2. Click Templates.

3. Click Add Template ( ) and select a template type.
4. Locate the project template section and click Add Template.
5. Complete the fields in the Template Properties form and click Save Changes.

6. On the Project People tab, specify participant roles then click Save Changes.

7. Select the Workflow tab and click Edit ( ).

8. Select Enable for Advanced Workflow execution to enable Advanced Workflow

capabilities.

9. Add system and user tasks workflow and organize them into stages.

Remember to save frequently while you work.
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10. Edit task dependencies, define task scheduling and duration, and enter other values to
supply when users create instances from this template.

For more information, see the Collaborate User's Guide.

Remember to save frequently while you work.
11. When the workflow is complete, click Save and Finish. The tab returns to view mode.

12. To configure more information for each task, click the task name when the Workflow
tab is in view mode.
For workflow tasks, you can configure whether users can add attachments.

For list review tasks, you can configure the list display.

13. Click View > View as a process flowchart to display the workflow as a process

flowchart.

Template Campaign tab

You use this tab in a Corporate Campaign template to set up communication between

Collaborate and Campaign. This tab is not available for On-demand Campaigns and Lists.

The Campaign tab contains the following settings:

Property Description
Campaign The URL used to start Campaign. For example:
Service URL

http://engsvr1: 9001/ Canpai gn/ servi ces/ Canpai gnSer vi ces
Collaborate uses this value to access services provided by a Campaign

server when you create a linked campaign.

[5) Note: Enter a value here only if you are mapping data between

Collaborate and Campaign.

Campaign Data | The XML file that contains the data map for creating a Campaign

Mapping campaign from a Collaborate object instance.
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Property Description
Options A single check box, Use Campaign Code Generated by Campaign.
Check this box to force Campaign and Collaborate campaign codes to
match.
Partition ID The Partition ID identifies the partition of the Campaign instance that

contains the linked campaign.

The default value is parti ti onl, which is correct if Campaign is
installed to a single partition. If Campaign is installed on multiple

partitions, you can specify the partition to use for creating campaigns.

If you leave this field blank, Collaborate obtains the partition ID from the
def aul t Canpai gnPartiti on parameter under Platform > Configuration

> Collaborate.

Folder ID The folder ID where Campaign stores campaigns that are created from

within Collaborate.

This ID comes from the CampaignUA_Fol der system table. You must

set up this system table in Campaign before you define it here.

Template Tabs tab for customizing the user interface

Use this tab to add forms to the Summary tab, or to create custom tabs for the marketing

object types that support this feature.

For example, you want to collect information about the outside vendor that users plan to
contract with to get collateral printed. To do so, you create a form with an attribute for users
to select a printing company from a list of several vendors. You also include a text box for
users to enter the quoted price of each page of the collateral. You then use the Tabs tab in a

project template to add a custom tab and name it Printing.

© Tip: You cannot rename the standard tabs that display for object instances.
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When you configure security policies for your organization, you can configure custom

security permissions for these tabs.

Table 17. Fields for defining a new tab

Field

Description

Display Name

The display name for the new section on the Summary tab or the

new custom tab.

Page Style

» Select summary to add a form to the bottom of the Summary
tab. Use this option for forms that contain relatively few
attributes and forms that users need to see frequently.

« Select tab to create a custom tab specifically for the form. Use
this option for forms, or groups of forms, that require their own

page, as in the Printing tab example.

This option is not available for all template types.

Form

Select the form to add.

Visibility

Select Show in Wizard to display the new Summary section or
custom tab in the series of pages that display when users create
a marketing object. If you clear this option, the section or tab

displays only after users save the object.

For project templates only, select Show in Request if this new
Summary tab section or custom tab applies to both projects
and requests. If you clear this option, the section or custom tab

displays for projects only.

Adding tabs to templates

Add a tab or form to templates to collect information about the marketing object. You can

add more forms to the Summary tab. For some types of templates, you can add custom

tabs, on which you add forms.
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1. Add or edit the template then click its Tabs tab.

2. Click the Add a Tabicon ( ).
3. Click Add Tab.

4. Enter a descriptive name for the tab in the Display Name text box.

The name that you choose becomes the name of the tab that users see when they

create instances from this template.

5. Choose whether to show the form on the Summary tab or its own custom tab.

This option is not available for all template types.

6. Select a form from the Form list.

This list contains all the forms available in Collaborate, except for the TCS® (Target Cell

Spreadsheet) forms used by campaign projects.
[5) Note: For List templates, forms of type Campaign are not listed.

7. Select the visibility options for the tab.

This option is not available for all template types.

8. Click Save Changes to save the tab, Add a Tab icon ( ~ ) to add another tab.

Moving tabs and forms on templates

You can change the position on forms on tabs. You can also change the order of custom

tabs as you change and refine templates.

1. Edit the template then click its Tabs tab.

2. Click one of the following buttons after Move:
» Down to move a tab down. Moving a summary tab down places it lower on the

object's Summary page. Moving a separate tab down places it further to the right
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in the tab list. For example, if the tab was fourth in the list, moving it down once
makes it fifth.
« Up to move up a tab. Moves it up or forward one position.

[5) Note: Summary tabs must come before non-summary tabs.

3. Click one of the following buttons after Move.

« Down to move down the tab or form. Moving a form on the Summary tab down
places it lower on the object's Summary tab. Moving a custom tab down places
it further to the right in the tab list. For example, if the tab was fourth in the list,
moving it down once makes it fifth.

 Up to move up a tab. Moves it up or forward one position.

[5) Note: On the Summary tab, the standard form for instance properties must come

before any custom forms.

Deleting custom forms and tabs from templates

You might want to remove forms from tabs or custom tabs from templates. Consider
whether you want to change the template by deleting the form or create a new template. If

you delete a form or tab, data in existing object instances is lost.

/\ Important: Deleting a custom form or tab from a template also deletes it from all
existing object instances that are created from the template. Do not delete a custom form
or tab from a published template if users already created object instances from it. If you do,

datais lost.

1. Edit the template then click its Tabs tab.

2. Scroll to the section that defines the form or custom tab you want to remove and click

Delete (on the right side of the page).

The form or custom tab is removed from the object template.

3. Click OK.
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4. Click Save Changes.

Template Attachments tab for adding folders and files

Use this tab to manage attachments in your templates. You can add attachments and

folders for future attachments.

On this tab, you:

« Add one or more attachment folders so that users can add and organize attachments:
Click the Add a folder icon.

« Change the relative position of the folders on the tab: Click Up and Down to reorder
attachment folders.

« Delete folders: Click Delete next to the folder you want to remove. All attachments in
the folder are also deleted.

- Attach one or more files to the template, so that whenever an object is created from
the template, certain images and documents are attached by default. Click Add an
Attachment.

« Delete default attachments: Click Delete next to the file you want to remove.
To add folders and default attachment files:

1. Add or edit the template then click its Attachments tab.
2. Add at least one folder to the tab: Click the Add a folder icon and provide a Name.

3. To add an attachment, click Add an Attachment next to a folder.

The Upload Attachment dialog opens.
4. Enter the file path and name, or click Browse to locate the attachment.

5. Click Save to attach the file.

The attachment file displays in a list under its folder.
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6. On the Attachments tab, click Save Changes to save the new folder and its attachment.

Repeat these steps to add as many folders and attachments as needed.

Template Custom Links tab for accessing other

websites

Use this tab to create custom links that display on one or more tabs for the object instances

that are created from this template. For example, you might want to link to an application

that your organization uses to generate ID codes for collateral pieces or direct marketing

offers.

To add a custom link, click Add a Custom Link ( ~ ). For each link, you can add a parameter,

such as the query portion for a dynamic URL. To form the complete URL for the link,

Collaborate appends a question mark (?) to the end of the URL you supply and then adds

the parameter. To include a parameter, click Add a Parameter. More fields display for the

parameter.

This tab contains the following properties. When your work is complete, click Save

Changes.

Table 18. Properties for custom links

Property

Description

No. of links per

row

Specifies the number of links to display in a single horizontal line at the
bottom of the selected tab or tabs. The display number depends on the
width of the browser window. If blank, the links display continuously

and wrap onto more lines.

For example, you create 6 custom links to display on the Summary tab.

To organize the links into 3 rows with 2 links in each row, enter 2.

Display Name

Enter a name for the link. This value becomes the name of the link.

ID

Enter a unique internal ID for the custom link.
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Property

Description

Description

Enter some descriptive text for the link. This text is shown as a tip when

a user moves the cursor over the link.

VisibilityShow in
tab

URL Enter the fully qualified URL (including http://) of the website to open
when users click the link. The website opens in a new browser window.
Tab To define where this link displays to users, select one or more tabs. The

link displays at the bottom of every selected tab. You can select the
Summary tab and the custom tabs previously added to any template of

the same type.

Options

For project templates, you can make the link display for both requests
and projects that are created from the template, or only for projects.

Select Show in Request to display the link for both.

Custom link URLs can include a parameter. For example, the link can open one page for an

object that is Not Started, and another page for an object that is In Progress.

Table 19. Fields for custom link parameters

Property Description
Name Enter a name for the parameter.
Value Select a value from the list to define the type of object property to use.

Depending on your selection, another Value list can display to collect
more specification. The choice that you make determines the options

available from the subsequent list.

For example, if you select a value of <object type> Properties, a list
displays values including Target Start, Actual End, Security Policy, and

other relevant properties for the object.

You can add more than one custom link: Click Add a Custom Link to display a new set

of property fields. If you add more than one custom link, you can change their relative

positions: Click Up and Down to reorder the links.
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Workflow Templates page

You use the options on the Workflow Templates page to import, export, delete, enable, or

disable previously created and saved workflow templates.

The Workflow Templates page lists all the workflow templates and presents the following

information and functions.

Table 20. Options on the Workflow Templates page

Control Description
Name The name of the workflow template.
Stages / Tasks The number of stages and tasks in the workflow, which is separated

by a'/' character. For example, the value in this column for a workflow
that has 5 stages and 30 tasks is 5/ 30.

Created Date

Creation Date

The date the template was created.

Last Modified Date

Last Modify Date

The date of the most recent change that is made to the template.

Status Whether the template is enabled or disabled. When a workflow
template is created, its status is set to Enabled by default.
Export link Exports the workflow template to an XML file. You can then import it

into another Collaborate system.

Import Workflow

Template link

Importicon ( =)

Imports an XML file with workflow template data. Typically, you
create these files by exporting them from another Collaborate

system.

Enable/Disable
Workflow

Template link

Marks the selected templates as enabled or disabled. A disabled
workflow template cannot be imported into a projectList, On-demand

Campaign, or Corporate Campaign template.
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Control Description

Enable/Disable

Delete Selected Deletes the selected workflow templates.
Workflow

Template link

Deleteicon (")

Exporting workflow templates

You can export individual workflow templates to use in other List, On-demand Campaign, or
Corporate Campaign templates. In some cases, you might want to edit the exported XML

file and reimport the workflow template into Collaborate.

1. Select Settings > Collaborate Settings.

2. Click Template Configuration.

3. Click Workflow.

4. Click the Export link for the workflow you want to export.

5. Choose a location to save the XML file, and save it.

6. Open the file with a text or XML editor, make your changes, and then save the file.

7. Navigate back to the templates library (Settings > Collaborate Settings).

8. Click the Import Workflow Template icon ( = ) and browse to your edited XML file.
9. Click Import Workflow Template and browse to your edited XML file.

10. Name the file to differentiate it from the previous version.
For example, if you export Mar ket i ng Col | at er al , you can name your edited file

Mar keting Col | ateral 2.You can always rename the file later.
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11. Create a template and use the new workflow or open an existing template and replace

the old workflow template with the new one.

Data Mapping Definitions

The Data Mapping Definitions page maps data between campaign projects in Collaborate

and campaigns in Campaign, objects in Collaborate and campaigns in Campaign. Use the

Data Mapping link on the Template Configuration page to configure data mapping.

The Data Mapping Definitions page contains the following columns:

Column

Description

Name

The name of the data mapping file.

Type

Campaign Metrics Import: Maps Plan project metrics to Campaign

contact and response counts.
Campaign Data: Maps Collaborate attributes to Campaign attributes.

If you have map files from previous versions, you might see other

values in the Type column.

Used By

A list of templates that use the data map.

[5) Note: You cannot create a map file within Collaborate. Use a text or XML editor to create

and edit the necessary map files.

The Campaign Service URL field on the Campaign tab in a Corporate Campaign template

behaves as follows:

« If it is blank, data mapping does not occur.

« If it contains information, the value in the field is used to map data between Collaborate

and Campaign.
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Adding data mapping files

Use a text or XML editor to create or edit a data mapping file. After you have a data mapping
file, you add it to Collaborate.

1. Select Settings > Collaborate Settings.

2. Click Template Configuration > Data Mapping.

3. Click Add a data mapping ( ).

The Upload Data Mapping dialog box opens.
4. Enter a name for the data mapping file.
5. Browse to the XML file that defines the data mapping.

6. Click Continue.

Editing data mapping files

If you want to update a data mapping file, you must first edit the XML file, and then reload it
back into Collaborate.

1. Open the data mapping XML file in a text editor and make your changes.
2. Select Settings > Collaborate Settings.
3. Click Template Configuration > Data Mapping.

4. Click the file name that you are updating.

The Update Data Mapping dialog opens.
5. Select File, and browse to the XML file.

6. Click Continue.
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You are prompted to overwrite the existing file.

7. Click Save to overwrite the existing file with the newer version.

Icons page
On the Icons page, you review and add icon files. These icons display in various parts of

Collaborate user interface to identify a type of template or object instance.

Click the Icons link on the Template Configuration page (or Change Icons on the template
Summary tab) to manage the icons that identify templates and the objects that are created

from them.

The Icons page contains the following columns:

Column Description

Imagesimage A large and small image for each icon. Click the images to change the

files icon name or the image files.
Name The name of icon.
Used By A list of object templates that use this icon. You specify the icons that

are used by a template on the template Properties tab. See Template
Properties tab for defining the template (on page 165).

Delete A link to delete the icon image file. This link is only available for icons

that are not used in any templates.

Collaborate is installed with a set of default icons. You can choose from these icons, or add
icons that are customized for your organization. When you add your own custom icons, you

upload two file sizes for each icon:

« File image:Main icon: the large (46x54 pixels) image that displays when users create an

object instance. For example, the main icon displays next to each template in the List,
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On-demand Campaign, or Corporate Campaign template selector (the dialog box that
opens when users click Add for an object type).

« List icon image:List icon: the small (20x24 pixels) image that displays on the list page
next to an object instance. For example, the ProjectList, On-demand Campaign, or
Corporate Campaign list page contains the list icons for all of the projectsLists, On-

demand Campaigns, and Corporate Campaigns on the page.

The image files must be in JPEG, PNG, or GIF format.

Adding and editing icons

You can add or edit icons to use on templates.

1. Click Settings > Collaborate Settings > Template Configuration.

2. Click Icons.

3. To add anicon, click Add an Icon ( ~ ‘Add Icon.
To edit an icon, click the icon image (large or small).

4. Enter a Name for the type of template and object the icons identify, such as the name

of a type of projectList.

5. Upload the icon image files:
« To upload a main icon, under File Image enter a path and file name or click
Browse.
« To upload a list icon, under List Icon Image enter a path and file name or click

Browse.

To replace an existing file, you must select the check box next to the type of icon you

want to change.
6. Click Continue to load the files into Collaborate.

7. Click Save Changes to confirm the upload.
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The new or edited icon displays in the list.

Importing and exporting templates

The template import/export functionality allows you to:

« Export templates into a self-contained archive, and

« Import templates that were previously exported or saved to a self-contained archive.

Specifically, the export command downloads a ZIP archive to your computer; import

uploads a ZIP archive to the Collaborate server.

[5) Note: The Collaborate installation does not install the Unica example templates. If you

want to use the examples, you need to import them.

You can use the import and export commands to create a portable archive. For example,
you can export all of your templates from a test server after you verify that they work

correctly, then import them to a production server.

[5) Note: If you localized roles, they are exported/imported to/from the archive as well.

Importing templates

You can use the import button to import workflow templates that were created in the same
version of Collaborate that you are using. To import templates from an earlier version of

Collaborate, you must upgrade.

1. From the Settings menu, select Collaborate Settings.

2. Click Template Configuration.

3. Click the Import icon ( = ).Click Import.

The Import Templates dialog is displayed.
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4. Enter the path name of the template archive you are importing, or navigate to it using

the Browse button.

5. Select the template types to import. By default, all types are imported; clear any types

that you do not want to import.

6. In the Update Database section, choose which database scripts to run:
« Drop tables
« Create/Update tables
* Drop Lookup Tables
- Create/Update Lookup Tables

Checking all the boxes fully imports the template. However, you lose any data you had if

you are reimporting the same templates.

Checking all the boxes fully imports the template. However, if you are reimporting a
template and you drop the tables, you lose data in any existing object you created by
using the template. For example, if you reimport a campaign project template and drop
the tables, you lose any data that you entered in the TCS in any project that created by

using that template.

[5) Note: If you are concerned about overwriting data, you can examine the SQL script
files in the template archive to see the details, and create the necessary tables and

columns manually.

7. Click Continue to import the selected templates.

A summary page is displayed, detailing templates that are being imported, and any

warnings about current template files that are overwritten.

8. Click:
- Save Changes to import the templates, or

« Cancel to stop the import, and avoid overwriting any existing templates.

The system reads the template files and analyzes them, and reports any errors.
Imported templates are saved to the template database, and then all available

templates are reloaded from the database.
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[5) Note: The archives that contain the example templates are in the \ t ool s\ adni n
\ sanpl e_t enpl at es folder under your Collaborate installation. Use the archive for
your database type. (For example, use sanpl e_t enpl at esDB2 if you are using a DB2®

database.)

Template exporting

If you create or edit a group of templates on a development or test Collaborate server, you

can export them and then import them to a production server.

The template export feature in Collaborate allows you to export a group of templates or a
single template. In either case, the system creates a self-contained ZIP archive; you can use

this archive to import the templates to another Collaborate server.

Export creates separate SQL scripts. These separate scripts give you more control over
updating your database to work with the new templates when you import them. For
example, if you need to add a column here or there, you can run only the create/alter scripts,

so as not to needlessly delete tables and existing data.

The system generates the following script files (to use when you import the template

archive).

Table 21. Generated script files

File Description

create. sql Adds columns to existing tables, and creates new tables that are

needed for the templates.

creat el kup. sq| Adds columns to existing lookup tables, and creates new lookup tables

that are needed for the templates.

dr op. sql Deletes existing tables that are used by the templates. If you do not
mind possibly deleting data, you run this script before cr eat e. sqgl to

ensure that the database is set up correctly.
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File Description

dr opl kup. sql | Deletes existing lookup tables that are used by the templates. If
you do not mind possibly deleting data, you run this script before

creat el kup. sqgl to ensure that the database is set up correctly.

I nsert| kup. sq| Inserts data into the lookup tables. This script makes it possible to
save complete lookup tables (schema plus data) with the template

archive.

Exporting a group of templates

1. From the Settings menu, select Collaborate Settings.

2. Click Template Configuration.

3. Click the Exporticon ( ' ). Click Export.
The Export Templates dialog is displayed.

4. Select the template types to export. By default, all types are exported, so you can clear
any types that you do not want to export.

5. Select the Database Type from the pull-down list.
This determines the format of the SQL script files that are generated with the exported

templates.

6. Click:
« Continue to export the templates, or
« Cancel to stop the export; skip the remainder of the instructions.

7. Click Open or Save from the File Download dialog that is displayed.

The system creates a ZIP archive that contains the template and SQL script files.
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Exporting a single template

You can export a single template by clicking on the template you want to export and clicking

Export Template.

1

2.

. From the Settings menu, select Collaborate Settings.
Click Template Configuration.
. Click Templates.

. Click the name of the template to export.

The Properties tab displays.

. Click the Exporticon ( ' ).Click Export Template.

. Specify the Database Type of the system that receives the template metadata through
an import operation. The selected database type determines the format of the SQL

script files that are generated by the export process.

. Click Export to export the template, or Close to cancel the export; skip the remainder of
the instructions.
. On the File Download dialog, click Open or Save.

The system creates a compressed archive that contains the XML and SQL script files

for the selected template. Open or extract the archive file to view these files.

Template validation

Val

Col

idate your templates to check for errors.

laborate offers two types of predefined template validation checks:

» Database validation

« Attributes validation
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You can perform these validation checks on all of your templates at any time: on the
Template Configuration page, click Validate Templates. Information about these validation

checks follows.

Database validation

Database validation checks the validity of the database schema, and whether form

attributes match their data type in the database.

The system validates the database when you import, upgrade, and export templates. When

you export templates, only forms that are not linked to any template are validated.

When you import and upgrade, you can save templates even if they are invalid. You receive
a warning, but you can still save. However, when you add a form, you cannot save the form if

validation finds any errors.

Attribute validation
Collaborate has two types of validation to check for inconsistencies in forms.

When you save templates, the system validates the attributes. Collaborate has two types of

attribute validation: template attributes validation and template attribute type validation.

« Template attributes validation: Checks whether two or more form attributes point to the
same table column in both Summary tab and other, non-Summary tabs. If two or more
form attributes on different tabs point to the same table column, the system generates
an error message that describes the duplicated references.

» Templates attributes type validation: Checks whether two form columns, of different
types, from two templates point to same table column but with different type. If two or
more form attributes with different types point to the same table column, the system

generates an error that describes the inconsistency.

Templates attributes type validation checks whether two form columns from two templates
point to same table column but with different type (for example, one has a type of select

and the other is multi-select).



Corporate Marketer's Guide | 12 - Building and managing templates | 195

If two or more form attributes with different types point to the same table column, the

system generates an error that describes the inconsistency.



Chapter 13. Form Editor

The Form Editor creates and edits template components. Forms capture information about

the List, On-demand Campaign, or Corporate Campaign.

Forms are also the way a field marketer provides input to Campaign flowcharts.

Forms and attributes

Forms are collections of attributes. Attributes are used to collect data about Lists, On-

demand Campaigns, or Corporate Campaigns.

Forms define how the attributes are displayed for input by field marketers or corporate

marketers, and how the supplied values are stored in a database.

Forms and Campaign flowcharts

When a flowchart is published in Campaign, an associated form is automatically created in

Collaborate.

How forms and Campaign flowcharts relate

When a flowchart is published in Campaign, an associated form is automatically created in

Collaborate.
You use this form to capture and send information from Collaborate to Campaign.

By using the form in this way, you give field marketers control over certain aspects of On-

demand Campaigns and Lists.

The administrator does this by exposing parameters in Campaign, publishing the flowchart,

and then working with the automatically created form in Collaborate.

Campaign tasks

In Campaign, you must create flowcharts, expose parameters, and publish the flowcharts.

The typical workflow is as follows:
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. Create an input flowchart. The function of this flowchart is to create a list as an input to

Collaborate.

. For the input flowchart, expose the parameters that the field marketer should be able to

control, for example, gender and i ncone range.

. Create an output flowchart. The function of this flowchart is to hold the final list of

prospects for the On-demand Campaign.

. For the output flowchart, expose the parameters that the field marketer should be able

to control.

For example, you may want to field marketer to be able to customize the greeting and
the branch name.

. Publish both the input and output flowcharts.

Collaborate tasks

In Collaborate, you must create a template for an On-demand Campaign or List. The typical

workflow is as follows:

1. Run the SQL commands that are produced as part of the flowchart publishing process.

2. Edit the forms that were created when the flowcharts were published in Campaign.

3. On the Form Definitions screen, click Publish next to the form to make the form

0 N o o b~

available for use in templates.

. Create a template for an On-demand Campaign or List.

. Add two tabs to the template, one for the input form and one for the output form.
. Create an On-demand Campaign or List by using the new template.

. Generate the list.

. Run the On-demand Campaign or List.

Offer integration in On-demand Campaigns

Offer integration takes the assigned offers corporate marketers design in the flowchart in

Campaign and publishes it to Collaborate.
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While the corporate marketer designs the flowchart, they can assign offers to target cells.
When the field marketer runs a flowchart, the offers that are configured by the corporate
marketer are used. They also configure On-demand Campaign templates with the same

flowchart form, and after the template is ready, field marketers can use the template.

The field marketer is only able to choose between available offers for each cell, and the

offer selection is used during a flowchart execution in Campaign.

Field marketers are not able to view or select offers in an instance if offer integration is
turned off. If offer integration is turned on, the field marketer is able to view and select

offers in an instance.

To enable offers in On-demand Campaigns, in the Template Properties, select the Enable

Offer Selection check box. You are able to view your offers on the Form Definitions page.

[5) Note: By default, settings for offer integration at template level are disabled.

Republish flowchart after changes

A Campaign user can edit the process configuration of a mail list or call list by changing the
offer association with the target cells. Any additional offers or deletion of offers to a target
cell creates a version of the flowchart. If the flowchart is already published, Save & Finish
automatically republishes the flowchart. To notify Collaborate about the changes that are

made, the Campaign user saves and publishes the flowchart.

[5) Note: If the corporate marketer does not publish the updated flowchart form, the field

marketer receives an error message and is not able to run the flowchart.

After the changes are made, a new set of offers with their ID, name, description, and cell
information is shown in Collaborate. On the Form Definitions page, a merge notification
is displayed for that flowchart form. You receive alerts about form republishing or an
invalid form whenever a flowchart is republished. You can turn off the form valid/invalid
notifications from the Notification Subscription page. Opening the form asks the user to

merge with the latest list of offers.
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Delete offers

Campaign users might delete offers currently being used in flowcharts and in Collaborate

campaigns.

If a cell or offer that is used in the flowchart is updated or deleted from the campaign but
the user does not publish the flowchart, there is not a version mismatch for the flowchart.
While the system runs the flowcharts from Collaborate, if the system verifies that the offer

or cell that is used for execution is not correct, the flowchart execution fails.

Deleting offers behaves the same way as republishing flowcharts after changes are made.

Adding a form generated from Campaign

An associated form is automatically created in Collaborate when you publish a flowchart in

Campaign.

The underlying schema for the associated form does not yet exist in the Collaborate

database.

When you open such a form, you are presented with a screen where you can select the

database type and the action to take. You select one of the following:

* Preview SQL

Select this option to preview the SQL script that is used to create the database table for
the form.
* Run SQL Script

Select this option to run the SQL script to create the database table for the form.

You cannot work with the form unless the underlying schema exists. That is, before you can
edit or publish the form, someone must run the generated SQL commands to create the

tables to store the contents of the form.
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Invalid forms

Invalid forms are forms that are associated with a flowchart in Campaign that are modified
in Collaborate. Templates that use the form also become invalid. All flowchart run tasks that

use the form are canceled.
To make the form and templates that use it valid, and to be able to run flowchart run tasks

that use the form, you must run the SQL generated by the republished flowchart.

[5) Note: Invalid forms are marked with a red exclamation point. For example, if a form is
deleted when a flowchart is removed in Campaign, then the template is marked with a red

Cross.

For an upgraded system, if you want to use a user variable value with 450 characters for
existing values or tables, then you must manually alter the look-up table that you want to

use. Otherwise, the form is invalid.

Form Definitions page

The Forms Definition page uses links and commands to work with forms.

You access the Forms Definition page by selecting Settings > Collaborate Settings, then

clicking Template Configuration, then Forms.

The following table describes the links that are contained in the Forms Definition page:

Link Description

Name The name of the form. Click the name to open the form.

The Pencil icon after a form Name indicates that the form is

updated but the changes are not yet published.

The red exclamation mark indicates that a form is temporarily
invalid because the associated flowchart was republished from

Campaign.
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Link Description

The yellow triangle icon indicates that a form is republished
and there are changes that must be validated. You must run a
SQL script to validate the form.

Disable/Enable Link to toggle the form between Enabled and Disabled states.

- Disable: indicates that the form is Enabled. Click to
disable the form. Disabling the form prevents it from being
selected in a template.

« Enable: indicates that the form is Disabled. Click to
enable. Enabling a form allows it to be selected in a
template.

Used By The list of templates that currently use the form. Click a

template name to open that template.

Publish Click to publish the form.

Revert Click to discard all the changes that are made to the form and

revert it to the previous published version.

Delete Click to delete the form.

[5) Note: When you work with existing or newly published forms, Collaborate does not

support working with multiple browser windows or tabs with the same browser session.

Editing a form

You cannot edit a form in the Published state. You must first disable a published form to

edit it. The system continues to use the published version of the form while you are editing
it.

1. From the Settings menu, select Collaborate settings.

The Administrative Settings screen opens.
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2. Click Template Configuration.

The Template Configuration screen opens.

3. Click Forms.

The Form Definitions screen opens.

4. Make changes to the form as necessary.

If you are making multiple changes, you should periodically click Save Changes to save

the form and continue working.

5. When you are finished editing the form, click Save and Exit.

The Form Editor closes and you return to the Form Definitions screen.

You must now either republish or revert the form.

Reverting a form

You can revert a form to its last published state when you do not want to use recent

changes.

1. From the Settings menu, select Collaborate settings.

The Administrative Settings screen opens.

2. Click Template Configuration.

The Template Configuration screen opens.

3. Click Forms.

The Form Definitions screen opens.

Changed forms are indicated by a pencil icon ( ).

4. In the row for the modified form, click
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The form reverts to its last published state.

Deleting a form

You cannot delete a form that is referenced by a template.

1. From the Settings menu, select Collaborate settings.

The Administrative Settings screen opens.

2. Click Template Configuration.

The Template Configuration screen opens.

3. Click Forms.

The Form Definitions screen opens.

4. In the row for the form, click Delete.

You are prompted to confirm the deletion.

5. Click OK to delete the form.

The form is removed from the system.

Run History series

Collaborate produces a series of run histories, with each series conceptually tied to a

version of the form that is used to generate the results.

You view the run history series in the Run History drop-down menu in the Analysis tab. You
can see all revisions of the "run history series" from the Run History drop-down menu, with

the most recent one selected by default.
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Merge forms

When a flowchart is republished in Campaign, a new form is generated that must be merged
with the old one.

If the new flowchart shows a new parameter, you must merge the form to have that

parameter appear.

When you merge forms, note the following.

« For trivial flowchart changes (for example, when a lookup value for an existing user
variable is added), you do not need to take any action, other than republishing the

flowchart in Campaign. Collaborate recognizes these changes automatically.

[5) Note: However, in this example, you do have the option of not merging the change if
Collaborate uses different lookup values.

« If user variables are added to or deleted from the flowchart, the system alerts
marketers to the fact they need to revalidate their Lists and On-demand Campaigns.

« Some small changes that are made to a flowchart are ignored by Collaborate. For
example, changes to localized text such as labels, prompts, and option prompts are
ignored, because Collaborate users typically modify this data. Therefore, the system
does not overwrite these changes.

« If you show new user variables in a flowchart, and there are already objects in
Collaborate that use this flowchart, the system does not update the existing objects

with a default value for any new attributes.

Republishing a form

You must republish a form when its associated flowchart in Campaign changes.

1. From the Settings menu, select Collaborate settings.

The Administrative Settings screen opens.

2. Click Template Configuration.
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The Template Configuration screen opens.

3. Click Forms.
The Form Definitions screen opens.

Forms for which the associated flowchart has changed are indicated by a pencil icon

().

4. In the row for the modified form, click

5. Edit the form as necessary.

If you are making multiple changes, you should periodically click Save Changes to save

the form and continue working.

Field marketers should revalidate List and On-demand Campaign instances that use the

updated form.

Changing values displayed in forms

You can modify the display values contained in lookup tables that are used to present

choices in drop-down lists and selection tables that are contained in forms.

This allows you to display choices to corporate and field marketers in your organization in
their native language. You do this in the Form Editor by modifying individual elements of the

form.

1. Edit the form for which you want to modify how values are displayed.
2. Select an element.

3. Click Update Lookup Table.

The Update Lookup Table window opens.

4. Modify or translate the values in the table.
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For example, translate the values for Acquisition, Cross-selling, and Loyalty into a

language other than English.

Your changes replace the text that is displayed in the drop-down list or display table

that is populated by the lookup table.

[5) Note: This step fails if the lookup table is a view rather than a table.

5. Save and republish the form when you are finished.

Form status

There are three form status values: published, disabled, and enabled.

The follow table lists the possible form status values:

Status Value Description
Published The form is published and is available for use in templates. You cannot
edit a form in this state; you must first disable it.
A Published form is also Enabled.
Disabled A previously Published form was disabled so that it could be edited.
Enabled A previously Disabled form was enabled so that it could be used by
templates.

Form Editor page

The Forms Editor is a visual tool to help you lay out how you want pages to appear to

corporate and field marketers.

The form layout is displayed in the main area of the page. In this area, you can:

« Change the format and labels of the parameters.
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« Rearrange the layout by selecting and moving elements around the page.

« Add help text, default values, and mark parameters as required

Form Editor tabs

The Form Editor contains three tabs:

» Add an Element tab (on page 207) tab
» Element Properties tab (on page 212) tab

» Form Properties tab (on page 212) tab

Form Editor Commands

The Form Editor contains the following commands:

Command Description
Save Changes Saves the changes that are made to this form and continue
editing.
Save and Exit Saves the changes that are made to this form and returns the

user to the Form Definitions page.

Preview Opens a pop-up window that shows how the form looks to

corporate and field marketers.

Cancel Discards the non-saved changes and returns to the Form
Definitions page.

Add an Element tab

You can use the Add an Element tab of the Form Editor to select elements and drag them to

the appropriate location on the form.

In this tab, you work with two kinds of elements:

« General Elements, which include the Attribute Group Header

» Custom Elements



Corporate Marketer's Guide | 13 - Form Editor | 208

Attribute Group Header

You can add group headers to group the fields on the form. When you add a group header,
you specify its properties, then drag it onto the form. The following table describes the

properties for a group header:

Property Description
Group Internal Name Internal name of the group.
Group Display Name The label that is displayed to users on the form.
Description Descriptive text for the group; this is useful for determining the

purpose. This text is not displayed to users.

Show Group Heading Determines if the Group Display Name is shown on the form.

Group Layout Determines whether the group is displayed in one or two
columns. The value of this property sets the form layout until

the next group header on the form appears.

Custom Attributes
You can add custom attributes to the form.

You must first create custom attributes; the custom attributes you create are only available

on the current form.

The following custom attribute types are supported:

Type Description
Text - Single-Line Text field allowing users to enter a single line of text.
Text - Multi-Line Text field allowing users to enter multiple lines of text.
Single-Select Enumerated field, allowing a user to select one value from a
list. The choices are driven by a hardcoded list of options you
specify when creating the attribute.
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Type

Description

Single-Select Database

Same as the Single-Select attribute, except that the list of
choices is loaded from a database table that contains valid
items.

Single-Select Database

Attribute reference

Represents a single property (column) from a row in the lookup
table that is used by the parent SSDOR attribute.

Single-Select Database

Object reference

Extends the capability of an SSDB attribute, and provides users
the ability to create attributes that represent an entity with

multiple properties.

Multiple-Select Database

Same as the Single-Select Database attribute, except that you

can choose more than one item from the list.

Searchable Multiple-
Select Database

Extends the capability of the Multiple-Select Database attribute
by searching and selecting large values at one time.

Yes/No Boolean field, allowing a user to select one of two values. Can
appear in any of the following ways:
* Check box
* Drop-down list
« Radio button group
Date Select Date selector, where the user can enter a date or select a small
calendar from which to choose a date.
Integer Numeric field, allowing users to enter whole numbers.
Float Numeric field. You can specify the number of decimal places.
Money Numeric field, allowing users to enter currency values. The

system uses the localized currency symbol. You can specify

the precision (number of decimal places) for the field.
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Type Description

User-Select Creates a user selector, which is populated (from Platform)
with all system users. You can use this attribute where the

value should come from a list of users.

List of Lists Special type of multi-select attribute that displays all of the

lists of a field marketer in a multi-select format.

Hidden Used to pass the Li st | Dand User nanme properties from a

Campaign flowchart that is brought into Collaborate as a form.

You can also use this type to create a field to which you assign
a default value that you do not need users to see, for example,

a field that is used only for reporting.

[5) Note: Note the following:

« Each attribute type can be displayed with different controls as indicated by the icon in
the list.
 To create an attribute, click Add custom attributes on the Add an Element tab.

Creating an attribute

You can create custom attributes from the Add an Element tab of the Form Editor.

Before you can create any custom attributes for the form, the database schema for the
lookup tables must be created. You must do this outside of Collaborate with your database

management software.

1. Open the Form Editor for the form to which you want to add a custom attribute.
2. With the Add an Element tab open, click Add custom attributes.

3. Enter information in the Basic Options section as needed.

Fields that are marked with two red asterisks (**) are required.
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Additional Basic Options fields may be added, and the Display Options may change
based on the Attribute Type you select.

4. Set the Display Options as needed.

5. Click Save and Exit to save the attribute and return to the Form Editor.

The custom attribute is now available for use in this form.

[5) Note: Custom attributes that you create are only available in the form you are editing.

Creating a dependent attribute

Dependent attributes are attributes whose values are constrained by another attribute value.

You can make only the following attribute types dependent on other attributes:

« Single-Select - Database
» Multiple-Select - Database

If you want to have a field that displays all the cities for a selected state, you can make the

City attribute dependent upon the State attribute.

1. Create the parent attribute.

To continue with the example above, you would create the State attribute.
2. Place the parent attribute onto the form.

3. Create the child attribute.
For example, you would create the City attribute.

4. In the child attribute, check the field This field is dependent on the following column.

5. Select the database table column on which this attribute is dependent.

For example, you would select the State column.

6. Click Save and Exit to save the attribute and return to the form editor.
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The dependent custom attribute is now available for use in this form.

Deleting a custom attribute

You cannot delete custom attributes from forms that were created automatically from a

published Campaign flowchart.

1. In the Form Editor, select the custom attribute to delete from the Custom Attributes list.

The custom attribute to delete must be in this list, and not in the form itself.

2. Click Delete the selected attribute.

You are prompted to confirm the deletion.

3. Click OK.

The custom attribute is deleted.

4. Click Save Changes or Save and Exit to save the form with the deletion.

To cancel the deletion, click Cancel.

Element Properties tab

The Element Properties tab displays the properties of the currently selected element in the

Form Editor.

This tab is displayed when you select a single element in the form.

The values that are displayed in this tab are read-only. To edit the values, click Edit Custom
Attribute or Edit Attribute Group.

Form Properties tab

The Form Properties tab displays the properties that are related to the form.

Use this tab to view or edit the form properties. The tab contains the following information:
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Property Description

Form name The name of the form.

If the form is created automatically when a Campaign
flowchart is published, then the Flowchart name, ID, type are

displayed in read-only mode.

Form Description Description for the form.

Form Layout Radio button group that indicates whether the form has a one-

or two-column layout.

Properties for forms associated with Campaign flowcharts

If the form was created through the publishing of a Campaign flowchart, it has several
additional properties:

Property Description

Flowchart Type The flowchart type is either List or Campaign. On-demand
Campaigns and Lists typically have two tabs, one for input and
one for output. The input form should be designated as List,
and the output form should be designated as Campaign.

Flowchart Name The read-only name of the corresponding flowchart in
Campaign.

Flowchart Version The read-only version of the corresponding flowchart in
Campaign.

Removing a custom attribute from a form

You cannot remove custom attributes from forms that were created automatically from a
published Campaign flowchart.

1. In the Form Editor, select the element to delete.
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2. Click the Delete icon ().

The element is deleted from the form.

3. Click Save Changes or Save and Exit to save the form with the deletion.

To cancel the deletion, click Cancel.

Single Select Database

Single Select Database (SSDB) gives you the ability to create single select drop-down

attributes that are based on database tables.

You use single select databases when the underlying lookup table exhibits a key-value
relationship, and when one entity can be defined by one attribute and identified by one key

column.

You can select only one value at a time from a drop-down list or a radio button group,
depending on the display format that is selected while you create the attribute.

These tables must follow certain conventions.

1. The table names must have a prefix: Ikup.

2. It must have at least two columns: a key column and a column that stores display
values.

3. It is recommended to have the key column with a primary key constraint to avoid
repetition. Even if the lookup table that is pointed to is a view, ensure that the data in
the view has unique records.

4. It is recommended to not have more than three columns, where the third column refers
to the relationship with another SSDB attribute. Having more than three columns in the
lookup table renders the unused columns redundant.

5. Set the Sort-by Column field to the same column as the Display Column, so that your

Display Column values are visible when you select a column sort order.
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Single Select Database Object Reference

Single Select Database Object Reference (SSDOR) attributes extend the capability of a
single select database attribute, and provide users the ability to create attributes that

represent an entity with multiple properties.

Use the following conventions while you create a single select database object reference.

« Select the database lookup table that has numerous columns that are representing an
entity.

« Select the key column carefully as this table might have many columns, and based
on the value in the key column, the dependent attributes are populated. You need to
use a primary key constraint on this table, as data might keep growing in this table. If
the lookup table that is being pointed to is a view, ensure that the data in the view has
unique records that are identified by a unique key column.

« Choose the appropriate columns from the available ones to be displayed at the
instance level.

» SSDOR attributes are mandatory, but are not read-only.

The underlying database lookup table has multiple columns. An entire row in the lookup

table would represent the object (entity). The data in this table may keep on growing.
SSDOR attributes allow users to select the columns they would like to view so that they can

make more informed choices of the value to be selected at the outset.

[5) Note: Date/date time type fields are not supported in the SSDOR display column.

Single Select Database Attribute Reference

A Single Select Database Attribute Reference (SSDAR) represents a single property
(column) from a row in the lookup table that is used by the parent SSDOR attribute.

Selection of the lookup table is automatic, depending on the parent SSDOR selected. The

lookup table for an SSDAR always points to a parent lookup table.

Use the following conventions while you create SSDAR attributes.
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« The form must have at least one SSDOR attribute.

- Select the parent attribute carefully, and the lookup table is populated automatically.
« Give intuitive names to attributes to easily map the attribute to the database column.
- By default, SSDAR is a read-only attribute.

The parent lookup table must have a unique key in the table. The unique key must be made
the attribute key in the Form Editor as well. The parent key column should be present in the

child attribute lookup table.

Searchable Multiple-Select Database attribute

You can use the Searchable Multiple-Select Database (SMSDB) attribute along with the
existing Multiple-Select Database (MSDB) attribute.

There are several dependencies of this functionality.

1. If an SMSDB attribute is a child of an SSDB attribute, then the result is filtered on the
parent attribute's selected value.

2. All the dependency-related features of MSDB attribute behave the same way, in case of
this new type of attribute SMSDB.

The difference between MSDB and the SMSDB attribute would be the way user selects the

values.

1. SMSDB: Behaves as described by using the pop-up window.

2. MSDB: Existing multi-select box with no pop-up window. There is nho change in behavior.

You are able to convert any MSDB into SMSDB, and vice versa, by using the Form Editor
user interface. The values that are selected before the conversion are retained after the

conversion.
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Using the Searchable Multiple-Select Database attribute

You use the Searchable Multiple-Select Database attribute when you want to search and

select large values at one time. A long list is defined as more than 10 values.

1. To create an attribute for SMSDB, first select Multiple-Select - Database.

2. Then, select Searchable Multi-Select from the Attribute Type list in the Display Option
section of the Custom Attribute tab.

Other settings for SMSDB remain the same as the MSDB type of attribute.

The Sort-by column is used to decide order of rendering of search results and selected
values in view mode of the form tab.

3. After the form is created and published, and then used in a template and an instance of
the template that was created, the SMSDB field is displayed in edit mode of the form.

The user interface now has a read-only select box with a Select button.

The select box display values that were previously selected in the pop-up window.

The new SMSDB pop-up window has a text field and the Find button. When you type in the
text you want to search and click Find, the result is shown in the same pop-up window in the
left pane called Search Results.

The Clear button next to Find is disabled until the search is performed. When Clear is
enabled and clicked, then the search text field and Search Results select box are cleared,
and the Clear button is disabled until a new search is performed. The Clear button does not
clear the values that are selected in Selected Values. The search term finds all occurrences

of the value regardless of its position in the value and regardless of case.

You can select the values in the left bucket and move them to right bucket by using Add >>.
You can click a single item or Ctrl + click for multiple separated items. Click Shift + click for

a pick of sequential items. You can also use Add All >> to add all of the items at one time.

The Remove button can be used to remove items from the Selected Values list. When an

item is removed, it may not make sense to return it to the Search Result list. (It may not be
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part of the current valid Search Results for the last search). You can also use Remove All to

remove all of the Selected Values in one click.

You must click Accept and Close to save and confirm these values back in the parent form.

Then, all selected values are added in the read-only select box on the parent form.

After the values are saved in the parent form, and at a later point, if you open this pop-up

window again, the selected values show up in the right pane.



Chapter 14. Collaborate Reports

The following section includes the details on various reports that Unica Collaborate offers.

The Collaborate reports are grouped as follows.

« Corporate Marketer reports

- Field Marketer reports

Corporate Marketers reports

Contact List Acceptance by User

This report lists the number of marketers participating in the campaigns (by campaign) and
the number of items accepted, added, declined, waiting, and targeted. This report allows the

corporate users to track the participation and follow up with field marketers if warranted.

Corporate Campaign Performance Comparison with Revenue

This report lists the marketers who participate in corporate campaigns and their level of
participation in the form of how many of their contacts participated and revenue generated.
It enables the corporate users to analyze how valuable the contacts of a participating field

marketer have been and follow up if warranted.

List Profile

This report provides the profile details of Collaborate campaigns by a selected list and by

a report user’s selected parameter (age, age range, education level, income, etc). It also
allows the corporate users to analyze the contacts within a Campaign to see if there are any
concentrations by the selected demographic or it requires further analysis or perhaps the

list or logic requires to be changed.
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On-demand Campaign Performance Comparison with Revenue

This report compares all selected campaigns and the performance of those campaigns with
revenue metrics. It allows the corporate users to determine the success of each campaign

against other campaigns.

Corporate Campaign Participation Status

This report lists the field marketers who participated in corporate campaigns and their level
of participation (how many of their contacts). It also allows the users to see how many

contacts are included as a result of the participation by each field marketer.

On-demand Campaign Performance Over Time with Revenue

This report focuses on the on-demand campaigns in Collaborate. It includes revenue
metrics, whereever applicable and available. It allows the corporate marketers to analyze

the performance of the on-demand campaigns over a particular time frame.

On-demand Campaign Performance Over Time

This report focuses on the on-demand campaigns in Collaborate. It does not include
revenue metrics. It also allows the corporate marketers to analyze the performance of the

on-demand campaigns over a particular time frame.



Chapter 15. Managing flowcharts

Campaign flowcharts define the campaign logic. Each flowchart in a campaign performs a

sequence of actions on data that is stored in your customer databases or flat files.
During and after creating flowcharts, you can perform various management activities on

them. For example, you can test and run flowcharts, edit them, print them, and so on.

[5) Note: To work with flowcharts, you must have the appropriate permissions assigned by
an administrator.
More information

There are restrictions in the use of special characters in flowchart names. For details, see

Appendix A of the Campaign User's Guide.

Flowchart workspace overview

Use the flowchart workspace to design flowcharts for marketing campaigns.

You can open just one flowchart at a time. If you attempt to open another flowchart while
one is already open, you are prompted to save your changes. To open two flowcharts at the

same time, see Viewing two flowcharts side-by-side (on page 231).

If a flowchart is open for viewing but not editing, the toolbar contains a smaller set of

functions and the process palette does not appear. Click the pencil icon + to open a

flowchart for editing. The following figure shows a flowchart open for editing.
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The flowchart workspace consists of the following elements.

Table 22. Flowchart window elements

Flowchart window elements

Element Description
i Palette | The palette at the left side of the window contains processes that you use
(Edit to build your flowchart. It is visible only in Edit mode. Drag a process from
mode the palette to the workspace, then configure and connect processes in the
only) workspace.

By default, all process types are displayed. Click a category (List
generation, Segmentation, Response tracking, Data preparation) to view a

subset of processes.

To resize the palette, drag the edge of the palette area to widen or narrow it.
To hide or show the palette, click Hide palette (gray arrow) or Show palette.
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Element Description
i Main In View mode, you can view but not modify process boxes and you can
workspaceperform a limited set of operations. In Edit mode, you can configure
area and connect processes to determine the workflow and behavior of the

flowchart. Right-click any process box to open a menu of options.

To configure a process: Double-click it, or right-click it and choose Process

configuration.

To connect processes: Rest the cursor over a process box until four arrows

appear, then drag a connection arrow to another process box.

. Panning

Use the panning area to highlight the portion of the flowchart that you want

area to see. This visual representation of the workspace is useful when not all of
the process boxes fit on the screen at the same time.
. Flowchart| Use the buttons and menus in the toolbar to perform the actions that are
toolbar | described in the following table. Rest your cursor over each item to see

what it does. To open a menu, click its down-arrow . The toolbar icons and
available options depend on your permissions and whether the flowchart is

in View or Edit mode.

The flowchart toolbar contains the following icons and menu options.

Table 23. Flowchart toolbar icons

Flowchart toolbar icons

In View mode, click the pencil icon + to open a flowchart for editing.

Use the Run menu ¥ ¥ to perform test and production runs of a flowchart or to validate a

flowchart. You can also pause, continue, or stop a run.

In View mode

, use the Schedules menu " to view or schedule process runs at defined

intervals. For details, see the Platform Administrator's Guide.




Corporate Marketer's Guide | 15 - Managing flowcharts | 224

Flowchart toolbar icons

In View mode, click Delete to permanently delete the flowchart, if you are sure that you no

longer need this flowchart. Then confirm or cancel.

In View mode, click Add a flowchart = if you want to create a new flowchart in this

campaign.

In View mode, click Copy "=/ to duplicate a flowchart. You are asked for a destination

campaign.

In View mode, click Search flowcharts to search all flowcharts in all campaigns for any

object (process box, user database, offer, configuration details, and so on).

Click the Properties icon | to change the flowchart name or description.

Use the Options menu £-~ to work with custom macros, stored derived fields, stored
triggers, stored templates, stored table catalogs, user variables, user authorization lists,

and to match and link target cells.

Use the Log options menu "I to view flowchart logs, set logging options, enable or

disable logging, clear a log file, or change the path.

Click the Reports icon :!' to open the Cell specific reports dialog.

Use the Save options menu " Ito either Save and continue or Save and exit the

flowchart designer.

Click Cancel and discard changes \“** to close the flowchart without saving changes.

Click Print this item " to print a visual depiction of the flowchart. All process boxes in the

flowchart are included, regardless of whether they are selected.

Administrators can use the Admin menu " I'to perform actions on individual

flowcharts. See the Campaign Administrator's Guide for details.
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Flowchart toolbar icons

Use the Select All, Cut, Copy, Paste, and Delete icons to select and then
perform actions on the selected process boxes. Use Ctrl-click to add or remove process

boxes from the selection.

Use the Alignment menu [~ /1o align the selected process boxes. To select process
boxes for alignment, drag a selection box around the process boxes or use Ctrl-click to

add or remove boxes.

Use the Layout menu “Ito reposition all processes in a flowchart.

Click Fit contents - to resize the flowchart to fit in the workspace.

Use the Zoom icons to reset zoom, zoom out, or zoom in.

Use Hide all annotations or Show all annotations to hide or show all annotations
that were added to the flowchart. (To add, delete, show, or hide individual annotations,

right-click a process box in Edit mode.)

Use the Find process by name field to search for a process box by entering any portion of

the name.

Click the Help icon ' for a list of topics that explain how to work with flowcharts.

Creating flowcharts

You can add a flowchart to your campaign either by creating a new one, or copying an

existing one.

Copying an existing flowchart may save time because you can start with a completed

flowchart and modify it to meet your needs.

To facilitate constructing flowcharts, you can use pre-configured flowchart templates to
quickly create common campaign logic or process box sequences. You can also save and
reuse other objects such as queries, table catalogs, triggers, custom macros, user variables,

and definitions of derived fields.
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Flowchart design considerations

Be aware of the following considerations when you create flowcharts.

- Avoid cyclical dependencies. Be careful not to create cyclical dependencies among
processes. Consider this example of a cyclical dependency: (a) Your flowchart contains
a Select process whose output provides input to a Create Seg process. (b) The Create
Seg process generates a strategic segment as its output. (c) You use that segment as
input to the Select process. This situation results in an error when you try to run the
process.

« Applying global suppressions. If your organization uses the global suppression feature,
it is possible that a particular set of IDs might be automatically excluded from use in
target cells and campaigns. The flowchart log file indicates whether global suppression
is applied.

Creating flowcharts

Follow these instructions to add a flowchart to a marketing campaign. A flowchart

determines the campaign logic.

Each marketing campaign consists of at least one flowchart. A typical campaign has
a flowchart that selects customers or prospects who will receive offers and a separate

flowchart that tracks responses.

For example, a contact flowchart might select a set of customers that will be contacted by
phone or email. Another flowchart in the same campaign tracks responses to those offers.
After the offers are made, you use the response flowchart to record and analyze responses.
You can add multiple flowcharts to a campaign as you analyze and refine your results. More

complex campaigns can include many flowcharts to manage multiple offer streams.

Each flowchart is made up of processes. You configure and then connect processes to
perform data manipulation, create contact lists, and record contact and response tracking
for your campaign. By connecting a series of processes in a flowchart, then running that

flowchart, you define and implement your campaign.
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For example, a flowchart might include a Select process, which is connected to a Segment
process, which is connected to a Call List process. The Select process can be configured
to select all customers from your database who live in the northeast. The Segment process
can segment those customers into value tiers, such as Gold, Silver, Bronze. The Call List
process assigns offers, generates a contact list for a telemarketing campaign, and records

the results in the contact history.

The following procedure provides a quick overview of how to create a new flowchart and
add it to a campaign or a session. (Alternatively, you can copy an existing flowchart. You
can also use the template library to copy configured processes from one flowchart to

another.)

[5) Note: If you are creating an interactive flowchart, see the Interact documentation for

information.

1. Open a campaign or session.

2. Click Add flowchart
The Flowchart properties page opens.
3. Enter a flowchart name (required) and description (optional). For Flowchart type,

Standard batch flowchart is the only option unless you are a licensed user of Interact. If

you installed a licensed version of Interact, you can select Interactive flowchart.

[5) Note: Flowchart names have specific character restrictions. See the "Special
characters in Campaign object names" section in the Campaign documentation.

4. Click Save and edit flowchart.
The flowchart window opens. You see the process palette on the left, a toolbar at the
top, and a blank flowchart workspace.

5. Add a process to your flowchart by dragging a process box from the palette to the
workspace.

A flowchart typically begins with one or more Select or Audience processes to define

the customers or other marketable entities with which to work.
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6. Double-click a process in the workspace or right-click the process and choose Process

configuration. Then use the configuration dialog to specify how the process operates.

7. Connect the configured processes to determine the workflow of your campaign.

8. Use Save and continue =i/ frequently while you work.

9. When you are done, open the Save options menu and choose Save and exit

Adjusting flowchart layout

When you edit a flowchart, use the Layout menu to reposition all process boxes in a single
command to improve the appearance of the flowchart. This is a visual change which

does not affect the flow of data. The direction of the connection lines between processes
determines data flow.

1. Open a flowchart for editing.

2. Open the Layout menu “!and select an option:

« Tree: Organizes process boxes in a tree format. Useful when each process box has
a single input.

- Org chart: Organizes simple flowcharts and is effective for flowcharts with a single
input from the top.

- Circular: Arranges process boxes in a radial fashion. Useful for single connection-
based flowcharts that lead to one output.

« Hierarchical: Organizes process boxes in horizontal or vertical levels so that most
links flow uniformly in the same direction. This layout often provides the most
simple and visually straightforward choice.

3. To control whether connection lines appear in front of or behind process boxes, right-

click the workspace, open the View menu and check or clear Overlap connections.
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Copying flowcharts

Copying an existing flowchart to add to a campaign saves time because you can start with a

completed flowchart and modify it to meet your needs.

If the copied flowchart includes contact processes (Mail List or Call List) with target cells
linked to target cells that are defined in the target cell spreadsheet, new cell codes generate
for cells in the new copy of the flowchart so that duplicate cell codes do not occur. If the
target cells were defined in the flowchart, and if the Auto-generate cell code option in

the contact process is off, new cell codes are NOT generated when you paste the copied
flowchart.

[5) Note: When you copy a flowchart, if the flowchart logic uses derived fields that
reference cell codes from the old flowchart, the logic is broken in the new flowchart.

Process configuration settings are copied to the new flowchart. However, any temporary
files or tables that were created as a result of running the original flowchart are not copied

to the new flowchart.

Copying flowcharts

Copying an existing flowchart saves time because you can start with a completed flowchart

and modify it to meet your needs.

1. View the flowchart that you want to copy. For example, click a flowchart tab while you

view its campaign.
2. Click the Copy icon

3. In the Duplicate flowchart dialog, select the destination campaign into which you want
to copy the flowchart.

4. Click Accept this location.
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[5) Note: You can also double-click a folder to select and accept the location in one

step.

The flowchart is copied to the campaign that you selected.

Process configuration settings are copied to the new flowchart. However, any temporary
files or tables that were created as a result of running the original flowchart are not copied
to the new flowchart.

If the copied flowchart includes contact processes (Mail list or Call list) with target cells
that are linked to a target cell spreadsheet, new cell codes are generated for cells in the new
flowchart so that duplicate cell codes do not occur. If the target cells were defined in the
flowchart, and if the Auto-generate cell code option in the contact process is off, new cell

codes are NOT generated for the new flowchart.

[5) Note: If the flowchart logic uses derived fields that reference cell codes from the old

flowchart, the logic does not carry over to the new flowchart.

Viewing flowcharts in Read-Only mode

If you have View permissions for a flowchart, you can open it in Read-Only mode to see
which processes are used and how they are connected. However, you cannot open process

configuration dialogs or make any changes.

1. Choose Campaign > Campaigns.
2. Use one of the following methods to open a flowchart.
* Click View a tab = next to the campaign name, and select a flowchart from the
menu.
 Open the campaign, then click the flowchart tab.
« Open the campaign's Analysis tab, then click the name of the flowchart that you

want to view.
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If you want to see more details of the flowchart, such as how the processes are configured,

you must open the flowchart for reviewing or editing: Click the Edit icon < in the flowchart

toolbar. Your permissions determine whether the flowchart opens in review or edit mode.

To view a flowchart

You can view a flowchart in three ways:

« On the Campaigns page, click the View a tab icon next to the campaign and select the
flowchart you want to view from the menu.

« Open the flowchart tab directly from the campaign.

 Open the campaign's Analysis tab, then click the flowchart name from the list of

flowcharts.

To zoom in and out

Click the Zoom In and Zoom Out icons.

Viewing two flowcharts side-by-side

Some campaign designers prefer to view two flowcharts side-by-side when developing
new flowcharts. When using Internet Explorer, you must use File > New Session to open

additional browser windows.

Do not use any other method to open multiple browser sessions. For example, do not use
a new tab; do not open another browser session from the Start menu; and do not use File >
New Window. Using these methods can confuse or corrupt information that is displayed in

Campaign.

[5) Note: When using the method below, you cannot copy processes from one flowchart to
another. To copy configured processes across flowcharts, use the template library options

available on the right-click command menu.

1. Open Internet Explorer.
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2. Log in to the HCL Unica Suite and navigate to a Campaign flowchart in view mode only.

3. In the browser window that you opened in Step 1, select File > New Session in the

Internet Explorer menu bar.

A new Internet Explorer instance opens.

4. In the new browser window, log in to the HCL Unica suite as the same or a different

user, and navigate to a Campaign flowchart in view mode only.

1 Remember: You must disable any pop-up blockers in your browser or browser add-

ons, such as toolbars. Pop-up blockers prevent the flowchart window from opening.

Reviewing flowcharts

Depending on your permissions, you might be allowed to review, but not edit, flowcharts.
Reviewing a flowchart means you can look at process configurations and make changes,
but you cannot save any changes or perform production runs. The flowchart auto-save
option is disabled and cannot be enabled. To save changes to a flowchart, you must have

Edit permissions.

If you are allowed to review but not edit flowcharts, you can verify a flowchart's contents

without inadvertently changing the flowchart.
You open a flowchart in Review mode the same way as you open a flowchart in Edit mode.

Your permissions ensure that you can only access flowcharts in Review mode if you do not

also have Edit permissions.

Follow these steps to review a flowchart.

1. Use one of the following methods to open a flowchart:
- On the Campaigns page, Edit a tab <" next to the campaign, and select a flowchart
from the menu.
 Open a campaign, click the flowchart tab, then click Edit + in the flowchart

toolbar.
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« Open the campaign's Analysis tab, click the flowchart link, then click Edit
A message indicates that the flowchart is in review mode and that any changes you
make cannot be saved. The page header says "Reviewing" and only the Cancel option is

visible.

2. You can perform the following actions in Review mode:
« Save processes as a template.
« Save the flowchart as a template.
 Modify the flowchart (but you cannot save your changes).

« Perform test runs, if you have the appropriate permissions.

/\ Important. Even in Review mode, test runs can write output and execute triggers.
Also, if you have the appropriate permissions, you can edit custom macros and triggers

in the flowchart, and thus might change the flowchart.

To review the processes in a flowchart

[5) Note: You open a flowchart in Review mode in the same way as you open a flowchart
in Edit mode. Your permissions settings automatically ensure that you can only access

flowcharts in Review mode if you do not also have Edit permissions.

You can open a flowchart for reviewing in several ways:

 On the Campaigns page, click the Edit a tab icon next to the campaign and select the
flowchart you want to review from the menu.
 Open the campaign, then click the flowchart tab. On the flowchart page, click the Edit

icon.

You can also press Ctrl and click the flowchart tab to open the flowchart directly in
Review mode.

« Open the campaign's Analysis tab, click the link to the flowchart you want to review,
then click the Edit icon.

On the Analysis tab, you can also press Ctrl and click the flowchart link to open the

flowchart directly in Review mode.
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When you enter a flowchart in Review mode, you see a message indicating that the
flowchart is in review mode and that any changes you make cannot be saved. The page

header indicates "Reviewing", and only the Cancel option is visible.

Editing flowcharts

Open a flowchart for editing to make changes to it. For example, you can add or remove

processes, reconfigure existing processes, or change the flowchart name and description.

1. Choose Campaign > Campaigns.

[5) Note: If your flowchart is in a session, adapt these instructions by choosing

Campaign > Sessions to open a flowchart from a session.

2. On the All campaigns page, find the campaign that contains the flowchart you want to
open. The campaign might be listed on the page or it might be in a folder. If you can't

locate it, use the Search flowcharts link to search for it.

3. After locating the campaign that contains your flowchart, click the Edit a tab icon

next to a campaign, and click the name of a flowchart from the menu.

If you try to edit a flowchart that is already being edited by someone else, Campaign

warns you that the flowchart is open by another user.

/\ Important: If you continue opening the flowchart, the other user's changes are
immediately and permanently lost. To prevent the loss of work, do not continue opening

the flowchart without first checking with the other user.

4. Make changes to the flowchart, just as you would when creating a flowchart. For
example, double-click a process to reconfigure it, or drag a new process from the

palette to the workspace.

5. To change the flowchart name, description, or type, click the Properties icon =/ in the

toolbar.
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[5) Note: Flowchart names have specific character restrictions. See Special characters

not supported (on page ).

[5) Note: Avoid renaming a flowchart that is using the Scheduler because
scheduled tasks rely on the flowchart name. For more information, see the Platform

Administrator's Guide.

6. Click Save and continue =i/ as you work. When you are done, open the Save options

menu and choose Save and exit

Opening a flowchart for editing

To change a flowchart, you must open it in Edit mode.

1. Use one of the following methods to open a flowchart for editing:
« On the Campaigns page, click the Edit a tab icon " next to the campaign, and
select the flowchart from the menu.
« Open the campaign, then click the flowchart tab. On the flowchart page, click the

Edit icon
You can also press Ctrl and click the flowchart tab to open the flowchart directly in

Edit mode.
« Open the campaign's Analysis tab, click the link to the flowchart you want to edit,

then click the Edit icon

You can also press Ctrl and click the flowchart name to open the flowchart directly

in Edit mode.

2. If you try to edit a flowchart that is already being edited by someone else, Campaign

warns you that the flowchart is open by another user.

/\ Important: If you continue opening the flowchart, the other user's changes are
immediately and permanently lost. To prevent the loss of work, do not continue opening

the flowchart without first checking with the other user.


unique_256
unique_256
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Editing a flowchart's properties

To change the name or description for a flowchart, you edit the flowchart's properties.
1. Open the flowchart for editing.

2. Click Properties ' in the Flowchart toolbar.

The Edit Flowchart Properties page opens.
3. Modify the flowchart name or description.

[5) Note: Flowchart names have specific character restrictions. See the "Special

characters in Campaign object names" section in the Campaign documentation.

4. Click Save Changes.

The modified flowchart details are saved.

Flowchart validation

You can use the Validate Flowchart feature to check the validity of a flowchart at any time

except when the flowchart is running.

Validation performs the following checks for a flowchart:

« Processes in the flowchart are configured.

« Cell codes are unique in the flowchart, if the AllowDuplicateCellCodes configuration
parameter is set to No. If this parameter is set to Yes, duplicate cell codes in flowcharts
are allowed.

« Cell names are unique in the flowchart.

« Offers and offer lists that are referenced by contact processes are valid (have not been
retired or deleted). Offer lists that are referenced but are empty generate warnings, not

errors.
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« Cells that were linked to a top-down entry from the target cell spreadsheet are still
connected.

The validation tool reports the first error found in the flowchart. You might need to run the
validation tool several times in succession (after correcting each displayed error) to ensure
that you have fixed all errors.

[5) Note: A best practice is to run validation on flowcharts before doing a production run.
This is especially important if you are running scheduled flowcharts; using batch mode; or

you are not planning to actively monitor the run.

Validating flowcharts

When you validate a flowchart, each process is checked for errors. Each error that is found
displays in succession so you can view and correct each one. A best practice is to run
validation on flowcharts before you do a production run. This is especially important if you
are running scheduled flowcharts; using batch mode; or you are not planning to actively
monitor the run.

Use the Validate flowchart feature to check the validity of a flowchart before you do a

production run. Validation performs the following checks for a flowchart:

« Processes in the flowchart are configured.

« Cell codes are unique in the flowchart, if the AllowDuplicateCellCodes configuration
parameter is set to No. If this parameter is set to Yes, duplicate cell codes in flowcharts
are allowed.

« Cell names are unique in the flowchart.

« Offers and offer lists that are referenced by contact processes are valid (have not been
retired or deleted). Offer lists that are referenced but are empty generate warnings, not
errors.

« Cells that were linked to a top-down entry from the target cell spreadsheet are still

connected.
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The validation tool reports the first error found in the flowchart. You might need to run the
validation tool several times in succession (after correcting each displayed error) to ensure

that you have fixed all errors.

1. On a flowchart page in Edit mode, open the Run menu ¥ ¥ and select Validate

flowchart.
Campaign checks your flowchart.

2. If errors exist, a message displays the first error that was found. As you correct each

error and rerun the validation, any remaining errors display successively.

Test runs for flowcharts

You can conduct a test run on a flowchart or branch if you do not want to output data or

update any tables or files.

When you conduct a test run on a flowchart or a branch, be aware of the following.

« Triggers run on completion of both test and production runs.
« Global suppression is applied when testing processes, branches, or flowcharts.
* The option Advanced Settings > Test Run Settings > Enable Output determines

whether output is generated during test runs.

Conduct test runs on processes and branches as you are building flowcharts, so that you
can troubleshoot errors as they occur. Remember to save each flowchart before you run or
test it.

Doing a test run of a process, branch, or flowchart
Conduct test runs as you build a flowchart so that you can troubleshoot errors as they

occur. You can then view a report of any errors in the flowchart.

Always save an edited flowchart before you do a test run. When you do a test run, be aware

of the following:



Corporate Marketer's Guide | 15 - Managing flowcharts | 239

« Test runs do not update any tables or files. However, triggers run on completion of test
runs and global suppression is applied.

 The option Advanced settings > Test run settings > Enable output determines whether
output is generated during test runs.

» When you test run a data manipulation process (Select, Merge, Extract, Audience), you
can limit the number of records. Use the Limit output cell size option on the Cell Size
Limit tab in the process configuration dialog.

« Results from a previous test run are lost.

« If a process requires data from an upstream process, you might have to run the

upstream process first so that its data is available to the downstream process.
1. Open a flowchart in Edit mode.

2. To test run a process or branch, right-click a process, open the Run menu ¥~ and

select Test run selected process or Test run selected branch.

3. To test run the entire flowchart, open the Run menu ¥ * in the toolbar and select Test
run flowchart.

The process, branch, or flowchart runs in test mode. Each process that runs
successfully displays a green check mark. If there are errors, the process displays a red
IIXII.

4. If you want to pause or stop the run, right-click a process box and select Pause or Stop

from the Run menu.

5. Use one of the Save options in the toolbar. If you click Save and exit before the
flowchart finishes the test run, the flowchart continues to run and is saved when it
finishes. If anyone reopens the flowchart while it is still running, any changes made to

the flowchart are lost. For this reason, always save a flowchart before you run it.

6. To determine if there were any errors in the run, click the Analysis tab and view the

Campaign flowchart status summary report.
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Testing a flowchart branch

When you test a flowchart branch, data is not written to any tables. If the run detects errors,

you can correct any processes that have errors.

1. On a flowchart page in Edit mode, click a process on the branch you want to test.

2. Open the Run menu ¥ * and select Test Run Selected Branch.

The flowchart runs in test mode. Data is not written to any tables.

Each process that runs successfully displays a green check mark. If there are errors, the

process displays a red "X".

Testing and running flowcharts

You can do a test or production run on an entire flowchart, a branch, or an individual process
in the flowchart. You can also validate flowcharts. For best results, conduct test runs and
perform validation as you build a flowchart, so that you can troubleshoot errors as they
occur. Be sure to save each flowchart before you do a test or production run and before you

perform validation.

/\ Important: For flowcharts that contain contact processes, each production run of a
flowchart can generate contact history only once. To generate multiple contacts from the

same list of IDs, snapshot out the list of IDs and read from the list for each flowchart run.

[5) Note: Users with Administrative privileges can access the Monitoring page, which
displays all running flowcharts and their status. The Monitoring page also provides controls

to suspend, resume, or stop flowchart runs.

Doing a production run of a flowchart

When you do a production run of a flowchart, the data that it generates is saved in system

tables. After you run and save the flowchart, you can view the results of the run in reports.
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Do a production run after you save, validate, and do a test run. A production run writes to the

history tables.

The contact processes, such as Mail list and Call list, write entries into Contact History.
Each production run can generate contact history only once. Contact processes that already
ran for that production run can be rerun only if the contact history from the current run is
first deleted. To generate multiple contacts from the same list of IDs, snapshot the list of

IDs and read from the list for each flowchart run.
Triggers run on completion of a production run.

After initiating a run, users with Administrative privileges can access the Monitoring page,

which displays all running flowcharts and their status.

1. Save the flowchart before you run it.

2. If you are viewing a flowchart, open the Run menu [ ~ and select Run.

If you are editing a flowchart, open the Run menu ¥~ and select Save and run

flowchart.

3. To run a process or branch, right-click a process, open the Run menu ¥~ and select

Save and run selected process or Save and run selected branch.

[5) Note: Running only a process or a branch of a flowchart does not increment the
Run ID of a flowchart. When you run only a process or a branch, if contact history
records exist, you are prompted to choose run history options before you can proceed.
The Run history options dialog appears only when you run a branch or process that
previously generated contact history for the current Run ID. You can either append

information to contact history or replace existing contact history for the Run ID.

4. To run the entire flowchart, open the Run menu ¥ * in the toolbar and select Save and

run flowchart.

If the flowchart has already run, you are asked to confirm the run.
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The process, branch, or flowchart runs in production mode. Data from the run is saved
to the appropriate system tables. Each process that runs successfully displays a green

check mark. If there are errors, the process displays a red "X".

5. If you want to pause or stop the run, right-click a process box, open the Run menu and

select Pause or Stop.

6. Use one of the Save options in the toolbar. If you click Save and exit before the
flowchart finishes the run, the flowchart continues to run and is saved when it finishes.
If anyone reopens the flowchart while it is still running, any changes made to the

flowchart are lost.
You must save the flowchart after it runs to view the results of the run in any reports.

After you save the flowchart, results of repeated runs are immediately available.

7. To determine if there were any errors in the run, click the Analysis tab and view the

Campaign flowchart status summary report.

Doing a production run of a process or branch

If you run only a process or a branch, the Run ID of the flowchart is not incremented.

Do a production run after you save, validate, and do a test run. A production run writes to the
history tables.
After initiating a run, users with Administrative privileges can access the Monitoring page,

which displays all running flowcharts and their status.

/\ Important: For contact processes, each production run can generate contact history
only once. To generate multiple contacts from the same list of IDs, snapshot out the list of

IDs and read from the list for each flowchart run.

1. Open a flowchart in Edit mode.

2. Click a process on the branch that you want to run.
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3. Open the Run menu ¥~ and select Save and run selected branch.

[5) Note: When you run only a process or a branch, if contact history records exist, you
are prompted to choose run history options before you can proceed. For details, see

Updating contact history by doing a production run (on page 377).

Each process displays a check mark after it runs successfully. If there are errors, the

process displays ared "X".

4. Click the Analysis tab and view the Campaign flowchart status summary report to

determine whether there were any errors in the run.

To run a flowchart process

Running only a process or a branch of a flowchart does not increment the Run ID of a
flowchart. When you run only a process or a branch, if contact history records exist, you are

prompted to choose run history options before you can proceed.

1. On a flowchart page in Edit mode, click a process on the branch you want to run.

2. Click the Run icon and select Save and Run Selected Branch.

Each process displays a blue check mark when it has run successfully. If there are

errors, the process displays a red X.

Pausing or stopping a flowchart run

When you pause a running flowchart, branch, or process, the server stops running but saves
all of the data that was already processed. When you stop a flowchart run, the results of any

currently running processes are lost and a red "X" appears on those processes.

You can pause a run to free up computing resources on the server, for example. After you
pause a run, you can continue the run or stop it. After you stop a run, you can continue the

run from the point at which it stopped.
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[5) Note: If you have the appropriate permissions, you can also control flowcharts from the

Monitoring page.

1. On a flowchart page, open the Run menu [~

2. To pause the run, select Pause. To stop the run, select Stop.

Continuing a paused flowchart run

When you continue a paused run, the run resumes at the exact point at which it stopped.
For example, if a Select process was paused after processing 10 records, it resumes by

processing the 11th record.

1. On a flowchart page, open the Run menu [ ~.
2. Select Continue.

[5) Note: If you have the appropriate permissions, you can also control flowcharts from

the Monitoring page. For details, see the Campaign Administrator's Guide.

Stopping a flowchart run

When you stop a flowchart run, the results of any currently running processes are lost and a

red "X" appears on those processes.

1. On a flowchart page, open the Run menu [~
2. Select Stop This.

[5) Note: If you have the appropriate permissions, you can also control flowcharts from
the Monitoring page.
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Continuing a stopped flowchart run

If you stopped a flowchart run, you can continue the run by running the flowchart branch
that begins with the process where the run stopped. That process is rerun along with all

downstream processes.

1. On a flowchart page in Edit mode, click the process that has a red "X".

2. Open the Run menu ¥~ and select Save and run selected branch.

[5) Note: If you have the appropriate permissions, you can also control flowcharts from

the Monitoring page. For details, see the Campaign Administrator's Guide.

Troubleshooting runtime errors

Correctly configured processes are displayed in color (the specific color reflects the type of
process). A gray process with its name in italics has a configuration error. To find out more
information about the error, hold your mouse over the process to display a descriptive error

message.

If a flowchart stops running due to an error, the processes that were running display a red X.

Hold your mouse over the process to see an error message.

[5) Note: If Campaign is configured so that system tables are stored in a database, you
are not viewing the flowchart, and the run stops due to a database connection failure, the
processes will not display a red X. Instead, the flowchart appears as it did when it was last

saved.

You should also consult the log file for system error information and review the Analysis
and Performance/Profitability reports for the campaign to see that the results are what you

expected.
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Deleting flowcharts

Deleting a flowchart permanently removes a flowchart and all of its associated files,
including the log file. If there are portions of your flowchart that you want to store for reuse,

you can save them as a stored object.

Output files (such as those written by a Snapshot, Optimize, or a contact process) are not

deleted, and contact and response history information is retained.

/\ Important: If you try to delete a flowchart that is being edited by someone else,
Campaign warns you that the flowchart is open by another user. If you continue deleting the
flowchart, the other user's changes are permanently lost. To prevent the loss of work, do not

continue deleting the flowchart without first checking with the other user.

Deleting flowcharts

You can delete a flowchart if you are sure that you no longer need it.

Deleting a flowchart permanently removes a flowchart and all of its associated files,
including the log file. If you want to retain portions of your flowchart for reuse, save them
as stored objects. Output files (such as files written by a Snapshot, Optimize, or a contact

process) are not deleted, and contact and response history are retained.

1. Open a flowchart in View mode.
2. Click the Delete button.

/\ Important: If you try to delete a flowchart that is being edited by someone else,
Campaign warns you that the flowchart is open by another user. If you continue, the
other user's changes are lost. To prevent the loss of work, do not continue without first

checking with the other user.

3. If you are sure that you want to permanently delete the flowchart, click OK to confirm

the deletion.
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The flowchart and all of its associated files are deleted.

Printing flowcharts

You can print hardcopies of flowcharts from Campaign.

[5) Note: Do not use the web browser File > Print command. This procedure does not

always print flowcharts correctly.

1. Open a flowchart in View or Edit mode.

2. Click the Print icon

Details about in-database optimization

In-database optimization avoids copying IDs from the database to the Campaign server for

processing whenever possible. This option can improve flowchart performance.

In-database optimization determines:

« Whether operations are done on the database server or the local Campaign server; and

» Where the results of operations are stored.
When in-database optimization is on:

« Processing tasks such as sorting, joining, and merging data are done on the database
server whenever possible.

« Output cells of processes are stored in temporary tables on the database server.
In-database optimization affects CPU consumption:

* When in-database optimization is on, more CPU is consumed on the database server.

* When in-database optimization is off, more CPU is consumed on the Campaign server.
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You can apply in-database optimization globally and override the global setting for
individual flowcharts. The best practice is to turn off the global configuration property (Use
in-DB optimization) and set the option at the flowchart level (Advanced Settings > Admin >

Use in-DB optimization during flowchart run ).

/\ Important: In-database processing cannot be done if you specify any limitations on the

output cell size or if temporary tables are disabled for a process.

Limitations of in-database optimization

« In-database optimization is not supported for all databases.
 Depending on the logic that is required, some functions are still performed on the
Campaign server, even with in-database processing turned on. Some examples are
given below:
> The query uses tables from different data sources.

For example, if a Select process queries different data sources, Campaign
automatically stores the ID lists for those cases on the application server.

> The query contains non-SQL macros or derived fields.

For example, to calculate a derived field, Campaign evaluates the derived field
formula to see whether any part of the calculation can be performed with SQL. If
simple SQL statements can be used, the calculation is done in-database. If not,
temporary tables are created on the Campaign server to handle the calculations

and persist the results from process to process within a flowchart.

Processing raw SQL in macros

Custom macros that consist of raw SQL statements can be processed in-database, within

the following guidelines:

« All raw SQL custom macros must begin with sel ect and contain exactly one f r omin
the rest of the text.
« For databases that only support insert into <TenpTabl e> syntax, you must map at least

one base table to the same data source at the same audience level as the raw SQL
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custom macro. If the fields that are selected by the raw SQL custom macro are too
large for the fields of the temp table, a runtime error occurs.

« If you use a raw SQL query in a Select process that has an input cell, you must
use the <TenpTabl e> token to obtain the correct list of audience IDs. Also use the
<Qut put TenpTabl e> token to prevent audience IDs from being retrieved from the
database back to the Campaign server.

« If you use raw SQL with in-database optimization, you must code the raw SQL to join
with the temp table from the upstream process. Otherwise, the results are not scoped

by the results from the upstream process.

Setting in-database optimization to improve flowchart
performance

Using in-database optimization can improve flowchart performance. When in-database
optimization is on, processing is done on the database server and output is stored in

temporary tables on the database server whenever possible.

You can apply in-database optimization in two ways: globally and for individual flowcharts.
The best practice is to turn off the global configuration setting and set the option at the

flowchart level.

1. To adjust the option globally, at the partition level:
a. Choose Settings > Configuration.
b. Choose Campaign > partitions > partition[n] > server > optimization.
c. Set uselnDbOptimization to TRUE (on) or FALSE (off).

2. To override the option for an individual flowchart:

a. Open a flowchart in Edit mode.

b. Open the Admin menu “I'and select Advanced settings.

c. Select or clear Use In-DB optimization during flowchart run.

Example
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Advanced settings EB

General Server optimization Test run settings

Save flowchart run resulis
Use In-DB optimization during flowchart run

| | Disable global suppression for this flowchart

When you save and run the flowchart, in-database processing will be used whenever

possible, if you are using in-database optimization.

[5) Note: In-database processing cannot be done if you specify any limitations on the

output cell size or if temporary tables are disabled for a process.

Packaging flowchart files for troubleshooting

If you need help from to troubleshoot a flowchart, you can automatically collect relevant

data to send to the Technical Support.

Only a user with permissions to edit or run a flowchart can perform this procedure. If you do
not have "View logs" permission, you cannot select the log-related entries in the selection

window.

Perform this task to package flowchart data files so you can send them to the Technical
Support. You can specify which items to include and indicate date ranges to limit data. The
data is written to the folder you choose, and the contents can be compressed and sent to

the Technical Support.

1. Open a flowchart in Edit mode.
2. Select Admin > Collect flowchart data.

3. In the Create Data Package for Troubleshooting window, type a name for the package

or leave the default name.
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The package name will be used to create a subfolder in which the selected data items

will be written.
4. Click Browse and select the folder where the data package will be saved.

5. Select the items that you want to include in the package or check Select default items
to select all data that is commonly required. Some items, when selected, may allow

additional information to be entered.

For more information, see Options for packaging flowchart data (on page 252).

6. Click OK to create the package.

7. Send the data package to the Technical Support by email or use the method
recommended by your support representative. The Technical Support accepts
uncompressed data (the entire package subdirectory), but you may optionally

compress, encrypt, and package the files into a single file before sending them.
In addition to the data items you select, Campaign creates a summary file that identifies:

« Current date and time

« Version and build numbers of the software

* Your user name

« The selections that you included in the package
« Campaign name and ID

» Flowchart name and ID

Packaging flowchart files for troubleshooting

Only a user with permissions to edit or run a flowchart (either test or production run) can
perform this procedure. If you do not have "View logs" permission, you cannot select the

log-related entries in the selection window.

Use this task to automatically package flowchart data files so you can send them to the

Technical Support if you need help troubleshooting a flowchart.
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1. From a flowchart page in Edit mode, select Admin > Collect Flowchart Data. You see
the Create Data Package for Troubleshooting window.

2. Type a name for the package, or leave the default name.
The package name will be used to create a subfolder in which the selected data items
will be written.

3. Click Browse and select the folder under which the data package will be saved.

4. Select the check box for each item you want to include in the package. Some items,
when selected, may allow additional information to be entered with which to filter the
extracted data.

Alternatively, you can check the Select default items check box. This check box
automatically selects all data that is commonly required for troubleshooting flowcharts;
this includes all of the listed items except the log files and the contents of the user

table, contact and response history tables, strategic segments, and stack trace files.

5. Click OK to create the package.

Transmitting the flowchart data package to Technical Support

You can send the data package to the Technical Support by email or using a method
recommended by your support representative. The Technical Support will accept
uncompressed data (the entire package subdirectory), but you may optionally compress,

encrypt, and package the files into a single file before sending them to HCL.

Options for packaging flowchart data

Select Admin > Collect flowchart data to package flowchart files to send to the Technical
Support. When prompted, specify the options described in this topic.
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Table 24. Options for packaging flowchart data

Additional specifications

Item Description of what is included
you may set
Select default All data commonly required
items check box | for troubleshooting flowcharts,
including all of the listed items
except log files and the contents
of the user table and contact
history table.
Flowchart The flowchart . ses file. Include run results? Optionally

include or exclude the runtime
data files, also called the

"underscore" files.

Flowchart log The flowchart . | og file. Optionally set start and end time
stamps. If you do not set them, the

default is the entire log file.

Listener log The uni ca_acl snr. | og file. Optionally set start and end time
stamps. If you do not set them, the

default is the entire log file.

Startup log The AC sess. | og file. Optionally set start and end time
stamps. If you do not set them, the

default is the entire log file.

Web message The AC web. | og file. Optionally set start and end time
log stamps. If you do not set them, the

default is the entire log file.

Campaign The . confi g file, which lists

configuration configuration properties

and settings from your
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Additional specifications

Iltem Description of what is included
you may set

Campaign environment to help
troubleshooting the flowchart.

Campaign The

custom cust ontanpai gnattri but es. dat

attributes file, which lists attribute name and
value pairs for Campaign custom
attributes. Only entries that are
related to the current campaign
are included.

Cell custom The cust ontel | attri but es. dat

attributes file, which lists attribute name

and value pairs for Campaign cell
custom attributes. Only entries
that are related to the current

campaign are included.

Offer definitions

All rows are included for each of
the following offer-related system
tables:UA At tri but eDef. dat,
UA Fol der. dat, UA O fer. dat,
UA OFferAttribute. dat,

UA O ferlist.dat,

UA O f er Li st Menber . dat,
UA O ferTenpl at e. dat,

UA O ferTenpl Attr. dat,

UA O fer ToProduct. dat,

UA Product. dat,

UA Product | ndex. dat
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Additional specifications
Iltem Description of what is included
you may set
Target cell Thet ar get cel | spreadsheet . dat
spreadsheet file, which includes data from
data UA Tar get Cel | s for the entire
target cell spreadsheet. Includes
data for the current campaign, in
column/row-delimited text format.
Custom macro | The cust onmacr os. dat file,
definitions which includes the following
fields from UA _Cust omMacr os,
in column/row format: Nane,
Fol der | D, Descri pti on,
Expr essi on, Expr essi onType,
Dat aScr Nane, Dat aVar Type,
Dat aVar NByt es, Cr eat eDat e,
Cr eat edBy, Updat eDat e, UPdat eBy,
Pol i cyl S, ACLI D
System table The syst abl emappi ng. xn
mapping file. Includes all system table
mappings, including the data
source.
+ Include When you select this option, it Select each system table to
system table expands to list all system tables. |include. The entire table will
contents be included (all rows and all
columns).
If you do not select any sub-
options, the package will not
include any system tables.
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Item

Description of what is included

Additional specifications

you may set

+ Include

contact history

tables

When you select this option, it
expands to show the contact
history and detailed contact
history tables for each audience

level.

For each set you select, the
package will include the contact
history and detailed contact
history records for that audience

level.

You can optionally set start and
end time stamps. If you do not set

them, the default is all records.

If you do not select a suboption,
the package will not contain any

contact history table information.

+ Include

response history

tables

When you select this option, it
expands to show response history

tables for all audience levels.

For each table you select, the
package will include the response
history records for that audience

level.

For each table you select, you can
optionally set start and end time
stamps. If you do not set them, the

default is all records.

If you do not select a table, the
package will not contain any

response history table information.

+ Include user

table contents

When you select this option, it
expands to show the user table
contents that you can select for

the package.

Select the user tables from the

flowchart to include.

If you do not select any, the
package will not include any user

table contents.
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Item

Description of what is included

Additional specifications

you may set

For each user table that you select,
you can optionally set maximum
number of rows to include. If you
do not set a maximum number of
rows, the package will include the

entire table.

+ Include
strategic

segments

When you select this option, it
expands to show all the strategic
segments that you can select for

the package.

Select the segment data for
each strategic segment from the

flowchart that you want to include.

+ Include stack

trace files

Option available for UNIX versions

only.

When you select this option, it
expands to show the list of stack
trace files (*. st ack) in the same

directory as uni ca_acl snr. | og.

Select the stack trace files

that you want to include in the
package. If you do not select any
sub options, the package will not

include any stack trace files.

Flowchart reference

This section describes the icons in the Campaign interface for working with flowcharts.

Flowchart tab icons (View mode)

The flowchart tab uses the following icons in View

mode.

Search flowcharts | | Find process by name

The icons, left to right, are described in the following table.
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[5) Note: Many of the icons in the interface are associated with features that require
permissions. For more information, see the Platform Administrator's Guide. The Copy and

Delete Flowchart icons do not appear without the appropriate permissions:

Table 25. Flowchart tab icons for View mode

Icon Name Description
Edit Click this icon to edit the flowchart.
Run Click this icon to access the Run menu.

Add a flowchart

Click this icon to add another flowchart to the campaign.

Zoom In

Click this icon to increase the view size of the flowchart.

Zoom Out

Click this icon to decrease the view size of the flowchart.

Print this Item

Click this icon to print the flowchart.

Copy

Click this icon to create a copy of this flowchart.

Delete Flowchart

Click this icon to delete the flowchart.

Flowchart page icons (Edit mode)

The Flowchart page uses the following icons in Edit

mode. = ~ ©¢  [EHE

The icons, left to right, are described in the following table.

[5) Note: Many of the icons in the interface are associated with features that require

permissions. For more information, see the Platform Administrator's Guide.

Table 26. Flowchart page icons for Edit mode

Icon Name

Description

Run

Click this icon to access the Run menu.




Corporate Marketer's Guide | 15 - Managing flowcharts | 259

Icon Name Description

Properties Click this icon to view or edit the Flowchart Properties
window.

Options Click this icon to access the Options menu.

Admin Click this icon to access the Admin menu.

Reports Click this icon to access the flowchart cell reports.

Cut Select one or more items in the flowchart and click this
icon to remove them.

Copy Select one or more items in the flowchart and click this
icon to copy them.

Paste Click this icon to paste into the flowchart any items you
have cut or copied.

Zoom In Click this icon to increase the view size of the flowchart.

Zoom Out Click this icon to decrease the view size of the flowchart.

Print Click this icon to print the flowchart.




Chapter 16. List of processes

The following processes, grouped by process type, are available in Campaign.

The sections for the individual processes provide step-by-step guidance for configuring
each process. Each set of the individual process configuration instructions assumes that
you have added the process to your flowchart as a first step. For details about how to add a

process to a flowchart, see Adding processes to flowcharts (on page 368).

You should also see Manipulating process boxes in flowcharts (on page 366) for

information about configuring processes in general.

Campaign provides the following types of processes:

« Data manipulation processes (on page 365)

» Run processes (on page 366)

» Optimization processes (on page 355)

[5) Note: Interact, Optimize, and Deliver provide additional processes. For more information,

see the documentation for those products.

Data manipulation processes

Campaign provides the following data manipulation processes:

» The Audience process (on page 261)

» The Extract process (on page 277)

» The Merge process (on page 289)

» The Sample process (on page 292)

» The Segment process (on page 298)

» The Select process (on page 314)
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The Audience process

Audience levels define the target entity that you want to work with, such as account,
customer, household, product, or business division. Use the Audience process in a flowchart

to switch between audience levels or to filter out IDs by audience level.

Audience levels are defined by an administrator during the table mapping process. When
you use the Audience process in a flowchart, you can specify which audience levels you

want to target in your campaign. For example, you can configure the Audience process to:

« Select one customer per household based on some business rule (for example, oldest
male or the person with the highest account balance);

« Select all accounts belonging to a particular set of customers;

- Select all accounts with a negative balance belonging to a particular set of customers;

« Select all households with individuals holding checking accounts;

« Select customers with three or more purchases within a specified time-frame.

The Audience process can select from any defined table(s), so you can use it as a top-level
process in your flowchart to initially select data.

To use the Audience process, you must work with tables for which multiple audience levels
are defined. These levels, defined within a single table, provide a relationship to "translate”
from one level to another.

+ One key is defined as the "primary" or "default” key for the table. (This key represents
the audience used most frequently for this data source.) The default level associated
with a table is specified during the table mapping process. For more information about
mapping tables, see the Campaign Administrator's Guide.

« The other keys are "alternate" keys that are available for switching audience levels.

After you switch audience levels, Campaign displays only those tables whose default key
is defined at the same audience level. If you work at different audience levels on a regular
basis, you might need to map the same table more than once within Campaign, each time
with a different primary/default key.
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Restricting audience size

When you configure an Audience process, the default size for the number of records per
audience is Unlimited. You may want to restrict the size of the audience if, for example, you

are performing test runs of a campaign flowchart or process.

You can limit the audience size to any positive integer. When you limit the audience size, the

qualifying records are chosen randomly.

The same random set of records will be used for each subsequent run of the Audience
process (unless the input to the process changes). This is important if you intend to use the
results for modeling purposes, because different modeling algorithms must be compared
across the same set of records to determine each model's effectiveness. If you do not
intend to use the results for modeling, you can make the Audience process select a different
random set of records each time it runs. To do this, use a Random Seed of zero (0). A value
of 0 ensures that a different random set of records will be selected each time the process

runs.

Audience levels

Audience levels are defined by Campaign administrators to represent different potential

targets of campaigns, such as account, customer, household, product, or business division.

Audience levels are often, but not always, organized hierarchically. Here are some examples

of hierarchical audience levels that are commonly found in customer marketing databases:

» Household > Customer > Account

« Company > Division > Customer > Product

Your organization can define and use an unlimited number of audience levels. If you are
using multiple audience levels (for example, customer and household), it is important to

understand how to use the Audience process to best accomplish your business objectives.

Audience levels are created and maintained by an administrator. Moving from one audience
level to another requires that all of the audience levels that you use have keys defined within

the same table. This provides a "look up" mechanism to switch from one level to another.
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Audience levels are global, and are attached to each mapped base table. Thus, when a
flowchart is loaded, the audience levels are loaded along with the table mappings within
that flowchart.

If you have permissions to map tables in Campaign, you can map a new table to one or
more existing audience levels, but you cannot create new audience levels. Only users with

the appropriate permissions, usually system administrators, can create audience levels.

In the Audience process, you specify an input audience level and an output audience level.
The input and output audience levels can be the same (for example, Customer) or different
(for example, Customer and Household). Use the Audience process to stay within the same

audience level, or to switch audience levels.

Householding

Householding is a general term that means reducing the number of members in the current

audience level by scoping using another audience level.

One of the most common examples of householding is to identify a single individual to
target within each household. You might select one individual per household according to a

marketing business rule such as:

« The individual with the greatest dollar value across all accounts;
« The individual with the most purchases in a particular product category;
« The individual with the greatest tenure; or

« The youngest male over 18 within the household.

You can use the Audience process to change audience levels and filter IDs according to

user-specified criteria.

When to switch audience levels

Some complex campaigns require processing at different audience levels to arrive at the
list of final target entities. This can involve starting at one audience level, performing some
computations and taking this output, then moving to another audience level, and performing
other computations.



Corporate Marketer's Guide | 16 - List of processes | 264

For example, you might want to support complex suppressions at different levels. As a
result, in a data model where there is a one-to-many or many-to-many relationship between
customers and accounts, a marketing analyst might want to build a campaign that does the

following:

« Eliminates all accounts of customers that satisfy certain criteria (for example, eliminate
any account that is in default);
« Eliminates particular accounts that satisfy certain criteria (for example, eliminate all the

low-profitability accounts).

In this example, the campaign might start at the customer level, perform customer-level
suppressions (suppress accounts in default), switch to the account level, apply account-
level suppressions (suppress low-profitability accounts), and then switch back to the

customer level to obtain the final contact information.

Configuring the audience process

To use the Audience process, you must work with tables for which multiple audience levels
are defined. These levels, defined within a single table, provide a relationship to "translate"

from one level to another.

« One key is defined as the "primary" or "default” key for the table. (This default key
represents the audience used most frequently for this data source.)

» The other keys are "alternate" keys that are available for switching audience levels.

Once you switch audience levels, Campaign displays only those tables whose default key
is defined at the same audience level. If you work at different audience levels on a regular
basis, you might need to map the same table more than once within Campaign, each time
with a different primary/default key. The default level associated with a table is specified

during the table mapping process. For more information about mapping tables, see the

Campaign Administrator's Guide .

The options available in the Audience process configuration dialog depend on various

choices that you can make:
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« Whether the input and output audience levels are the same or different;
» Whether the audience level values are normalized in these tables;

« Whether there are multiple audience levels defined for the selected tables.

For this reason, not all of the options described in the following sections are available for all

pairs of input and output table selections.

Switching and filtering audience levels

Configure an Audience process to switch between audience levels or to filter out IDs by a

specific audience level.

To use the Audience process, you must work with tables for which multiple audience levels

are defined.

The options that are available in the Audience process configuration dialog depend on

various choices that you can make:

« Whether the input and output audience levels are the same or different
» Whether the audience level values are normalized in these tables
» Whether there are multiple audience levels defined for the selected tables

For this reason, not all of the options described below are available for all pairs of input and

output table selections.

1. Open a flowchart for editing.

2. Drag the Audience process “= from the palette to your flowchart.

The Audience process can select from any defined tables, so you can use it as a top-
level process in your flowchart to initially select data. You can also use a process such

as Select or Merge to provide input to the Audience process.

3. Double-click the Audience process in the flowchart.
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The Audience process configuration dialog box opens and the Source tab is open by
default.

4. On the Source tab, open the Input list and select a data source for the process. You can
select a Segment, a Table, or the output cell from any process that is providing input to

the Audience process.

The audience level for the selected input is displayed next to the Input field. If there is

no input, the audience level is shown as not selected.

© Tip: Notice that the Select options indicate the input audience level. For example, if
the audience level is Customer, you can select One entry per Customer. If the audience

level is Household, you can select One entry per Household.
5. Select an output audience level from the Choose audience list.
[5) Note: If you do not see the expected audience level, you can try remapping a table.

The Select options now reflect both the input and the output audience levels.

For example, if your input is Household and your output is Customer, the Select options
are labeled All Customer entries, Some Customer entries, One Customer entry per

Household.

6. Use the Select and Filter options to specify how to select records. The available
options depend on whether you are selecting All IDs (in which case filtering is not
allowed), switching levels, or staying at the same level.

For details on how to select and filter based on whether you are switching audience
levels, see:
« Options that are available when using the same input and output audience levels

(on page 269)

» Options that are available when using different input and output audience levels

(on page 274)

7. Optionally, use the Cell size limit tab to limit the number of IDs generated by the

process during production or test runs. .
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8. Use the General tab to set the following options.

a. Process name: Assign a descriptive name to identify the process in the flowchart
and in various dialogs and reports.

b. Output cell name: This name matches the Process name by default. It is used
in dialogs and reports to identify the output cell (the set of IDs that the process
retrieves).

c. (Optional) Link to target cell: Perform this step if your organization pre-defines
target cells in a target cell spreadsheet. To associate the pre-defined target cell
with the flowchart process output, click Link to target cell, then select a target
cell from the spreadsheet. The Output cell name and Cell code are inherited from
the target cell spreadsheet, and both of those field values are shown in italics to
indicate that there is a link relationship.

d. Cell code: The cell code has a standard format that is determined by your system
administrator and is unique when generated. Do not change the cell code unless
you understand the implications of doing so. By default, the name of a cell created
in a process matches the process name. When you save changes to an output cell
name, if Auto generate is selected, the cell code is regenerated. If you do not want
the cell code to change, uncheck Auto generate.

e. Note: Use the Note field to explain the purpose or result of the process, such as
Contact one individual per household. The contents of this field appears when you

rest your cursor over the process box in a flowchart.

9. Click OK to save and close the configuration.

The process is now configured. You can test run the process to verify that it returns the

results that you expect.

Example: Audience process
This example shows how to configure an Audience process in a flowchart.

The following figure shows a configured Audience process.
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Audience process configuration M x

Source Cell size limit General

Specify selection criteria and result audience level

Input Demo ~ | { Audience level Customer )

Choose audience Customer in Trans_xind_retail_Auto

Select
(®) One Customer entry per. HHold s
() Some Customer entry per...

() For each Customer

Based on

MaxOf v MEAN_HHOLD_INCOME Derived fields...

The process is configured to choose the customer who has the highest credit limit within a

household:

* The selected input audience level is Customer; it is the default audience level of the
DEMOtable. The Audience Level is displayed to the right of the Input field.

« The output audience level is the same: Customer as defined in the DEMOtable. The DEMO
table has two other audience levels defined: Br anch and HouseHol d .

« The process is configured to choose One Customer entry per... HouseHold based on
the maximum of the field CREDI T_LIM T.

Example: Filtering records

This example explains how to use filtering in an Audience process in a flowchart.



Corporate Marketer's Guide | 16 - List of processes | 269

When you configure an Audience process to select IDs based on a count, or a statistical
function ( MaxOf, MedianOf, MinOf) or Any One, the Filter button becomes available. When
you click Filter, the Specify selection criteria dialog appears, which allows you to enter a

query expression to specify which records will be used in the Based on calculation.

[5) Note: The filtering criteria is applied before the Based on calculation is performed,

allowing you to remove records from consideration.

For example, you might want to constrain the date range over which an operation is
performed. To use only purchase transactions over the last year, you can enter a filter query

expression such as:
CURRENT_JULI AN() - DATE(PURCH DATE) <= 365

Then, if you are computing a Based on calculation that chooses the sum of the Amount

field, only the amounts from transactions within the last year are summed together.

Options that are available when using the same input and output audience levels

When the input and output audience levels are the same in an Audience process of a

flowchart, you can use the following selections to identify the audience.
The Select options vary depending on the relationship of the selected audience levels for

the Input and output (Choose audience). Options that are not meaningful are disabled.

[5) Note: The name of the selected audience level is used in the Select option labels. For
example, if the input audience level is Customer, the One entry per option appears as One

Customer entry per.

The Select options include:

One per One member of the input/output audience level, scoped

by another audience level.
For example: One customer per household.

See Selecting one <Input/Output audience> entry per

<Different audience> (on page 270).
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Some per

Some members of the input/output audience level,

scoped by another audience level.

For example: All customers in the household with above

average purchases.

See Selecting some <Audience> records per <Different

audience> (on page 272).

For each

Select members if the number of members at the

selected audience level satisfies some condition.

For example: Number of accounts > 1, or number of

purchases > 3.

See Selecting entries for each entry at that audience

level (on page 273).

Selecting one <Input/Output audience> entry per <Different audience>

Choose this option if the input and output audience levels are the same, but a different

audience level is used to scope the output.

An example is to select the one customer in each household who has the oldest account.

(Input audience level is customer, output audience level is customer, scoping by Household

level, using M nOf ( Basel nf o. Acct Start Dt) to select.) Specify a business rule to indicate

how the single entity is selected (for example, the minimum, maximum, or median of some

field), or else choose Any one (in this case, no field choices are available).

1. In the Audience process, select an input source for Input.

2. Choose the same audience level for the output audience.

The relevant Select options become available.

3. Select the One entry per option.

4. Select an audience level from the list.

All alternate defined audience levels (other than the input audience) appear in the list.
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5. Choose a value from the Based on list:
« Any One eliminates the need to pick a Based on value
« MaxOf returns the maximum value of the selected field
» MedianOf returns the median value of the selected field

» MinOf returns the minimum value of the selected field

Each of these functions will return exactly one member from the input audience level.
If more than one entry is tied at the maximum, minimum, or median value, the first

encountered entry is returned.

6. If you selected a Based on criterion other than Any one, select a field on which the
function operates. This list includes all the fields from the table selected in the Choose
audience field and any mapped dimension tables. Expand a table by clicking the " +"

sign. Created derived fields are listed at the bottom.

For example, to select the account holder from each household with the highest
account balance, select MaxOf for the Based on criteria and Acct Bal ance from the
list of table fields.

You can also create or select derived fields by clicking Derived fields.

7. (Optional) If you selected a count to be based on, the Filter button becomes available.

Use the Filter function to reduce the number the IDs that will be available to the
Based on calculation. For example, you might want to select customers based on their
average account balance in the last 6 months, but prior to doing that, you would want to

filter out all customers whose accounts are inactive.

To filter records before performing the Based on computation, click Filter. The Specify
selection criteria dialog appears. You can enter a query expression to specify which
records will be used in the Based on calculation. The filtering criteria is applied before
performing the Based on calculation, thereby allowing you to remove records from

consideration.

© Tip: You create a query expression in the Specify selection criteria dialog the same

way that you would for a Select process. For instructions, see the topic Selecting a list

of contacts (on page 315).
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8. Click OK to save your query and close the Specify selection criteria dialog.

9. Continue configuring the Audience process by completing the fields on the remaining
tabs.

Selecting some <Audience> records per <Different audience>

This selection indicates that there are multiple entries per audience.

In this situation, the input and output audience levels are the same, but a different audience
level is used to scope the output. For example, select all customers within each household
who have made purchases over $100 (Input audience level is customer, output audience

level is customer, scoping by Household level, using Maxi mum Pur chase Val ue>$100.)

In addition to creating a query, the Based on criterion also supports keywords allowing the

functional equivalent of a GROUPBY macro function to be performed.

1. Select an input source for Input and the same audience level for the output audience in
the Audience process.

The relevant Select options become available.

2. Select the Some entries per... option.

A list appears next to the selected option.

3. Select an audience level from the list.

All alternate defined audience levels (other than the input audience) appear in the list.

4. Click in the Based on field to enter a query.

The Specify selection criteria dialog opens.

5. Enter or build a valid query expression, then click OK to save it and close the Specify

selection criteria dialog.

© Tip: You create a query expression in the Specify selection criteria dialog the same

way that you would for a Select process. For instructions, see the topic Selecting a list

of contacts (on page 315).
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6. Continue configuring the process by completing the fields on the remaining tabs.

Selecting entries for each entry at that audience level

This selection indicates that there are multiple selections from multiple audience levels.

Select this option if the number of members at the selected audience levels satisfies some

condition (for example, Nunber of Accounts > 1 or Nunber of Purchases > 3).

[5) Note: This option is available only if the input audience level is not normalized (that is,
the record ID is not unique in the selected Choose Level table), and the input and output
levels are the same. It is the only option available if no alternate keys have been defined for
your output audience table.

1. Select an input source for Input and the same audience level for the output audience in
the Audience process.

The relevant Select options become available.
2. Select the For each option.

[5) Note: This option is available only if the input audience level is not normalized (that

is, the record ID is not unique in the selected Choose Level table).
A list appears next to the selected option.

3. Choose a Based on selection.

If the table that you selected for Choose audience (that is, the output audience) is not
normalized, there might be duplication in your results. To avoid duplication, specify a
Based on method for Campaign to use when selecting records. For example, if your
results might include more than one individual in the same household, you can use
Based on to select only one individual from that household, based on the criterion that

you configure in this feature.

You must select one of the Based on methods:
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« Count: This option lets you select the <l nput Audi ence Level > ID, where the
number of occurrences of the <I nput Audi ence Level > ID satisfies the specified
condition. To toggle between different relationships (<,<=,>>=,=), click the operator

button repeatedly until the desired relation is displayed.

When you select Count, the Filter button becomes available. Optionally, use the
Filter function to reduce the number the IDs that will be available to the Based on
calculation. For example, you might want to select customer IDs based on their
average account balance in the last six months, but before doing that, you would
want to filter out all customers whose accounts are inactive. When you click Filter,
the Specify selection criteria dialog opens. You can enter a query expression to
specify which records will be used in the Based on calculation. The filtering criteria
is applied before performing the Based on calculation, allowing you to remove
records from consideration.

« Condition: Click in the text box to the right of Condition. The Specify selection
criteria dialog appears. Enter or build a valid query expression, then click OK to

save your expression and close the Specify selection criteria dialog.

© Tip: You create a query expression in the Specify selection criteria dialog
the same way that you would for a Select process. For instructions, see the topic

Selecting a list of contacts (on page 315).

4. Continue configuring the process by completing the fields on the remaining tabs.

Options that are available when using different input and output audience levels

When the input and output audience levels are different in an Audience process of a

flowchart, you can use the following selections to identify the audience.

[5) Note: The name of the selected audience level is used in the Select option labels. For
example, if the input audience level is Customer, the One entry per option appears as One
Customer entry per. In the following sections, this dynamically changing portion of the

option text is indicated with <Input/Output Audience> where appropriate.

The Select options include:
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All Select all members of the input audience level, scoped
by another audience level. For example: All customers

per household.

See Selecting all <Output Audience Level> entries (on

page 275).

Some Select some members of the output audience level,

keeping only those IDs that satisfy a specified
condition. For example: All customers aged 18 or over
within a household.

See Selecting some <Different Output Audience Level>

entries (on page 276)

One per Select exactly one output audience record for each
input audience record. For example: One customer per
household.

See Selecting one <Output Audience> per <Different

Input Audience> (on page 276).

Selecting all <Output Audience Level> entries

Select this option to switch to the output audience level without performing any filtering.
For example, you can select all customers in a household or all accounts belonging to a
customer.

This option creates an output cell with all output audience level entries associated with the

input IDs. It switches audience levels without applying any selection or filtering criteria.

If you change from a primary audience level to another audience level, you will no longer be

able to use derived fields in downstream processes.

1. Select an input source for Input and a different output audience for Choose audience.

The Select options become available.

2. Select All <Output Audience Level> entries.
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3. Click OK.

Selecting some <Different Output Audience Level> entries

Select this option to switch from the input audience level to a different output audience
level, keeping only those IDs that satisfy a specified condition. For example, you could
select all customers aged 18 or over within a household, or select all accounts of a

customer with positive balances.

1. Select an input source for Input and a different output audience for Choose audience.

The Select options become available.

2. Click to select Some <Output Audience Level> entries.

The Based on field becomes available.

3. Click in the Based on field to enter a query.

The Specify Selection Criteria window appears. The Based on criteria allows you to

enter a query expression to limit the output audience level entries selected.

4. Enter or build a valid query expression, then click OK to save the query and close the

Specify Selection Criteria window.

5. Click OK to close the Audience process configuration dialog, saving your entries.

Selecting one <Output Audience> per <Different Input Audience>

Select this option to choose exactly one output audience record for each input audience

record (for example, to choose one email address per customer).
You must specify a business rule to indicate how the single entity should be selected (min/
max/median of some field) or choose AnyOne (in this case, no field choices are available).

This option is available only if the input audience level is not normalized (that is, the record

ID is not unique in the selected Choose Level table).
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In addition to creating a query, the Based on criterion also supports keywords allowing the

functional equivalent of a GROUPBY macro function to be performed.

1. Select an input source for Input and an output audience for the Audience process.

The Select options become available.
2. Select One <Output Audience Level> per <Input Audience Level>.

3. Select a value from the Based on drop-down list.
(Field selection, using the drop-down list to the right, becomes inactive when you select
Any One. If this is your selection, skip to step 5.)

4. Select a field in the next drop-down list to which the Based on function relates:

a. Click in the Based on text box.

The Select Field window appears. All fields from the table selected in the Choose

audience drop-down list appear, including any mapped dimension tables.

You can expand a table by clicking the "+" sign. Created derived fields are listed at
the bottom.

b. Select a field and click OK.
c. (Optional) Create derived fields by clicking Derived fields.
5. (Optional) To filter records before performing the Based On computation, use Filter.

6. Click OK.

The Extract process

Use the Extract process to select fields from one table and write them out to another table
for subsequent processing. The Extract process is designed to pare down a large amount
of data to a manageable size for subsequent operations, resulting in vast performance

improvements.
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The Extract process can take input from a cell, single table, strategic segment, optimized list
(Optimize only), or Deliver landing page (Deliver only). If you select a strategic segment as

input, you must join it to a table before you can extract fields.

If you use several Extract processes in a series, only the fields in the final Extract process
are written out.

If you use several Extract processes in parallel (in different branches in the same flowchart),

they behave the same as persistent derived fields:

« The extracted fields attach to the inbound cell
* The extracted fields are calculated before query execution in that process
 Multiple extracted fields are available in subsequent processes
« When extracted fields are sent to a contact process:
o If an extracted field is not defined for a cell, its value = NULL
> If a single ID is in more than one cell, one row is output for each cell
« When extracted fields are sent to a Segment or Decision process, the extracted field

must exist in all selected input cells for it to be used in segmenting by query.

Extracted tables

Data is extracted as either a binary file on the Campaign server or as a table with a UAC_EX

prefix.

Extract tables are not deleted at the end of a flowchart run. An extract table persists so that

users can continue to access it to perform operations such as profiling its fields.

An extract table is deleted only when you delete its associated Extract process, flowchart,

campaign, or session.

[5) Note: To conserve space, system administrators can periodically delete tables with a
UAC_EX prefix. However, if these tables are removed, you must rerun the affected Extract
processes before you rerun flowcharts or profile fields in the now-missing tables. Otherwise,

Campaign generates "Table Not Found" errors.
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Example: Extracting transaction data

This example explains how to use the Extract process to obtain data about purchase

transactions.

Assume that you designed a campaign to perform selections or calculations based on the
last three months of purchase transactions for all non-delinquent customers (approximately

90% of your customer base), resulting in 4 GB of data.

Even if Campaign created a temporary table for these customers, joining it back to the
purchase transaction table would entail pulling over approximately 90% of the 4 GB rows
(and discarding all transactions except for the last three months) to execute a GROUPBY

macro, for example.

Instead, you can configure an Extract process (placed at the purchase transaction level) to
pull out all transactions within the last three months, put them into a table in the database,
and then subsequently run multiple GROUPBY macros and other calculations against it (for

example, min/max and average).

Prerequisites for extracting data from Deliver landing pages

Several prerequisites must be met before you can configure an Extract process to accept

input from Deliver landing pages.

« Deliver must be installed, running, and enabled.
« Deliver landing pages must be appropriately configured.

« The mailing must be executed and responses from mailing recipients must be received.

For more information about Deliver landing pages, see the Deliver User's Guide.

Extracting subsets of data for further processing and manipulation

Use the Extract process to pare down a large amount of data to a manageable size for

subsequent operations, resulting in performance improvements.

The procedure for configuring the Extract process differs depending on whether you are

extracting data from a cell, table, or strategic segment or from a Deliver landing page.
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To extract data from an optimized list, see the Optimize User's Guide.

Extracting data from a cell, table, or strategic segment

This procedure explains how to use the Extract process to obtain data from an input cell,
such as a Select process, or from a single table or a strategic segment. In this way, you
can pare down a large amount of data to a manageable size for subsequent operations,

resulting in improved performance.

See The Extract process (on page 277).

1. Open a flowchart for editing (click Edit < in the flowchart toolbar).

2. Drag the Extract process ™ from the palette to your flowchart.

3. Optionally, connect a configured process, such as a Select process, as input into the
Extract process.
4. Double-click the Extract process in the flowchart.
The Extract process configuration dialog opens and the Source tab is open by default.
5. On the Source tab, use the Input list to select an input cell, a table, or a strategic

segment. The Select based on list indicates your selection. If you selected a strategic

segment, you must join it to a table by selecting a table from the Select based on list.

6. Specify which records to select. If you want to include all records from the input data

source, choose Select all records.

7. If you prefer to use a subset of IDs from the selected data source, choose Select all
records with, so you can do a query for the records that you want to extract.
The Expression box shows columns labeled Field name, Oper, Value, and And/Or.

When the button says Text Builder, you can build expressions by populating the

columns labeled Field name, Oper, Value, And/Or.
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When the button says Point & click, you can view or edit raw SQL and you can use the

Formula helper to pick macros, operators, and string functions from a list.

With either method (Text Builder or Point & click), you can select fields from the

Available fields list, including Campaign Generated Fields and Derived fields.
8. Construct a query to determine which records are selected:

a. To specify which field to query, click in the Field name cell. The Available fields list
should appear. If the list does not appear, click in the Field name cell again. In the
Available fields list, expand the fields until you see the one that you want. Select an

available field by double-clicking it or by highlighting it and clicking Use.

[5) Note: When deciding which field to use, you can highlight an available field
and click Profile to see a list of values in that field. Then use the Profile selected

field dialog to examine the field values. For more information, see Previewing field

values from your user data (on page 397).

[5) Note: When the list of Available fields is displayed, you can use the Derived
fields button if you want to create or select a variable for querying. For more
information, see Derived fields (on page ).

b. Click in the Oper cell, then double-click a comparison operator in the Operators list

(5, <, > <=, >=,<>,In, Not in, Between).

c. Click in the Value cell, then double-click a value. If no values appear, double-click
(Profile...) in the Values list to open the Profile selected field dialog so you can
select from a list of values. You can also double-click in the Value cell to edit the
value directly.

[5) Note: If you do not see the expected list (Available fields, Operators, Values,
For selected expresssion), try either single clicking or double clicking on a cell in

the Expression area.

You now have an expression that consists of a field name, operator, and value.
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9. Click Check syntax to confirm whether the query syntax is valid. Checking the syntax

does not put any load on the database server.

10. To add and combine multiple expressions, follow the guidelines below:

a. To add another expression, click the And/Or cell, then double-click AND or OR in
the Values list to indicate how to combine the expressions.

b. Build your next expression, consisting of a field name, operator, and value.

c. To add parentheses to control evaluation order, double-click the Field Name in
any row to display the For selected expression list. In the list of expressions,
double-click Add () to add a set of parentheses, Remove () to remove a single
set of parentheses, or Clear all () to remove all of the parentheses in the selected
expression. Parentheses allow you to group expressions when defining complex
queries. For example, (AcctType = 'Gold' AND Rank ='A’) OR NewCust = 'Yes'is
different from AcctType = 'Gold' AND (Rank ='A' OR NewCust = 'Yes').

d. To reorder the selected expression, double-click Move up or Move down.

e. To add a blank row below the selected expressions, double-click Insert.

f. To delete the selected expression, double-click Delete.

11. Optionally, click the Text Builder button so its label changes to Point & click. When
the button says Point & click, you can view or edit raw SQL. You can also use

the Formula helper to pick macros, operators, and string functions from a list.

(®) Select Customer IDs with Advanced...

Expression
Field name Oper. Value AndiOr
CUSTOMER_MAIL O. .. = *\ﬂ

Text Builder Check syntax || Testquery




12.

13.

14.

15.
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Expression
CUSTOMER_MAIL_OFTIN = "Y'

| Point & click ‘ ‘ Formula helper | | Check syntax ‘ ‘ Test query

[5) Note: If your query includes a table field that has the same name as a Campaign
generated field, you must qualify the field name. Use the following syntax:

<t abl e_nane>. <fi el d_nanme>.

For related information, see Creating raw SQL queries (on page 392). Also see

Creating queries with Formula helper (on page 386).

Click the Point & click button to change back to the original query mode. The button

label changes back to Text Builder.

(Optional) Use Test query to see how many IDs the query returns.

A progress bar is displayed while the query is being tested. Close the progress window
if you want to cancel the test. When testing is complete, Campaign indicates the

number of rows the query returned.

/\ Important: Global suppressions and cell size limits are not applied in test query
counts. Test queries might also return non-normalized data. To obtain an accurate

result count, test run the process.

Continue configuring the process, as described below, or click OK to close the process

configuration dialog and save the query expression.

Optionally, use the Cell size limit tab to limit the number of IDs generated by the

process during production or test runs.



Corporate Marketer's Guide | 16 - List of processes | 284

16.

17.

18.

If you selected Random seed, in most cases you can accept the default seed. The

random seed represents the starting point that Campaign uses to select IDs randomly.

[5) Note: The same random set of records will be used for each subsequent run

of the Extract process (unless the input to the process changes). This is important

if you intend to use the results for modeling purposes, because different modeling
algorithms must be compared across the same set of records to determine each
model's effectiveness. If you do not intend to use the results for modeling, you can
make the Extract process select a different random set of records each time it runs. To
do this, use a Random Seed of zero (0). A value of 0 ensures that a different random set

of records will be selected each time the process runs.

On the Extract tab, use the Target data source field to select an output location:
« To store the data in binary format, select Campaign Server.
- To store the data in a uniquely named table with a UAC_EX prefix, select an available

database.

Then select fields from the list of Candidate fields and add them to the Fields to
extract list. Use the controls to remove or reorder fields. For information about using

the Extract tab, see Extract tab reference (on page 287).

Optionally, use the Dimension tab to add existing dimension tables to the extract table
and specify the key fields to join on. The extract table becomes a base table for the

selected dimension tables and can be used in downstream processes.

[5) Note: The Dimension tab is not applicable if you are extracting data to the

Campaign Server.
Select the General tab to set the following options.

a. Process name: Assign a descriptive name. The process name is used as the box
label on the flowchart. It is also used in various dialogs and reports to identify the

process.
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b. Output cell name: This name matches the Process name by default. It is used
in dialogs and reports to identify the output cell (the set of IDs that the process

retrieves).

c. (Optional) Link to target cell: Perform this step if your organization pre-defines
target cells in a target cell spreadsheet (TCS). To associate the pre-defined target
cell with the flowchart process output, click Link to target cell, then select a target
cell from the spreadsheet. The Output cell name and Cell code are inherited
from the TCS, and both of those field values are shown in italics to indicate that
there is a link relationship. For more information, read about using target cell

spreadsheets.

d. Cell code: The cell code has a standard format that is determined by your system
administrator and is unique when generated. Do not change the cell code unless
you understand the implications of doing so. By default, the name of a cell created
in a process matches the process name. When you save changes to an output cell
name, if Auto generate is selected, the cell code is regenerated. If you do not want
the cell code to change, uncheck Auto generate.

See Changing the cell code (on page ).

e. Note: Use the Note field to explain the purpose or result of the process. Common
practice is to reference the selection criteria or other important information. The
contents of this field appears when you rest your cursor over the process box in a

flowchart, in View or Edit mode.

19. Click OK to save and close the configuration.

The process is now configured. You can test run the process to verify that it returns the

results you expect.
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Extracting data from a Deliver landing page

You can use the Extract process in a flowchart to extract data from an Deliver landing page.
The Extract process selects fields from one table and writes them out to another table for

subsequent processing.

Ensure that your Unica environment meets the requirements before attempting to extract

Deliver landing page data. For more information, see Prerequisites for extracting data from

Deliver landing pages (on page 279).

1. In a flowchart in Edit mode, double-click the Extract process in the flowchart

workspace.

The process configuration dialog appears.
2. On the Source tab, select Deliver landing pages.
3. In the popup window, select an Deliver landing page as input.

[5) Note: You can select only one Deliver landing page as input to an Extract process.

To extract data from more than one landing page, configure multiple Extract processes.

4. If there is more than one audience level available for the landing page, select the
appropriate audience level from the drop-down list. If there is only one audience level

available, it is automatically selected.
5. Click OK.

6. On the Extract tab, use the Target data source field to select an output location:
« To store the data in binary format, select Campaign Server.
- To store the data in a uniquely named table with a UAC_EX prefix, select an available

database.

Then select fields from the list of Candidate fields and add them to the Fields to
extract list. Use the controls to remove or reorder fields. For information about using

the Extract tab, see Extract tab reference (on page 287).
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7. Perform any of the following optional tasks:
« Add a derived field to the list of candidate fields.
« Specify that duplicate IDs are excluded from the output. See Skipping duplicate IDs

in process output (on page 409).

« Limit the size of the output cell (that is, limit the number of IDs generated by the
process).
« Use the General tab to modify the Process name, Output cell names, or Cell codes,

link to a target cell, or enter a Note about the process.
For information about linking to target cells, see Linking flowchart cells to targeted
offers defined in a target cell spreadsheet (on page ).

[5) Note: Profiling is not available for Deliver landing page attributes.

8. Click OK.

The process is configured. You can test the process to verify that it returns the results you

expect.

[5) Note: During the extraction process, Campaign creates an intermediate view in
the system tables database with a UCC_LPV prefix. This internal view remains in the
database until the process box is deleted. If you remove the view, you must reconfigure
its corresponding Extract process before rerunning the process or flowchart; otherwise,

Campaign generates a missing table error.

Extract tab reference

Use the fields on the Extract tab when you configure an Extract process in a flowchart.

Table 27. Fields on the Extract tab

Field Description

Target data source Location to which the output from this process will be

written. The Campaign Server and any other data sources
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Field

Description

to which you are connected are available in the Target data

source drop-down list.

Candidate fields

List of fields available to extract, including field name and
data type, based on your input data source. To see the list
of fields, you may need to click the arrow next to an item to

expand the item.

If your input source is a landing page in Deliver, each field
name is an attribute of the landing page. If the attribute
contains special characters or spaces, it is converted to a
valid field name. Data types of all landing page attributes
are listed as text.

[5) Note: Schema object names are limited to 30
characters. Restrict your attribute names to 30 characters
or less to produce valid column names for extracted

output.

Fields to extract

Fields that you chose to extract from the Candidate fields
list. The Output name defaults to the field name in the

Fields to extract column.

If you change the Output name, you can use any
combination of letters and numbers. Do not use spaces,
hyphens (-), periods (.), slashes (/ or \), or any special
characters.

Profile...

Click Profile to preview a list of values in the selected
candidate field. Profiling is not available for Deliver landing
page attributes.

Derived fields...

Click Derived fields... to create a variable in the list of

candidate fields. Derived fields are variables that do not
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Field Description

exist in a data source and are created from one or more

existing fields, even across different data sources.

More... Click More... to open the Advanced settings dialog. This

dialog includes the option to exclude duplicate IDs from the

output and specify how Campaign identifies duplicates.

The Merge process

Use the Merge process to specify which input cells are included and combined and which

input cells are excluded (suppressed).

In this way, you can include or exclude cells from subsequent processes in your flowchart.

For example, use the Merge process to suppress "opt-out’ customers who requested that

they not receive any marketing materials.

Merging and suppressing contacts

The

cell.

Merge process accepts input from multiple cells and produces one combined output

When you merge cells, you can choose to include or exclude content.

. Open a campaign and click a flowchart tab.

. Click the Edit icon " in the flowchart window.

. Configure at least two processes whose output you want to merge.

For example, configure two Select processes.

. Drag the Merge process ~ from the palette to your flowchart.

. Drag an arrow from an upstream process (for example, a Select process) to the

Merge process, to connect the boxes. You must connect from the upstream process

to the Merge process. Repeat to connect any other upstream processes into the
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Merge process. An arrow indicates the direction of data flow between the connected

processes

[5) Note: All cells that provide input to the Merge process must have the same
audience level. For example, multiple Select processes must use the Household

audience.

6. Double-click the Merge process in the flowchart.

The process configuration dialog box opens and the Method tab is open by default.
Cells from processes that are connected to the Merge process are listed in the Input

list.

7. If you want to exclude IDs from the merged output, select a cell in the Input list and add

it to the Records to exclude list. For example, use this option to exclude Opt Outs.

8. If you want to include IDs in the merged output, select a cell in the Input list and add
it to the Records to include list. The IDs in the cells that you add to this list will be

combined into one list of unique IDs.

9. Specify how to merge the lists from the input cells that are in the Records to include
list:

- Merge/Purge on include: This option produces a list of unique IDs that exist in
at least one input cell. Duplicate IDs are included only once. This method uses a
logical "OR" or "ANY." For example: Include customer A if that customer is in either
the Gold.out cell OR the Platinum.out cell.

« Match (AND) on include: Include only those IDs that exist across all input cells.
This method uses a logical "AND" or "ALL." For example: Include customer A only
if that ID exists in both the Gold.out cell AND the LoyaltyProgram.out cell. This
option is useful when you want to include customers that meet multiple criteria. If

an ID does not exist in all of the Merge process input cells, the ID is not included.

10. Optionally, use the Cell size limit tab to limit the number of IDs generated by the

process during production or test runs. .
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If you selected Random seed, in most cases you can accept the default seed. The

random seed represents the starting point that Campaign uses to select IDs randomly.

[5) Note: The same random set of records will be used for each subsequent run

of the Merge process (unless the input to the process changes). This is important

if you intend to use the results for modeling purposes, because different modeling
algorithms must be compared across the same set of records to determine each
model's effectiveness. If you do not intend to use the results for modeling, you can
make the Merge process select a different random set of records each time it runs. To
do this, use a Random Seed of zero (0). A value of 0 ensures that a different random set

of records will be selected each time the process runs.

11. Use the General tab to set the following options.

a. Process name: Assign a descriptive name. The process name is used as the box
label on the flowchart. It is also used in various dialogs and reports to identify the
process.

b. Output cell name: This name matches the Process name by default. It is used
in dialogs and reports to identify the output cell (the set of IDs that the process
retrieves).

c. (Optional) Link to target cell: Perform this step if your organization pre-defines
target cells in a target cell spreadsheet. To associate the pre-defined target cell
with the flowchart process output, click Link to target cell, then select a target
cell from the spreadsheet. The Output cell name and Cell code are inherited from
the target cell spreadsheet, and both of those field values are shown in italics to
indicate that there is a link relationship.

d. Cell code: The cell code has a standard format that is determined by your system
administrator and is unique when generated. Do not change the cell code unless
you understand the implications of doing so. By default, the name of a cell created
in a process matches the process name. When you save changes to an output cell
name, if Auto generate is selected, the cell code is regenerated. If you do not want

the cell code to change, uncheck Auto generate.
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e. Note: Use the Note field to explain the purpose or result of the process. For
example, indicate which records you are including or excluding. The contents of

this field appears when you rest your cursor over the process box in a flowchart.

12. Click OK to save and close the configuration.

The process is now configured. You can test run the process to verify that it returns the

results you expect.

The Sample process

Use the Sample process to divide contacts into groups. The classic use of sampling is to
establish target and control groups that you can use to measure the effectiveness of your

marketing campaign.

Dividing contacts into sample groups

To create target and control groups, use the Sample process. There are several sampling
methods: Random creates statistically valid control groups or test sets. Every other X
allocates every other record to a sample group. Sequential portions allocates a number of

records into subsequent samples.

1. Open a flowchart for editing.

)

2. Drag the Sample process =" from the palette to your flowchart.
3. Connect at least one configured process (such as a Select process) as input to the

Sample process box.
4. Double-click the Sample process in the flowchart.

5. Use the Input list on the Sample tab to select the cells that you want to sample. The list
includes all output cells from any process connected to the Sample process. If multiple
cells are providing input, you can optionally select the Multiple cells option. If more

than one source cell is selected, the same sampling is performed on each source cell.
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@ Note: All selected cells must be defined at the same audience level, such as

Household or Customer.

6. Use the # of Samples/Output cells field to specify how many samples to create for
each input cell. By default, three samples are created for each input cell, with default

names Sample1, Sample2 and Sample3.

7. To change the default sample names, double-click a sample in the Output name
column, then type a new name. You can use any combination of letters, numbers, and

spaces. Do not use periods (.) or slashes (/ or \).

/\ Important: If you change the name of a sample, you must update all subsequent
processes that use this sample as an input cell. Changing a sample name might
unconfigure subsequent connected processes. In general, you should edit the names of

samples before connecting subsequent processes.

8. Use one of the following methods to define the sample size:

« To divide records up by percentages: Select Specify size by %, then double-click
the Size field to indicate the percentage of records to use for each sample. Use the
Max size field if you want to limit the size of the sample. The default is Unlimited.
Repeat for each sample listed in the Output name column, or use the All remaining
check box to assign all remaining records to that sample. You can select All
remaining for only one output cell.

« To specify the number of records for each sample size: Select Specify size by #
records, then double-click the Max size field to specify the maximum number of
records to allocate to the first sample group. Specify the Max size for the next
sample that is listed or use the All remaining check box to assign all remaining

records to that sample. You can select All remaining for only one output cell.

Optional: Click Sample size calculator and use the calculator to determine the

optimal sample size. (See About the sample size calculator (on page 296).) Then

copy the value from the Min. sample size field in the calculator, click Done to close
the calculator, and paste the value into the Max. size field for Specify size by #

records.
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9. Ensure that each sample in the Output name list has a Size defined or has All

remaining checked.

10. In the Sampling method section, specify how to build the samples:

« Random sample: Use this option to create statistically valid control groups or test
sets. This option randomly assigns records to sample groups using a random
number generator based on the specified seed. Seeds are explained later in these
steps.

« Every other X: This option puts the first record into the first sample, the second
record into the second sample, up to the number of samples specified. This
process repeats, until all records are allocated to a sample group. To use this
option, you must specify the Ordered by options to determine how records are
sorted into groups. The Ordered by options are explained later in these steps.

- Sequential portions: This option allocates the first N records into the first sample,
the next set of records in the second sample, and so on. This option is useful
for creating groups based on the top decile (or some other size) based on some
sorted field (for example, cumulative purchases or model scores). To use this
option, you must specify the Ordered by options to determine how records are

sorted into groups. The Ordered by options are explained later in these steps.

11. If you selected Random sample, in most cases you can accept the default seed. The

Seed represents the starting point that Campaign uses to select IDs randomly.

To generate a new seed value, click Pick or enter a value in the Seed field. Examples of

when you might need to use a new seed value are:

* You have exactly the same number of records in the same sequence and if you use
the same seed value, records are created into the same samples each time.
« The random sample produces undesired results (for example, all males are being

allocated to one group and all females to another).

[5) Note: The same random set of records will be used for each subsequent run of
the Sample process (unless the input to the process changes). This is important
if you intend to use the results for modeling purposes, because different modeling

algorithms must be compared across the same set of records to determine each
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model's effectiveness. If you do not intend to use the results for modeling, you can
make the Sample process select a different random set of records each time it runs. To
do this, use a Random Seed of zero (0). A value of 0 ensures that a different random set

of records will be selected each time the process runs.

12. If you selected Every other X or Sequential portions, you must specify a sort order to
determine how records will be allocated to sample groups:
a. Select an Ordered by field from the drop-down list or use a derived field by clicking
Derived fields.
b. Select Ascending to sort numeric fields in increasing order (low to high) and sort
alphabetic fields in alphabetical order. If you choose Descending, the sort order is

reversed.

13. Use the General tab as follows:

a. Process name: Assign a descriptive name. The process name is used as the box
label on the flowchart. It is also used in dialogs and reports to identify the process.

b. Output cell names: By default, output cell names consist of the process name
followed by the sample name and a digit. These names are used in dialogs and
reports. You can double-click an output cell name to change it by typing in the field.
Or, click the Copy button to open a text box that shows all of the existing Output
cell names. Copy them manually, then click OK. Then click the Paste button to
paste them into a text box, where you can edit them. Then click OK to copy the
edited Output cell names into the fields. You can use the Reset cell names button
if you want to revert to the default output cell names.

c. Cell codes: The cell code has a standard format that is determined by your system
administrator and is unique when generated. Do not change the cell code unless
you understand the implications of doing so. By default, the name of a cell created
in a process matches the process name. When you save changes to an output cell
name, if Auto generate cell codes is selected, the cell code is regenerated. If you
do not want the cell code to change, uncheck Auto generate cell codes.

d. Note: Use the Note field to explain the purpose or result of the process. The
contents of this field appears when you rest your cursor over the process box in a
flowchart.
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14. Click OK.

The process is configured and enabled in the flowchart. You can test run the process to

verify that it returns the results you expect.

About the sample size calculator

Campaign provides a sample size calculator to help determine the statistical significance of

sample sizes in evaluating campaign results.

There are two ways to specify the level of accuracy that you want. You can enter an error
bound and compute the minimum sample size needed, or you can enter a minimum
sample size and compute the error bound that will result. Results are reported at the 95%

confidence level.

Determining the appropriate sample size

The sample size calculator determines the minimum number of contacts to include in
your sample, based on what you consider to be an acceptable margin of error. Results are

reported at a 95% confidence level.

Determining the appropriate sample size is important when your goal is to make inferences
about a group of people based on a sample. In general, a larger sample size produces a
smaller margin of error. Use the sample size calculator to either compute the sample size
needed for a particular error bound, or to determine the error bound for different sample

sizes.

1. On the Sample tab of the Sample process configuration dialog, click Sample size

calculator.

The Sample size calculator opens.

2. For Response rate estimate, enter your best guess for the Minimum and Maximum

response rates that you expect from your marketing campaign.
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These two values must be percentages between 0% and 100%. The lower the expected
response rate, the larger the sample size must be to achieve the same level of accuracy

for the measured response rate.
3. If you are not using a predictive model, select No model as the Modeling estimate.

4. If you are using a predictive model, select Model performance, then enter percentages

for the Cumulative gain and File depth.
To obtain these values:

a. Open the Evaluate reports in IBM SPSS® Modeler Advantage Enterprise Marketing
Management Edition, and open the Testing partition.

b. Select the Gains tab, and display the information as a Table.

c. Use a value from the first column (Segment) of the table as the File depth, to
indicate the percentage of customers that you intend to contact.

d. Use the corresponding value from the last column (Cumulative Gain) of the table

as the Cumulative gain.

The calculator uses this information to determine the number of samples that you

need to use, based on the expected response rate and modeling performance.

5. Use either approach:

* To determine the minimum sample size based on the margin of error that you
are willing to accept: Enter a value of 0% to 100% in the Error bound (+ or -) field
to indicate the percentage margin of error that you are willing to accept for this
sample. Then click Compute sample size. The Min. sample size field indicates the
smallest sample that will meet the specified error bound. A smaller error bound
percentage requires a larger sample size. Conversely, a larger error bound requires
a smaller sample size. For example, a 3% error bound requires a larger sample size
than if you allow for a 10% error bound.

« To determine the margin of error that will result from a specific sample size: Enter
a value in the Min. sample size field to indicate the sample size that you plan to

use, then click Compute error bound. Based on the results, you can decide whether
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to increase or decrease the sample size. Larger sample sizes result in smaller error

bounds. If the resulting error bound is too high, use a larger sample size.

6. After you determine the optimal sample size:
a. Copy the value from the Min. sample size field.
b. Click Done to close the calculator.
c. Confirm that Specify size by # records is selected.

d. Paste the value into the Max. size field in the Sample process box.

The Segment process

Use the Segment process to divide data into distinct groups, or segments. Connect a
Segment process to a contact process, such as a Call list or Mail list, to assign treatments

or offers to the segments.

For example, you can divide your customers into high-value, medium-value, and low-value
segments based on their prior purchase history. Each segment can receive a different
offer when the segment is input to a contact process. There is no limit to the number of

segments that you can create.

You can segment data in two ways: by using the distinct values in a field, or by using a query
to filter the data in a field. In addition to database table fields, you can use derived fields to
segment data. In this way, you can perform custom grouping, to segment your customers

however you want.

[5) Note: Segments that are created by the Segment process are not persistent across
flowcharts or sessions. To create a "permanent” segment (also called a strategic segment),

an administrator can use the Create Seg process.

Segmenting by field

When you segment data by a field in a database table, each distinct value in the field
creates a separate segment. This option is most useful when the values in the field

correspond to the segments you want to create.
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For example, assume that you want to assign a different offer to customers in each of 10
regions. Your customer database contains a field called r egi onl D, which indicates the
region to which each customer belongs. Segment by the r egi onl Dfield to create the 10

regional segments.

Segmenting by query

The segment by query option segments your data based on the results of a query that you
create. This option is most useful when it is necessary to filter the data in a field to create

the required segments.

For example, assume that you want to divide your customers into high-value (more than
$500), medium-value ($250-$500), and low-value (under $250) segments based on their
purchase history over the last year. The Pur chaseH st ory field in your customer database
stores the total dollar amount of each customer's purchases. Use a separate query to create
each segment, selecting records with values in the Pur chaseHi st ory field that meet the

criteria of the segment.

[5) Note: You can also segment data using raw SQL.

Using segments as input to another Segment process

Segments can be used as input cells to another Segment process in a campaign flowchart.

For example, you can segment by age range, then further segment by preferred channel.

For this example, assume that you want to segment your customers into age ranges. Your
database contains the field AgeRange, which assigns one of six age ranges (such as 26-30)

to each customer. Segment by the AgeRange field to create six segments.

You could then use these six segments as input to another Segment process that

further divides customers by another field or query. For example, assume that your
database contains a field called Pr ef er r edChannel , which specifies each customer's
preferred contact channel: Direct mail, telemarketing, fax, or email. Using the six age range
segments as input, you could then create a second Segment process to segment by the
Pref erredChannel field. Each of the six age range segments is further segmented into four

preferred channel segments, to produce a total of 24 output segments.
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Segmenting considerations

Consider the following options and guidelines when you configure a Segment process in a

campaign flowchart.

Choosing a segmenting method

You can segment by field or by query when you configure a Segment process in a campaign

flowchart.

In some cases, the same results can be achieved when segmenting either by field or by
query. For example, assume that the Acct Type field in your database divides your customer
accounts into Standard, Preferred and Premier levels. Segmenting by the Acct Type field will

create three segments for these account types.

You could achieve the same results using queries, but creating the segments would require
writing three separate queries. Determine the most efficient method based on the data that

you are segmenting.

Making segments mutually exclusive

You can specify that segments are mutually exclusive, meaning that each qualifying
record is guaranteed to be placed into no more than one segment. When the segments are

assigned to offers, each customer will receive only one offer.

Records are placed in the first segment whose criteria they satisfy, based on a priority order
that you define. For example, if a customer qualifies for segments 1 and 3, and segment 1 is

before segment 3 in the priority order, that customer will appear only in segment 1.

Restricting segment size

When you configure a Segment process, the default size for the number of records per
segment is Unlimited. You may want to restrict the size of the created segment if, for

example, you are performing test runs of a campaign flowchart or process.

You can limit the segment size to any positive integer. When you limit the segment size, the

qualifying records are chosen randomly.
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The same random set of records will be used for each subsequent run of the process
(unless the input to the process changes). This is important if you intend to use the
Segment results for modeling purposes, because different modeling algorithms must be

compared across the same set of records to determine each model's effectiveness.

If you do not intend to use the results for modeling, you can make the Segment process
select a different random set of records each time it runs. To do this, use a Random Seed of
zero (0) in the upstream process that provides input to the Segment process. A value of 0

ensures that a different random set of records will be selected each time the process runs.

Selecting source cells

When you configure a Segment process in a campaign flowchart, all selected cells must
be defined at the same audience level. If more than one source cell is selected, the same

segmentation is performed on each source cell.

Using segments as input to another Segment process

Segments can be used as input cells to another Segment process in a campaign flowchart.

For example, you can segment by age range, then further segment by preferred channel.

For this example, assume that you want to segment your customers into age ranges. Your
database contains the field AgeRange, which assigns one of six age ranges (such as 26-30)

to each customer. Segment by the AgeRange field to create six segments.

You could then use these six segments as input to another Segment process that

further divides customers by another field or query. For example, assume that your
database contains a field called Pr ef er r edChannel , which specifies each customer's
preferred contact channel: Direct mail, telemarketing, fax, or email. Using the six age range
segments as input, you could then create a second Segment process to segment by the
Pref erredChannel field. Each of the six age range segments is further segmented into four

preferred channel segments, to produce a total of 24 output segments.

Choosing a segmenting method

You can segment by field or by query when you configure a Segment process in Campaign .
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In some cases, the same results can be achieved when segmenting either by field or by
query. For example, assume that the Acct Type field in your database divides your customer
accounts into Standard, Preferred and Premier levels. Segmenting by the Acct Type field will

create three segments for these account types.

You could achieve the same results using queries, but creating the segments would require
writing three separate queries. Determine the most efficient method based on the data that

you are segmenting.

Making segments mutually exclusive

You can specify that segments are mutually exclusive, meaning that each qualifying
record is guaranteed to be placed into no more than one segment. When the segments are

assigned to offers, each customer will receive only one offer.

Records are placed in the first segment whose criteria they satisfy, based on a priority order
that you define. For example, if a customer qualifies for segments 1 and 3, and segment 1 is

before segment 3 in the priority order, that customer will appear only in segment 1.

Restricting segment size

When you configure a Segment process, the default size for the number of records per
segment is Unlimited. You may want to restrict the size of the created segment if, for

example, you are performing test runs of a campaign flowchart or process.

You can limit the segment size to any positive integer. If the segment size that you specify
is less than the total number of records generated, the segment will consist of randomly

selected qualifying records.

Selecting source cells

When you configure a Segment process in a campaign flowchart, all selected cells must
be defined at the same audience level. If more than one source cell is selected, the same

segmentation is performed on each source cell.
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Segmenting data by field

You can use the Segment process to divide data into segments based on field values. When

you segment data by a field in a database table, each distinct value in the field creates a

separate segment.

Segmenting considerations (on page 300)

Segmenting data by field is most useful when the values in the field correspond to the

segments that you want to create. For example, assume that you want to assign a different

offer to customers in four different regions. Your customer database contains a field that is

called r egi on, which indicates the region to which each customer belongs. Segment by the

regi on field to create the four regional segments.

1. Open a flowchart for editing.

. Drag a Segment process <] from the palette to your flowchart.

. Connect at least one configured process, such as a Select process, as input into the

Segment process.

. Double-click the Segment process in the flowchart to open the Segment process

configuration dialog.

Cells from processes that are connected to the Segment process appear in the Input
list.

. On the Segment tab, open the Input list and select the input to the Segment process. To

select multiple cells, use the ellipsis button (...) next to the Input list.

. Select Segment by field, then use the drop-down list to select the field that you want to

use to create the segments. For example, to segment by region, select the r egi on field.

The Profile selected field dialog opens, and Campaign immediately begins examining
the field values. By profiling the field values, Campaign can determine which segments

to create.
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For more information about this dialog, see Previewing field values from your user data

(on page 397).

7. Wait for profiling to finish to ensure that all segments are properly created. Then click

OK to close the Profile selected field dialog.

The # of segments field and the list of Segment names are updated based on the
profiling results of the field that was selected for Segment by field. For example, if you
segment by field "Status" which has two values "A" and "B", two segments are created,
"Status_A" and "Status_B."

8. Optionally, you can edit the segment names, adjust the maximum size, create mutually
exclusive segments, or create extract tables. For information about options that you
can set, see the following topics:

» Segment process: Segment tab (on page 309)

» Segment process: Extract tab (on page 312)

» Segment process: General tab (on page 313)

9. Click OK to save your selections and close the Segment process configuration dialog.

The process is now configured. You can test the process to verify that it returns the

results you expect.

Segmenting data with queries

You can use the Segment process to segment data based on the results of a query that you

create.

Segmenting considerations (on page 300)

Segmenting by query is most useful when it is necessary to filter the data in a field to
create the required segments. For example, assume that you want to divide your customers
into high-value (more than $500), medium-value ($250-$500), and low-value (under $250)
segments that are based on their purchase history over the last year. The Pur chaseHi st ory

field in your customer database stores the total dollar amount of each customer's
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purchases. Use a separate query to create each segment, selecting records with values in

the Pur chaseHi st ory field that meet the criteria of the segment.

[5) Note: You can also use raw SQL to segment data.

1. Open a flowchart for editing.

2. Drag a Segment process 2] from the palette to your flowchart.

3. Connect at least one configured process, such as a Select process, as input into the

Segment process.

4. Double-click the Segment process in the flowchart to open the Segment process
configuration dialog.
Cells from processes that are connected to the Segment process appear in the Input

list.

5. On the Segment tab, open the Input list and select the input to the Segment process. To

select multiple cells, use the ellipsis button (...) next to the Input list.
6. Select Segment by query.

7. Determine the number of segments that you want to create, and enter that number in

the # of segments field.

8. Now you will construct a query for each segment: Select the first segment and click
Edit to open the Edit segment dialog.

[5) Note: For reference information about each available control, see Segment process:

New segment and Edit segment controls (on page 313).

9. If you want to include all IDs from the segment or table that you selected as the
Input source, choose Select all <audience> IDs (The word <audience> indicates the

audience level, such as Customer, that is specified for the selected input data source.)
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10. If you prefer to use a subset of IDs from the selected data source, choose Select

<audience> IDs with, so you can do a query for the records that you want.
The Expression box shows columns labeled Field name, Oper, Value, and And/Or.

When the button says Text Builder, you can build expressions by populating the

columns labeled Field name, Oper, Value, And/Or.

When the button says Point & click, you can view or edit raw SQL and you can use the

Formula helper to pick macros, operators, and string functions from a list.

With either method (Text Builder / Point & click), you can select fields from the
Available fields list, including Campaign Generated Fields and Derived fields.

11. Construct a query to determine which records will be used to create the segment:

a. To specify which field to query, click in the Field name cell. The Available fields list
should appear. If the list does not appear, click in the Field name cell again. In the
Available fields list, expand the fields until you see the one that you want. Select an

available field by double-clicking it or by highlighting it and clicking Use.

[5) Note: When deciding which field to use, you can highlight an available field
and click Profile to see a list of values in that field. Then use the Profile selected

field dialog to examine the field values. For more information, see Previewing field

values from your user data (on page 397).

[5) Note: When the list of Available fields is displayed, you can use the Derived
fields button if you want to create or use derived fields. For more information, see

Derived fields (on page ).

b. Click in the Oper cell, then double-click a comparison operator in the Operators list

(5, <, > <=,>=,<>,In, Not in, Between).

c. Click in the Value cell, then double-click a value. If no values appear, double-click
(Profile...) in the Values list to open the Profile selected field dialog so you can
select from a list of values. You can also double-click in the Value cell to edit the

value directly.


unique_320
unique_320
unique_320
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[5) Note: If you do not see the expected list (Available fields, Operators, Values,
For selected expresssion), try either single clicking or double clicking on a cell in

the Expression area.

You now have an expression that consists of a field name, operator, and value.

() Select all Customer IDs

'E," Select Customer IDs with Advanced...

Expression
Field name Oper. Value A
CUSTOMER_MAIL_OPTIN = ™

12. Click Check syntax to confirm whether the query syntax is valid. Checking the syntax

does not put any load on the database server.

13. To add and combine multiple expressions, follow the guidelines below:

a. To add another expression, click the And/Or cell, then double-click AND or OR in
the Values list to indicate how to combine the expressions.

b. Build your next expression, consisting of a field name, operator, and value.

c. To add parentheses to control evaluation order, double-click the Field Name in
any row to display the For selected expression list. In the list of expressions,
double-click Add () to add a set of parentheses, Remove () to remove a single
set of parentheses, or Clear all () to remove all of the parentheses in the selected
expression. Parentheses allow you to group expressions when defining complex
queries. For example, (AcctType = 'Gold' AND Rank ='A’) OR NewCust = 'Yes'is
different from AcctType = 'Gold' AND (Rank ='A' OR NewCust = 'Yes').

d. To reorder the selected expression, double-click Move up or Move down.

e. To add a blank row below the selected expressions, double-click Insert.

f. To delete the selected expression, double-click Delete.
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14.

15.

16.

17.

18.

19.

20.

Optionally, click the Text Builder button so its label changes to Point & click. When the
button says Point & click, you can view or edit raw SQL. You can also use the Formula

helper to pick macros, operators, and string functions from a list.

[5) Note: If your query includes a table field that has the same name as a Campaign
generated field, you must qualify the field name. Use the following syntax:

<t abl e_nane>. <fi el d_nane>.

Click the Point & click button to change back to the original query mode. The button

label changes back to Text Builder.

(Optional) Use Test query to see how many IDs the query returns.

A progress bar is displayed while the query is being tested. Close the progress window
if you want to cancel the test. When testing is complete, Campaign indicates the

number of rows the query returned.

/\ Important: Global suppressions and cell size limits are not applied in test query
counts. Test queries might also return non-normalized data. To obtain an accurate

result count, test run the process.
Click OK to save the query for this segment and close the Edit segment dialog.

In the Segment process configuration dialog, edit the remaining segments to define

queries for them.

Continue configuring the Segment process by using the controls on the Segment,
Extract, and General tabs. For more information, see the following topics:

» Segment process: Segment tab (on page 309)

» Segment process: Extract tab (on page 312)

» Segment process: General tab (on page 313)

Click OK to save your selections and close the Segment process configuration dialog.

The process is now configured. You can test the process to verify that it returns the

results you expect.
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Segment process: Segment tab

Use the Segment tab of the Segment process configuration dialog to indicate how to divide

incoming data into distinct groups, or segments.

The following table describes the controls on the Segment tab of the Segment process

configuration dialog.

Table 28. Segment tab

Control Description

Input Specifies the input to the Segment process. The drop-down
list contains all output cells from any process connected to
the Segment process. Select Multiple cells if you want to

select more than one input.

Segment by field Specifies a field to use for segmenting data. The data is
segmented using the values that exist for the selected
field. Each distinct value in the field creates a separate
segment. For example, a field that contains the values A, B,

C results in three segments.

Profile Opens the Profile selected field dialog, which calculates
the values and distributions of records in the selected field.
Active only when segmenting by field. To reprofile the field

at any time after initially selecting it, click Profile.

Derived fields... Active only when segmenting by field. Opens the Create

derived field dialog so you can create a new field.

Segment by query Segments data based on a query that you create.

# of segments Active only when segmenting by query. Indicates the

number of segments to create. By default, three segments

are created, with default names "Segment1,' "Segment?2,"

and "Segment3." The # of segments field does not allow
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Control

Description

you to enter a value greater than 1000 because that is the
maximum number of segments that can be created in a
flowchart.

When segmenting by field: The # of segments field is
updated based on the profiling results of the selected field.
The number of segments depends on the values that are
detected in the field.

Mutually exclusive segments

Specifies whether the segment is to be mutually exclusive
(that is, each qualifying record is guaranteed to fall into no
more than one segment).

Create extract tables

This control specifies whether segments should create
Extract tables for each output cell. Selecting this option
ensures that Campaign can provide a later process with
the information necessary to keep track of duplicate target

audiences across segments.

Select this check box to enable the options on the Extract
tab.

This check box is disabled if Mutually exclusive segments
is selected.

Segment name

Lists all segments by name. By default, three segments are

created, with default names "Segment1," "Segment2," and

"Segment3.”

When segmenting by field: Segment names are updated
based on the profiling results of the selected field.

For example, if you are segmenting on a field called
"Acct_Status" which has two distinct values "A" and "B,
two segments are created, named "Acct_Status_A" and
"Acct_Status_B."
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Control Description
Max. size Maximum number of records allowed in each segment.
Size Number of records that meet the criteria for the segment.
Before the process is run, this number defaults to the total
number of records in the output cell.
Query The Query column in the list of segments appears only

when segmenting by query. It indicates the query criteria
that is used to create the segment. To change the query
criteria, double-click the segment name or select a

segment and click Edit.

Up 1, Down 1 arrows

Move the selected segment up or down in the list.
Segments are processed in the order in which they are
listed.

New segment

Active only when segmenting by query. Opens the New
segment dialog so you can create a new segment by

specifying a query.

Edit

This button opens the Edit segment window for the
selected segment. When segmenting by field, you can
change the segment name or Max size. When segmenting
by query, you can change the name, size, and query

expression.

Remove

Removes the selected segment. When a segment is
removed, the # of segments field updates automatically. If
there is only one segment available, the Remove button is

disabled to avoid deleting the only segment.

Do not run subsequent
processes for empty

segments

Prevents downstream processes from running for empty

segments.
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Segment process: Extract tab

Use the Extract tab of the Segment process configuration dialog to select fields to extract.
In this way, you allow the output from the Segment process to be accessible as input to Mail

list or Call list processes in a flowchart.

The following table describes the fields, buttons, and controls on the Extract tab. The
controls on the Extract tab are active only if you selected Create extract tables on the
Segment tab.

Table 29. Extract tab

Field Description

Target data source Location to which the output from this process is written.
The Campaign server and any other data sources to which
you are connected are available from the Target data

source drop-down list.

Candidate fields List of fields available to extract, including field name and

data type, based on your input data source.

If your input source is a landing page in Deliver, each field
name is an attribute of the landing page. If the attribute

contains special characters or spaces, it is converted to a
valid field name. Data types of all landing page attributes

are listed as text.

[5) Note: Schema object names are limited to 30
characters. Restrict your attribute names to 30 characters
or less to produce valid column names for extracted

output.

Fields to extract Fields that you selected to extract from the Candidate
fields list. The Output name defaults to the field name in

the Field to extract column.
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Field

Description

If you change the Output name, you can use any
combination of letters and numbers. Do not use spaces,
hyphens (-), periods (.), slashes (/ or \), or any special

characters.

Profile

Opens the Profile selected field dialog, which calculates
the values and distributions of records in the selected field.
Active only when a field name is selected in the Candidate
fields list.

Derived fields...

Opens the Create derived field dialog.

More...

Opens the Advanced settings dialog, which includes
the option to skip duplicate records and to specify how

Campaign identifies duplicates.

Segment process: General tab

Use the General tab of the Segment process configuration dialog to modify the Process

name, Output cell name, or Cell code. You can also enter a Note to explain the purpose of

the Segment process. The note appears when you rest your cursor over the process box in a

flowchart.

Segment process: New segment and Edit segment controls

The following table describes the controls on the New segment and Edit segment dialog

boxes. You can access these dialog boxes when configuring a Segment process.

[5) Note: The New segment dialog box can be accessed only when you are segmenting by

query. When you segment by field, only the Name and Max. size fields are available in the

Edit Segment dialog box.
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Table 30. New Segment and Edit Segment dialog box controls

Control Description
Name Name of the segment.
Max. size Maximum number of records that are allowed in the
segment.
Select based on Specifies a data source on which to base your query.
Select all data source type Includes all the IDs from the data source in the Input drop-
down list.

Select data source type with | Provides access to the functions for creating a query to

select only certain IDs based on criteria you define.

Advanced... Opens the Advanced settings dialog, which provides the
following options:

« Use raw SQL: Use a raw SQL query to segment data.

« Use query scope from input cell: Available only if a
source cell to this Segment process uses a query.
Select the check box to combine the query in the
source cell (using "AND") with the current selection

criteria.

Derived fields... Opens the Create derived field dialog.

Query text box and buttons | For information about using the query text box and related
fields and buttons, see "Creating queries in processes" in

the Campaign Administrator's Guide.

The Select process

Use the Select process to select IDs from your marketing data, such as customers,

accounts, or households that you intend to contact.
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Select is one of the most frequently used processes in Campaign. Many flowcharts begin
with one or more Select processes. The Select process outputs a cell that contains a list of

IDs, such as customer IDs, which can be modified and refined by other processes.

Filtering the mapped user tables

You can filter the mapped user tables that appear in the Available Fields section in the

Select process configuration window. The tables are filtered by table name.

To filter the mapped user tables by table name, complete the following steps:

1. Open a flowchart for editing (click Edit < in the flowchart toolbar).
2. Double-click the Select process box in the flowchart to open the Select process

configuration window.

3. Click the Filter icon next to Available Fields.

4. Enter the text to filter the tables and click Apply.

You cannot use any special characters except underscore in the filter text. The search

is not case sensitive.

The filtered list of tables is displayed. The Filter icon changes to a dark green color.

5. To clear the filter, click the Filter icon * , and in the Filter window, click Clear.

The filter is applicable until you click Clear or you close the Select process configuration

window.

Selecting a list of contacts

Configure a Select process to select contacts from your marketing data.

To select contacts, you can specify all IDs in a segment or table, or you can use a query to
find just the contacts that you want. One or more Select processes can then be used as
input into another process. For example, you can select all Gold customers, then create
another selection of Silver customers. You can then use a Merge process to create a single

list of eligible contacts.
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1. Open a flowchart for editing (click Edit < in the flowchart toolbar).

=y

2. Drag a Select process = from the palette to your flowchart.

3. Double-click the Select process box in the flowchart.
The Select process configuration dialog box opens and the Source tab is open by

default.

4. On the Source tab, use the Input list to select a Segment or Table as the data source.
To select multiple tables, click the ellipsis button L= next to the Input field, then check

the tables that you want to use.

[5) Note: If IBM Digital Analytics is integrated with Campaign, you can select IBM
Digital Analytics segments as the input.

5. If you want to include all rows from the segment or table that you selected as the
Input source, choose Select all <audience> IDs (The word <audience> indicates the

audience level, such as Customer, that is specified for the selected input data source.)
6. If you prefer to use a subset of IDs from the selected data source, choose Select

<audience> IDs with, so you can do a query for the records that you want.

The Expression box shows columns labeled Field name, Oper, Value, and And/Or.

When the button says Text Builder, you can build expressions by populating the

columns labeled Field name, Oper, Value, And/Or.

When the button says Point & click, you can view or edit raw SQL and you can use the

Formula helper to pick macros, operators, and string functions from a list.

With either method (Text Builder / Point & click), you can select fields from the
Available fields list, including Campaign Generated Fields and Derived fields.

7. Construct a query to determine which records are selected:

a. To specify which field to query, click in the Field name cell. The Available fields list

should appear. If the list does not appear, click in the Field name cell again. In the
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Available fields list, expand the fields until you see the one that you want. Select an
available field by double-clicking it or by highlighting it and clicking Use.

[5) Note: When deciding which field to use, you can highlight an available field
and click Profile to see a list of values in that field. Then use the Profile selected

field dialog to examine the field values. For more information, see Previewing field

values from your user data (on page 397).

[5) Note: When the list of Available fields is displayed, you can use the Derived
fields button if you want to create or select a variable for querying. For more
information, see Derived fields (on page ).

b. Click in the Oper cell, then double-click a comparison operator in the Operators list

(5, <, > <=, >=,<>,In, Not in, Between).

c. Click in the Value cell, then double-click a value. If no values appear, double-click
(Profile...) in the Values list to open the Profile selected field dialog so you can
select from a list of values. You can also double-click in the Value cell to edit the

value directly.

[5) Note: If you do not see the expected list (Available fields, Operators, Values,
For selected expresssion), try either single clicking or double clicking on a cell in
the Expression area.

You now have an expression that consists of a field name, operator, and value.


unique_320
unique_320
unique_320
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Select process configuration =

Source Cell size limit General

Specify the criteria of records to select
Select based on
Input Auto_MailListForResPB

() Select all Customer IDs

(@ Select Customer IDs with
A

Expression Values

Field name Oper Value (Profile...)

CUSTOMER_MAIL_OPTIN - Y

Text Builder Check syniax | | Test query

8. Click Check syntax to confirm whether the query syntax is valid. Checking the syntax

does not put any load on the database server.

9. To add and combine multiple expressions, follow the guidelines below:

a. To add another expression, click the And/Or cell, then double-click AND or OR in
the Values list to indicate how to combine the expressions.

b. Build your next expression, consisting of a field name, operator, and value.

c. To add parentheses to control evaluation order, double-click the Field Name in
any row to display the For selected expression list. In the list of expressions,
double-click Add () to add a set of parentheses, Remove () to remove a single
set of parentheses, or Clear all () to remove all of the parentheses in the selected
expression. Parentheses allow you to group expressions when defining complex
queries. For example, (AcctType = 'Gold' AND Rank ='A’) OR NewCust = 'Yes'is
different from AcctType = 'Gold' AND (Rank ='A' OR NewCust = 'Yes').

d. To reorder the selected expression, double-click Move up or Move down.

e. To add a blank row below the selected expressions, double-click Insert.

f. To delete the selected expression, double-click Delete.



10.

11.

12.

13.

14.
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Optionally, click the Text Builder button so its label changes to Point & click. When the
button says Point & click, you can view or edit raw SQL. You can also use the Formula

helper to pick macros, operators, and string functions from a list.

Exprassion Expression

Field name Oper. Value And/Or CUSTOMER.MAIL OPTIN = 7Y
‘CUSTOMER MAIL_OPTIN = i

4 1 2

Text Builder Check syntax || Test query Point & click Formula helper Check syntax || Test query

[5) Note: If your query includes a table field that has the same name as a Campaign
generated field, you must qualify the field name. Use the following syntax:

<t abl e_nane>. <fi el d_nanme>.

For related information, see Creating raw SQL queries (on page 392). Also see

Creating queries with Formula helper (on page 386).

Click the Point & click button to change back to the original query mode. The button
label changes back to Text Builder.

(Optional) Use Test query to see how many IDs the query returns.

A progress bar is displayed while the query is being tested. Close the progress window
if you want to cancel the test. When testing is complete, Campaign indicates the

number of rows the query returned.

/\ Important: Global suppressions and cell size limits are not applied in test query
counts. Test queries might also return non-normalized data. To obtain an accurate

result count, test run the process.

Continue configuring the process, as described below, or click OK to close the process

configuration dialog and save the query expression.

Optionally, use the Cell size limit tab to limit the number of IDs generated by the

process during production or test runs.
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If you selected Random seed, in most cases you can accept the default seed. The

random seed represents the starting point that Campaign uses to select IDs randomly.

[5) Note: The same random set of records will be used for each subsequent run

of the Select process (unless the input to the process changes). This is important

if you intend to use the results for modeling purposes, because different modeling
algorithms must be compared across the same set of records to determine each
model's effectiveness. If you do not intend to use the results for modeling, you can
make the Select process select a different random set of records each time it runs. To
do this, use a Random Seed of zero (0). A value of 0 ensures that a different random set

of records will be selected each time the process runs.

15. Use the General tab to set the following options.

a. Process name: Assign a descriptive name, such as Select_Gold_Customers. The
process name is used as the box label on the flowchart. It is also used in various
dialogs and reports to identify the process.

b. Output cell name: This name matches the Process name by default. It is used
in dialogs and reports to identify the output cell (the set of IDs that the process
retrieves).

c. (Optional) Link to target cell: Perform this step if your organization pre-defines
target cells in a target cell spreadsheet. To associate the pre-defined target cell
with the flowchart process output, click Link to target cell, then select a target
cell from the spreadsheet. The Output cell name and Cell code are inherited from
the target cell spreadsheet, and both of those field values are shown in italics to
indicate that there is a link relationship.

d. Cell code: The cell code has a standard format that is determined by your system
administrator and is unique when generated. Do not change the cell code unless
you understand the implications of doing so. By default, the name of a cell created
in a process matches the process name. When you save changes to an output cell
name, if Auto generate is selected, the cell code is regenerated. If you do not want
the cell code to change, uncheck Auto generate.

e. Note: Use the Note field to explain the purpose or result of the process. Common

practice is to reference the selection criteria or other important information. The
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contents of this field appears when you rest your cursor over the process box in a

flowchart.

16. Click OK to save and close the configuration.

The Select process is now configured. You can test run the process to verify that it

returns the results you expect.

Run processes

Campaign provides the following run processes:

» The Call list process (on page 321)

» The CreateSeq process (on page 331)

 The Cube process (on page 333)

» The Mail list process (on page 335)

» The Schedule process (on page 344)

» The Snapshot process (on page 351)

The Call list process

Use the Call list process to assign offers to contacts, generate a contact list for a
telemarketing campaign, and log the contact history. The Call list process is often referred

to as a contact process.

You configure a Call list process the same way as you configure a Mail list process. See

Configuring Mail list or Call list processes (on page 321).

Configuring Mail list or Call list processes

Follow these instructions to configure a Mail list or Call list process in a Campaign
flowchart. Configure a Mail list or Call list process to assign offers to contacts, generate
a contact list for a direct mail or telemarketing campaign, and write the results to contact

history.
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1. Open a flowchart for editing.

A @
[ or Call list ©

2. Drag a Mail list process from the palette to your flowchart.

3. Connect one or more configured processes as input to the Mail list or Call list.

The input processes must produce output cells, which provide input to the Mail list or
Call list process. For example, a Select process produces a list of IDs, which are used

by the Mail list or Call list process.

/\ Important: All of the cells that you select as input cells must have the same

audience level.

4. Double-click the Mail list or Call list process in the flowchart workspace to open the

configuration dialog.

5. Use the Fulfillment tab to build the contact list and specify whether the output is sent

to a list or table.

a. From the Input list, specify the cells to use as the data source for the contact list.

If multiple processes are connected to the Mail list or Call list process (or if an
input process generates multiple cells), click the ellipsis button ) then select
which inputs to use. For example, if Gold, Silver, and Bronze cells are connected to
a Mail list, you can select one, two, or all three of them. When more than one cell is

selected, the Input list says Multiple cells.

b. To export the list to a table or file, select Enable export to, then use the appropriate
options:

« To write the output to a file, select File from the Enable export to list, then
provide a file name and other details. You can write to a file to test the output
of the Mail list or Call list process. After you run the process, review the file to
confirm that the results are what you expect.

« To write the output to a database table, select a table from the Enable export

to list.
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« If the database table that you want to use is not in the list, or if you want to
write the output to an unmapped table, select Database table. Use the Specify
database table dialog to indicate the table name and database. User variables
are supported in the table name that you specify.

« To create a user table, select New mapped table from the Enable export to list.
For instructions, see the Campaign Administrator's Guide.

« Specify how to handle updates to the output file or table:

- Append to existing data. Add the new information to the end of the table
or file. This option is the best practice for database tables. If you select
this option for a delimited file, labels are not exported as the first row.

- Replace all records. Remove any existing data from the table or file and
replace it with new information.

o Create new file. This option is available if you specify a new file in the

Enable export to field.

c. If you only want to write to contact history, and you do not want to generate output
to a table or file, clear the Enable export to option. (To specify how to log to the

Contact history tables, use the Log tab, explained later in these steps.)

d. (Optional) Summary file: Enter a path and file name in the Summary file field, or
navigate to a location by clicking the ellipsis button. A summary file is a text file
with the extension . sum This file contains information about the contents of the
list. Typically, you include this file with the list when you send it to the fulfillment
center. A summary file is generated only if you select the Enable export to option.

e. (Optional) To send a trigger when the process finishes running, select Send
trigger(s), and choose the trigger that you want to send. To send multiple triggers,
use Ctrl+Click to select more than one trigger. The selected t